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 

Revision Date Description
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Contact Information 
Triton© Headquarters and Manufacturing Plant
21405 B Street       
Long Beach, MS 39560 USA     
1 (866) 259-4866      
(228) 575-3101 (fax) 

Triton Technical Services Department      
techsvs@triton.com
1 (800) 259-6672 (opt 3)

Manufacturer warrants that the products delivered to a distributor will perform in accordance with the Manufac-
turer’s published speciĕ cations for thirteen months from date of shipment from Long Beach, MS. 

Manufacturer’s warranty shall not apply to any damage resulting from abuse, negligence or accident, or to any 
loss or damage to the product(s) while in transit. Written notice and explanation of circumstances surrounding 
any claims that the goods have proved defective in material or workmanship shall be given promptly from the 
distributor to the manufacturer. No claim may be made, or action brought, by or through a distributor a er the 
expiration of 14 months following any alleged breach of warranty.

Distributor’s sole and exclusive remedy in the event of defect is expressly limited to the replacement or correc-
tion of such defective parts by manufacturer at its election and sole expense, except there shall be no obligation 
to replace or repair items which, by their nature, are expendable.

 ese terms and conditions shall be governed by and construed in accordance with the provisions of the Uni-
form Commercial Code as adopted by the State of Mississippi.

For detailed warranty information by unit, So ware End-User Agreement, access to ADA compliance statement, 
PCI v3 EPP certiĕ cations, card reader TQM certiĕ cations, EMV certiĕ cations and more, please visit www.trito-
natm.com. Click Service & Support.



 is guide covers the operating information and installation procedures for Triton Connect 6.2. 



 is manual applies to all service personnel involved in installing, conĕ guring, or upgrading so ware on Triton 
ATMs nationwide and abroad. 



 is user guide provides information, methods, and easy-to-follow instructions for operating Triton Connect 6.2 
monitoring so ware.  e manual contains information regarding initial set up of Triton Connect 6.2, navigation 
of important features, and basic usage instructions.
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 

AC Alternating Current

ATM Automated Teller Machine 

CAT-5 Category 5 (ethernet)

EMV Europay, Mastercard, and Visa

EPP Encrypting Pin Pad 

FCC Federal Communications Commission

PCI Payment Card Industry

SSL Secure Socket Layer 

TCP/IP Transmission Control Protocol/Internet Protocol

TLS Transport Layer Security
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  - 

   

Triton Connect allows users to remote-manage one or many Triton Systems ATMs. Advantages include in-
creased effi  ciency and reduced costs associated with managing your ATMs. Triton Connect provides a proven 
ATM monitoring solution, which currently manages thousands of Triton ATMs throughout the United States 
and worldwide.



Install the Triton Connect so ware on a single PC as a stand-alone conĕ guration for a single point of adminis-
tration, or install on multiple PCs as a network conĕ guration which allows the distribution of management tasks 
to multiple personnel. Triton Connect can manage a Ę eet of ATMs of virtually any size. 



Triton Connect so ware enables the user to perform a wide range of monitoring and control functions from the 
convenience of a central location. In many cases, the so ware eliminates the cost of a technician traveling to the 
terminal location to perform conĕ guration or data retrieval functions. Triton Connect can access terminals via 
dial-up telephone service, TCP/IP land-line, or wireless connections.



Multiple levels of password protection prevent unauthorized individuals from using Triton Connect.  e so -
ware uses cryptographic protocols, such as SSL or TLS certiĕ cates, which provides authentication and data 
encryption between servers, terminals, and the Triton Connect application.



Triton Connect off ers a wealth of features to maximize the value of your investment in Triton Systems ATM 
products.  e so ware application groups these features within the following program blocks below.
 

• Terminal Manager

• Data Manager

• Call Monitor

• Call Viewer

• Alarm Monitor
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 

 e Terminal Manager application supports remote terminal conĕ guration, data retrieval and storage, and status 
monitoring.

 

 e Terminal Manager allows the user to set, monitor, and change terminal parameters from the convenience of 
a PC.  e following lists examples of these parameters. 
• Fast Cash Amounts and Withdrawal Limits
• Text or Graphics Advertising Screens
• Display and Coupon Message Text 
• Surcharge Amounts

   

 e Terminal Manager contains a powerful feature to retrieve, store, and manipulate terminal data in databases.
 e following lists examples of the types of data maintained in the databases.
• Terminal Identiĕ cation information
• Terminal Conĕ guration parameters
• Electronic Journal transaction data

 

Triton Connect can schedule periodic calls to the terminals and retrieve the most current status information.  e 
terminal sends detected error conditions to Triton Connect in real time. Once stored in the database, the appro-
priate Terminal Manager function retrieves the data and the user can view it at their convenience. 
 e following lists examples of available status information.
• Terminal Error conditions.
• Cassette Status (cash loaded, remaining).
• Status of Last Dispense operation.
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 

 e Data Manager application manages many of the data-processing functions previously handled by the Call 
Monitor and Call Processors, thus improving the speed and functionality of those applications.

 

 e Call Monitor gives Triton Connect the ability to calls the terminals—call-out operations—and to receive 
calls from terminals—call-in operations—using a combination of dial-up, TCP/IP, or wireless connections.  e 
Call Monitor exercises overall control of all call activity by assigning each communication line to a Call Proces-
sor. Each Call Processor monitors and controls the calling activity of its associated line.  e Call Processor will 
make calls to terminals, answer calls from terminals, provide indications of the activities taking place during 
a call, and terminate the connection a er a call.  e Call Monitor gives a standalone PC the ability to handle a 
high volume of call activities.



Triton Systems ©16

 

 e Call Viewer displays the activities of all active Call Processors from a licensed workstation on the network. 
A Call Processor acts as an interface between the Call Monitor application and the communications hardware; 
modems, telephone lines, and TCP/IP.

 

 e Alarm Monitor checks incoming calls for alarm conditions reported by the terminals, and provides visual 
indications of such conditions.  e Terminal Manager maintains a printable report of the alarm conditions.
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      .

 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.2:
1. Adds ability to run Call Monitor as a Windows service.
2. Adds last contacted date and time from Triton Connect to the Cassette Status report.
3. Adds support for TLS1.2 between TC and SQL.
4. Adds ĕ le date and time to Terminal Files report for when ĕ les were created or last modiĕ es.
5. Adds more SSL security options for email alerts.
6. Updates ISO Numbers report to include a column for ISO Value.
7. Adds support for Tiered Surcharging.
8. Adds a message when attempting to reset error condition 924 – Counterfeit Note Detected.
9. Journal Data Changes: Due to changes in ATM so ware version 4.2.2 and later, Triton Connect 6.2 is needed 

to correctly reĘ ect the Day Close settlement amount and Cassette Close multiple amounts properly in the 
journal. Earlier versions will show N/A for these ĕ elds.

10. Corrects Terminal Status Reports excluding TID.
11. Corrects the confusion of checkboxes indicating the selected user’s permissions would not be updated prop-

erly in some circumstances.
12. Resolves: Cannot change max withdrawal amount on US dollar-dispensing ATMs in Mexico.
13. Resolves sporadic issue where changing passwords on ATM from Triton Connect would fail.
14. Resolves calls erroneously rejected due to no available call processors even though the call processors were 

available.
15. Resolves: Erroneously message “Warning voltage must not be greater than detection voltage!” received when 

attempting to change and save a value on the Extended Parameters screen.
16. Resolves the Incorrect behavior when replacing a z180 ATM with a CE-based ATM.
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      ., , ,  

 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.1 SP3:
1. Adds support for TLS 1.2 between Triton Connect and SQL Server.

 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.1 SP2:
1. Updated the background graphic on the main Terminal Manager.
2. Adds a new report detailing how long terminals were out of service with individual error codes across a 

selectable date range.
3. Restores a feature to allow the user to view and modify EFLAG values.
4. Added message showing the IP Address of the client attempting to connect on the port conĕ gured for SSL.
5. Resolves the issues of individual call processors could cause the CPU usage to spike and remain maxed for 

the duration of the TCP/IP connection.
6. Resolves so ware downloads to a Z180 terminal starting at the wrong location a er a broken connection 

resumed.
7. Resolves empty message, welcome message, causing a partial display of the terminal conĕ guration overview.
8. Resolves missing terminal IDs when attempting to locate a terminal for a so ware download broadcast.
9. Resolves issues of incorrect journal results based upon a PC with a date range set in day/month/year format.
10. Resolves the issues of an OCX ĕ le not registering properly during installation.

 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.1 SP1:
1. Resolves the issue of Triton Connect moving a scheduled call to the error call list, if the PC language was set 

to Spanish.
2. Resolves the issue of Triton Connect broadcasting a load ĕ le to multiple ATMs.

 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.1:
1. Adds a dashboard to view terminal status, the call list, as well as the ability to view call processors.
2. Parameters will be stored in SQL. If default settings are used and the automatic database upgrade processes 

are performed at the end of installation, the parameters will automatically be copied to SQL.
3. More information has been added to Triton Connect’s Conĕ guration Overview for terminals.  e data added 

to the overview is as follows: Terminal Messages, EMV Info, Coupon Info, Default Transaction, Default Ac-
count, Default Language, Scheduled close enabled status and time, and Screen File.

4. Adds support for licensing based on the number of terminals in Triton Connect.
5. Removes Status history limit that resulted in lost and erroneous reports.
6. Beginning with this release of Triton Connect does not need to be uninstall to upgrade. 
7. Resolves PIN Unlock reported incorrectly in Triton Connect when viewing journals.
8. Resolves not able to view entire dispenser error details in Terminal Status Messages report.
9. Resolves Call Processors set for outgoing only, then accepts incoming calls.
10. Corrected Terminal Manager crashes if Conĕ g Overview is minimized.
11. Updated wording on the Mail Server Settings dialog, the wording for the from address was updated from 

“Email Address for Undeliverable Mail” to “From Email Address”.
12. Resolves potential problem, If the ‘Use Incoming IP Address’ option is enabled for a terminal, under certain 

circumstances there is a possibility that the wrong IP address could be updated for the ATM.
13. Changes: UAC will no longer be disabled nor will the user require administrator privileges. During the in-

stallation and upgrade process, a directory called TritConn will be created in the ProgramData folder and all 
users will be granted full control of the TritConn directory. If the automatic upgrade processes are completed 
at the end of installation, a copy of all ĕ les that Triton Connect both reads and writes to will be made and 
placed in the new ProgramData\TritConn directory, and those ĕ les will be used from that location.

14. Since the archive journals functionality no longer applies, the option was removed from the File menu.
15. Resolves the Journal Data Report from an archive functionality not working.
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      ., , , , ,  

 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.0 SP5:
1. Includes support for ATMs equipped with an anti-skim card reader. 
2. Resolves the issue of Triton Connect calling an ATM more than the set number of retries for failed calls. 
3. Resolves the issue of missing information from exported .csv ĕ le about bills dispensed from cassettes 2, 3, 

and 4 when using a G60 recycling dispenser. 
4. Resolves EMV Data Report not showing ATM with EMV enabled, but all EMV applications are disabled. 
5. Resolves the issue of not properly merging two databases using the Triton Connect Database Utility. 
6. Resolves the issue of overĘ ow error when attempting to place a call through Triton Connect. 
7. Resolves the issue of Call Monitoring crashing under a heavy load of TCP/IP connection requests.

 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.0 SP4: 
1. Includes all Optional Screens in Confi g Overview omitted in the Triton Connect.
2. Fixes the issue of getting an error message when selecting a fi le for a software download.
3. Fixes the issue error occurring when pasting in a large number of ISO bins.
4. Resolves the issue of an error indicating a database item was not found when a fl at fi le is being processed.
5. Resolves the issue of the new price per gallon not being sent when a price per gallon update is rescheduled.
6. Allows the perimeters to be viewed or changed when using full extended amounts on the ATM.
7. Includes the Triton Connect Manual in installation.
8. Increases the number of ATMs for a Bulk Delete.
9. Resolves the issue of the journal table remaining after an ATM was deleted.
10. Resolves EMV data not copied when two databases are merged using the Triton Connect Database Utility.

 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.0 SP3:
1. Performance enhancements when opening and performing operations within the Terminal Manager.
2. Resolves error report stating no data is available when attempting to run Triton Connect numbers report.
3. Resolves the issue of an error message given, preventing a ĕ le from being selected to send to the ATM.
4. Fixes the problem of not populating ĕ elds for the SPED and dispenser during the Version Numbers Report.
5. Resolves the issue on the Call Viewer crashing when being restored a er being minimized.
6. Resolves price per gallon not sent when call to update price per gallon rescheduled from the call error list.

 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.0 SP2:
1. Increases the number of ATMs for a Bulk Delete.
2. Gives email alerts higher priority than calls to an ATM.
3. Added support for T9 error codes.
4. Added the ability to send load ĕ les to CE6 and CE7 ATMs.
5. Added maximum withdraw amount ISO. ATM support for this is dependent upon ATM so ware version.
6. Prohibits emails erroneously sent to ATM IP address.
7. Prohibits calls to ATMs from being placed at incorrect times.

 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.0 SP1:
1. Increases the number of ATMs for a Bulk Delete.
2. Adds ability to enable or disable SSL for sending email alerts and accepts self-signed certiĕ cates.
3. Removes journals from tc_main a er migration.
4. Resolves the issue of Triton Connect not placing a call without restarting the Call Monitor.
5. Resolves every other record not printed when journals printed to paper in extended format..
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 e following lists the features either new or modiĕ ed to the latest release of Triton Connect 6.0:
1. Increases the number of ATMs for a Bulk Delete.
2. Ability to ĕ lter by parameters.
3. Support for email with user name and password.
4. Ability to combine Triton connect databases.
5. Terminal Manager expiration.
6. Added support for more users.
7. Added more settings for user permissions.
8. Added ability to use Comloc on network.
9. Ability to migrate journal archives to SQL Support enabling /disabling protocol reversals.
10. Ability to import ATM user password from ĕ le.

E  C 
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  - 
   

Triton Connect has two deployable conĕ gurations:
1. Network.
2. Standalone

 

See the Network Conĕ guration diagram below to view a typical network conĕ guration. For installation purposes 
the user needs to understand the roles played by the Database File Server, Operator Workstation (or Client PC) 
and the Call Monitor PC. 

  

 e so ware installs Triton Connect into the Call Monitor PC and creates databases accessible to the client and 
Call Monitor PC. Allowable network PCs will access and update data to the databases.

  

 e Main Application PC manages the processing of calls across the communication interfaces connecting the 
Triton Connect host installation to the remote terminals.  e so ware installs Terminal Manager (TM), Alarm 
Monitor (AM), and Call Monitor (CM) onto the Main Application PC.

   

Each Operator Workstation needs the program code, which performs terminal monitoring and control opera-
tions via the Terminal Manager and Alarm Monitor applications.
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 

See the diagram below. In a standalone conĕ guration, a single PC hosts all the Triton Connect applications and 
associated functions, to include database storage and call monitoring.

 e standalone conĕ guration handles communications with remote terminals via TCP/IP, one modem, or a mo-
dem pool as shown in the diagram.  e Modems are telephone modems with Ethernet connections. 

  

Triton systems has tested and recommends the following PC hardware conĕ gurations for Triton Connect 6.2. 

**Note**
Triton Connect 6.1 added support for TLS 1.2. If the PC supports this version of TLS, it will automatically be 
generated. Windows versions prior to 7 do not support TLS 1.2.

Network Conĕ guration
(Used for database storage only)

1. Operating systems: Windows XP, Windows 7, Windows 8, Windows 10.
2. Window Server 2008 thru 2019 to operating system.
3. Pentium 4 equivalent or faster CPU.
4. 4 GB or higher RAM.
5. 20GB Free hard drive space.
6. Dedicated a USB port (for Comloc device).

Operator Workstation
(Manages the Terminal Manager and Alarm Monitor applications)

1. Operating systems: Windows XP, Windows 7, Windows 8, Windows 10.
2. Pentium 4 equivalent or faster CPU.
3. 4 GB or higher RAM.
4. 20GB Free hard drive space.
5. Dedicated USB port (for Comloc device)
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Main Application PC
(Manages the Call Monitor application)

1. Operating systems: Windows XP, Windows 7, Windows 8, Windows 10.
2. Pentium 4 equivalent or faster CPU.
3. 4 GB or higher RAM.
4. 20GB Free hard drive space.
5. Dedicated a USB port (for Comloc device)

Standalone PC Conĕ guration

Triton Connect 6.1 allows it to perform in a standalone conĕ guration; however, the additional enhancements 
to the current release makes more demands on the system hardware.  e minimum system requirements for a 
single PC/single modem conĕ guration are listed below. 

1. Operating systems: Windows XP, Windows 7, Windows 8, Windows 10.
2. Pentium 4 equivalent or faster CPU.
3. 4 GB or higher RAM.
4. 20GB Free hard drive space.
5. Hard disk with a minimum of 20GB of free space.
6. Dedicated a USB port (for Comloc device).

 

  

In either a network or standalone environment, the type of modem to use for dial-up communications is an im-
portant consideration. See the next page for information concerning modem selection.

Each telephone line connected to Triton Connect will require a modem as the interface between the analog tele-
phone system and the PC. Triton Connect supports either the Universal Serial Bus (USB) or standard modems 
with RS-232 serial interface protocol.

Most modern PCs have one or two USB and/or serial ports, accessible from the rear panel of the main unit. If the 
need for additional telephone lines exceed the number of available PC ports, connect a multi-port interface card 
or device to the PC and add addition lines to the multi-port.

**Note**
Triton Connect supports communications using up to 20 modem connections.

  

If the user requires USB modems, they should only connect to USB ports or a USB hub.  e hub allows multi-
ple modems connections to a single physical PC port. Triton does not recommend the use of any USB to Serial 
adapters due to the potential of increase of data corruption.
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  

If using standard serial modems instead of USB modems, add a multi-port adapter module for additional ports.
With a variety of multi-port, I/O devices on the market, many fail the demands of large scale serial communica-
tions with Triton Connect. If the PC needs a multi-port adapter, DigiAccelePort 8em PCI Host Adapter meets 
the performance requirements.

Follow the manufacturer’s instructions for installing and conĕ guring the multi-port hardware.

 

Triton recommends  the  following modems, which have been tested with Triton Connect
     
1. 3COM (U.S. Robotics) Courier V Everything  56K  (RS-232 serial)
2. MultiTech Systems MultiModem V.90 Data/Fax Modem with USB.
3. MultiTech Systems MultiMobile 56K Data/Fax Modem (USB)

 ese external modems connect to the PC using either a RS-232 serial cable (3COM V Everything) or a USB 
cable (Multitech MultiModem and MultiMobile modems.)

Triton recommends the US Robotics model 5699B for PC internal slots.

Caution  
For correct operation, the dip switches on the bottom of the 3COM V Everything modem chassis must match the 
settings shown below.

**Note** 
Whichever modem selected, insure the PC has the latest modem drivers available for your operating system.

MODEM CONFIGURATION SWITCHES

SWITCH # FUNCTION OFF ON

1 DTR NORMAL X

2 VERBAL RESULT CODES X

3 DISPLAY CODES X

4 ECHO OFFLINE COMMANDS X

5 SUPPRESS AUTO ANSWER X

6 NORMAL CARRIER DETECT X

7 DISPLAY ALL RESULT CODES X

8 ENABLE AT COMMAND X

9 DISCONNECT WITH +++ X

10 LOAD NVRAM DEFAULTS X
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 

/  

Install the TCP/IP protocol on a standalone PC, a Call Monitor PC, an Operator Workstation, and a Database 
File Server PCs, so the various Triton Connect applications will communicate with one another. 

 / 

Triton Connect utilizes Internet Protocol (TCP/IP), and must be correctly installed, so the Call Monitor will 
communicate with the Data Manager and Call Viewer applications. Login the PC as an Administrator or a mem-
ber of the Administrators group to complete this procedure.

During the PC’s operating system setup, it will detect the network adapter hardware and set TCP/IP as the 
default network protocol. If the TCP/IP is not installed, obtain the assistance of your network administrator or 
other PC support personnel.

A er installing Triton Connect, perform the Power option for the Windows 10 operating system. 
Right click the Start icon, click Power Option, and click Power & Sleep.
Locate Sleep and set the following: 
On battery power, PC goes to sleep a er: NEVER 
When plugged in, PC goes to sleep: NEVER

Caution

1. For Brand new installations of Triton Connect 6.2, go directly to the “Install Triton Connect section.
2. If the user has a previous version of Triton Connect, Triton recommends coping the following database ĕ les 

to the desktop. Navigate to the old Triton Connects’ default database location: C:\Progradata\Tritconn folder 
or current database location. Copy and Paste the ĕ les, do not drag and drop the ĕ les.

 ○ TC_main.mdb

 ○ Callist.mdb

 ○ Stathis.mdb  (This not needed unless the customer/processor needs the stats history)

3. Upgrade Triton Connect based upon the current version. Once the upgrade completes, navigate to the de-
fault database location: C:\Progradata\Tritconn folder or current database location. Rename the following 
ĕ les:

 ○ TC_main.mdb > TC_main.mdb.1

 ○ Callist.mdb > Callist.mdb.1

 ○ Stathis.mdb > Stathis.mdb.1

4. Copy the two or three database ĕ les save to the desktop and paste them into the default database location: C:\
Progradata\Tritconn folder or current database location. 
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  

 is section covers the actions needed to install the Triton Connect program on your network or a standalone 
system. You must have a USB Comloc device.

Caution

 e Triton Connect feature of the ATM must be ENABLED and conĕ gured with the correct phone numbers or 
TCP/IP information to allow communications with your Triton Connect host system. See your ATM Operation 
Manual for instructions on enabling the Triton Connect feature and entering the appropriate information.

  

 ese instructions perform a fresh Triton Connect 
installation on a single PC. Triton Connect will up-
date the Windows Installer and .Net Framework, if 
required. SQL Server 2012 R2 Express available with 
this program.  is release Adds support for TLS 1.2 
between Triton Connect and SQL Server.

Perform the following steps to install this release of 
Triton Connect as a single-PC new installation. 

1. Run setup.exe for this release of Triton Connect as 
administrator. 

2. When presented with requirements of additional 
so ware, click the Install button.

3. When prompted to install or upgrade SQL Server 
Express, click the Yes button. 

4. Proceed with the SQL Server 2012 Express installa-
tion with default options. 
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Read and accept the license terms. Click the Next 
button to continue.

ON the next six screens, leave the default options and 
click the Next button.
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With SQL install complete, click the Close button to 
continue the Triton Connect installation.

5. On the welcome to the installer Wizard screen, 
click the Next button. 

6. Read and accept the license agreement. Click the 
Next button. 

7. Enter User Name and Organization (optional). 
Click the Next button. 



Triton Systems ©29

8. Leave installation type as Complete and click the 
Next button. 

9. Click the Install button. 

10. Once complete, click the Finish button. 

11. On the Comloc installation utility, select USB 
Dongle GREEN, for Dongle Type and Standalone, 
RED, for Installation Type. 

12. Click Begin Install and follow any on-screen in-
structions. 

13. When prompted to perform automatic database 
upgrade processes, click the Yes button. 
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14. When prompted to perform parameter migration 
with default settings, click the Yes button. 

15. Once the automatic upgrade and migration pro-
cesses are complete, click the Migrate button for 
journal data. 

16. Once the journal data migration has completed,  
RED, close the Triton Connect Database Migration 
Utility. 

17. Triton Connect is ready to use.
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    . 

Note:  ese instructions assume that SQL Server Express 2008 R2 is installed as included in a previous Triton 
Connect installation.  ese instructions assume that the existing SQL Server instance will be upgraded to SQL 
Server Express 2012. However, Triton Connect is still capable of using SQL Server Express 2008 R2. If TLS1.2 
between SQL Server and Triton Connect is not required, the upgrade to SQL 2012 Express may be skipped.

Perform the following steps to upgrade to Triton 
Connect  6.2.

1. Run setup.exe for this release of Triton Connect as 
administrator. 

2. When prompted to perform an upgrade of Triton 
Connect, click the Yes button. 

3. When presented with the screen listing other so -
ware requirements, click the Install button. 

4. When prompted to upgrade SQL 2008 Express 
to SQL 2012 Express, click the Yes or No button 
based on your needs. 

5. If upgrading SQL 2008 Express to SQL 2012 Ex-
press, follow the on-screen prompts. 

Read and accept the license terms. Click the Next 
button to continue. 
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On the next 6 screens, leave the default options 
selected and click the Next button. On the sixth screen 
click the Close button
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6. Once the installation process has returned to the 
Triton Connect installer, the SQL Server Native 
Client 11 will be installed in the background, if 
needed.

7. To install Triton Connect, click the Next button. 

8. When the Wizard completes the install, click the 
Finish button. 

9. Click the Exit button when the Comloc install 
utility opens. 

10. When prompted to perform automatic database 
upgrade processes, click the Yes button. 
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11. Once the database upgrade completes, close the 
Triton Connect Database Migration Utility. 

12. Triton Connect should now be ready to run. 
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Perform the following steps to upgrade to Triton 
Connect  6.2.

1. Run setup.exe for currently installed Triton Con-
nect 6.0.

2. Click the Next button to continue to the Program 
Maintenance Screen. 

3. Select Remove, then click the Next button.

4. Click the Remove button. 

5. Click the Finish button once the uninstall process 
is complete. 

6. Run setup.exe for this release of Triton Connect 6.2 
as administrator. 

  T C .

 is process assumes a single-computer installation with SQL Server Express 2008 installed on the local PC. 
Upgrading to SQL Server 2012 Express is optional.
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7. When presented with the screen listing other so -
ware requirements, click the Install button. 

8. When prompted to upgrade SQL Server 2008 Ex-
press to SQL Server 2012 Express, click the Yes or 
No button based on your needs. 

9. If upgrading SQL Server Express versions, follow 
the on-screen prompts. 

Read and accept the so ware license, then click the 
Next button to continue. 
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10. With the completion of the SQL Server Express 
installation, click the Close button to continue the 
Triton Connect installation.

11. Once the installation process has returned to the 
Triton Connect installer, SQL Server Native Client 
11 will be installed in the background, if needed. 

12. When the Welcome to install the Triton Connect 
screen opens, Click the Next button. 
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13. Read and Accept the license agreement. Click the 
Next button. 

14. Enter User Name and Organization (optional). 
Click the Next button.  

15. Select Complete and click the Next button.  

16. To install Triton Connect, Click the Install button. 
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17. When the Wizard completes the install, click the 
Finish button. 

18. Click the Exit button when the Comloc install 
utility opens. 

19. When prompted to perform automatic database 
upgrade processes, click the Yes button. 

20. When prompted to perform parameter migration 
with default settings, click the Yes button. 

21. Once database upgrade and migration processes 
are complete, the Triton Connect Database Migra-
tion Utility can be closed. 

22. Triton Connect should be ready to run.
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Perform the following steps to upgrade to Triton 
Connect  6.2.

1. Make a backup copy of the contents of the Triton 
Connect directory (optional).

2. Run setup.exe for this release of Triton Connect as 
administrator. 

3. If presented with requirements of additional so -
ware, click the Install button. 

4. Install SQL Server Express, if needed, using default 
settings. 

5. At the initial Triton Connect install Wizard screen 
click the Next button. 

6. Read and accept the license agreement. Click the 
Next button.

    .  .

 ese instructions assume a single-PC installation upgrade from 5.x or 4.4 to this release of Triton Connect. 
 ese instructions also assume that the Comloc driver is already installed. 

Microso  SQL Server will not successfully install on a disk that is either compressed or encrypted. 
 

**Note**
If upgrading from a Triton Connect version prior to 4.4,  e user must install either 4.4 or 5.x prior to installing 
this release.
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7. Enter a User Name and Organization (optional). 
Click the Next button. 

8. Select Custom and click the Next button. 

9. Select Main and verify that the “Install to” path 
is the location of the previous Triton Connect 
version. Click “Change…” to change the install 
location if needed. 

10. In the previous image, click the down arrow for 
Database and select “ is feature will not be avail-
able.” Click the Next button.

11. Click the Install button. 

12. Once completed, click the Finish button. 
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13. Click the Exit button, when the Comloc install 
utility opens. 

14. When prompted to perform automatic database 
upgrade processes, click the Yes button. 

15. When prompted to perform parameter migration 
with default settings, click the Yes button. 

16. Once the automatic upgrade and migration pro-
cesses are complete, click the Migrate button for 
journal data. 

17. Once the journal data migration is completed, the 
word “Done” appears at the end of the list. Close 
the Triton Connect Database Migration Utility. 

18. Triton Connect is ready to use.
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

Triton Connect uses a two-level password protection 
scheme.  e ĕ rst level provides ĕ ve User Passwords 
(User 1, User 2, User 3, User 4, and User 5), and 
grants access that does not require control of sensitive 
features such as so ware download or terminal 
password management.

 e second, higher level password referred as the 
Supervisor Level Password, gives complete control to 
trusted personnel whose responsibilities require full 
access to all Triton Connect features.

 

 e default Supervisor password is: ‘connect’.
 e default User 1 password is: ‘triton’.
 e default User 2 password is: ‘so ware’.
Password is lower case without the parenthesis.

 e supervisor level password will assume its default 
value of ‘connect’ until modiĕ ed.

Caution

Remember to change the default passwords as soon as 
possible a er completing the installation.

  

A password entry window appears, when the Terminal 
Access Manager application starts for the ĕ rst time.

At this point, you have the option of entering the 
Terminal Manager as a User, or as a Supervisor.  e 
level of access granted depends upon the User ID: User 
1, User 2, User 3, User 4, User 5, or Supervisor.

- 

Individuals with User 1 or User 2 access cannot perform 
these actions below.

1. Cannot change the Supervisor password.
2. Cannot perform so ware downloads.
3. Cannot alter certain terminal parameters, which 

depends upon the operating so ware installed in 
the terminal.

 e above functions can only be performed by personnel 
with Supervisor access.

 e User ID appears in the title bar of the Terminal 
Manager window.
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 / 

A er installing Triton Connect, immediately change 
the default passwords. Enter the Terminal Manager 
using the Supervisor password. Click the Security 
option on the menu bar.  e Manage User Account(s) 
screen should appear.

User                            Supervisor

  

Under Select User: use the down arrow to select a 
User. Click the Change Password option. Enter a new 
password in the top text box. On your keyboard press 
the Tab key and enter the new password in the Verify 
New Password text block. Click the OK button. 

A successfully written password to the Comloc device 
generates a ‘User#/Supervisor password updated’ 
message or a ‘Did not change password’ message. Click 
the OK button to dismiss the message box. 

 

 

 

Call Monitor 6.0 and higher will expire according to 
the expiration on the Triton Connect Comloc. A er 
expiration, the Call Monitor will not operate until the 
Comloc expiration has been updated.  e Terminal 
Manager will continue to function as normal a er 
expiration.

When the license for the Comloc’s expiration date falls 
to 30 days or less, the Call Monitor will display a notice 
upon the startup, or if the Call Monitor remains open 
for an extended period, the notice appears once per 
day.

Notice of expiration at 11 days or less, top image. No-
tice of expired Comloc license, bottom image. 
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   

To extend the expiration date, the Comloc needs 
an ability for remote updates.  e Triton Connect 
installation contains a Comloc Remote Update Client 
utility.  e user must contact Triton Technical Support 
to use the utility.
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Perform the following steps to install as a server. 

1. Run setup.exe for this release of Triton Connect as 
administrator 

2. If presented the requirements of additional so -
ware, click the Install button. 

3. When prompted to install SQL Server Express, 
choose based on if this or another version of SQL 
Server will be used. If installing this version, Click 
the Yes button and proceed through setup accord-
ing to your environment.

4. For the Triton Connect installation type, choose 
Custom and click the Next button. 

   .

**Note** 
 is installation is for a server that will host the database and the Comloc. Client computers will run the Triton 
Connect application and connect to this server to access the databases and the Comloc.  is document cannot 
cover the SQL server conĕ guration due to the severs varying operating environment. Use either the version of 
SQL Server Express included with the Triton Connect installation or a full version of SQL Server.  is server 
may or may not run the Triton Connect application.  ese instructions assume a fresh installation of Triton 
Connect. 

 ese instructions do not cover setting up a shared directory on a network or other required processes de-
pending on operating environments.   ese instructions assume that the default SQL connection string and the 
default database and installation paths are all applicable. 

Caution

Microso  SQL Server will not successfully install on a disk that is either compressed or encrypted.
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5. Verify/update the installation path and click the 
Next button.

6. Click the Install button. 

7. Once complete, click the Finish button.

8. For Dongle Type select USB Dongle RED.
9. For Installation Type select the Server radial but-

ton, PURPLE. 
10. Click the Begin Install button and follow the on-

screen instructions. 

11. Click the Close button on success message. 
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12. When prompted to perform automatic database 
upgrade processes, click the Yes button. 

13. When prompted to perform parameter migration 
with default settings, click the Yes button. 

14. Once the automatic upgrade and migration pro-
cesses are complete, click the Migrate button for 
journal data. 

15. Once the journal data migration has completed, 
close the Triton Connect Database Migration Util-
ity. 

16.  e server setup should now be complete.
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Perform the following steps to install the client instal-
lation.
 
1. Run setup.exe for this release of Triton Connect as 

administrator.

 
2. If presented the requirements of additional so -

ware, click the Install button. 

3. When prompted to install or upgrade SQL Server 
Express, click the No button 

4. On the Welcome to the Installer screen, click the 
Next button. 

5. Read and accept the license agreement, click the 
Next button.

  .

If another computer on the local network has been conĕ gured as a server for the databases and the Comloc, ad-
ditional computers may connect to those same resources. Conĕ gure the TC Main database location as a mapped 
drive to access the SQL Server database.  e client contacts the server via port 4242 to use the Comloc across the 
network.
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6. Enter a User Name and Organization (optional). 
Click the Next button. 

7. Leave installation type as Complete. Click the Next 
button. 

8. Click the Install button. 

9. Once complete, click the Finish button. 
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10. When the Comloc install utility opens, click Client 
under Installation Type, RED rectangle. 

11. Click Set Server (Optional) button in the Server 
Selection for Client section ORANGE rectangle. 

12. Click the Manual server selection by Name OR IP 
Address radio button and enter the IP address of 
the Comloc server. 

13. Click the OK button 

14. Click the Begin Install button and follow any on-
screen instructions.

15. When prompted to perform automatic database 
upgrade processes, click the No button. 
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16. If this is the ĕ rst version of Triton Connect 6.1 or 
6.2 to be installed on this client, click the Perform 
File Migration button when the Triton Connect 
Database Migration Utility appears. 

17. Once the ĕ le migration has completed, see 
ORANGE rectangle in previous image, verify 
or update the TC_Main Path and click the Save 
button. 

18. Verify or update the SQL Connection String for 
Journals. Click the Initialize button, then click the 
Save button, RED rectangle.  

19. Verify or update the SQL Connection String for 
Parameters. Click the Initialize button, then click 
the Save button, RED rectangle. 

20. Close the Triton Connect Database Migration 
Utility.

21. Triton Connect should now be ready to use on the 
client computer
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

View the Terminal Status, Call List, and the Call Processors via the Triton Connect Dashboard; disabled by 
default. To enable the dashboard settings, launch the Triton Connect Terminal Manager, open the Setup menu, 
click Options, and click Dashboard Conĕ guration.

 ree sections exist on the dashboard conĕ guration screen, one for each of the following dashboard compo-
nents: Terminal Status, Call List, and Call Viewer. Enable or disable one, two, or all independent components on 
the dashboard. 



Triton Systems ©54

A check in the Enabled box activates the Terminal Status components to include the Table Name ĕ eld, Height 
percent ĕ eld, Show grid lines check-box, and Show only terminals with an error code check-box. 
 
 e Table Name ĕ eld becomes important in an environment when multiple client Triton Connect installations 
access the same database. Assign a unique value in the ĕ eld for each terminal. 

 e Height ĕ eld sets the height of the Terminal Status at a percentage of the Terminal Manager screen.

Check the ‘Show grid lines’ block to add lines around each data block similar to a spreadsheet. Check the ‘Show 
only terminals with an error code’ block to display only terminals with an error code.
 
 e Field Width sets the percentage of width for each component data shown in the dashboard.  e sum of the 
ĕ elds may exceed one hundred percent.  

To enable the Terminal Status portion of the dashboard, check the Enabled check-box in the Terminal Status 
section then click the OK button on the Dashboard Conĕ guration window.

From the Terminal Status component of the dashboard, right-click on a TID terminal to present shortcuts to 
Modify Terminal, Get Terminal Data, Set Terminal Parameters, View Terminal Parameters, View Journal Data, 
and So ware Download.
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 e Call List section of the Dashboard Conĕ guration window contains the check box to enable the Call List 
dashboard component, along with a height percent ĕ eld, a show grid lines check box, and the ĕ eld width percent 
settings for several ĕ elds shown in the dashboard.  e sum of the ĕ elds may exceed one hundred percent.
 
To enable the Call List, check the Enabled check box in the Call List section of the Dashboard Conĕ guration 
screen and click OK. 
 

In the Call List section of the dashboard, right-click on a call to present the option to delete the call.
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 e Call Viewer section of the Dashboard Conĕ guration window contains the check box to enable the Call 
Viewer dashboard component, the height percent setting, and the IP address and port settings for connecting to 
the Call Monitor. 
 
To enable the Call Viewer, check the Enabled check box in the Call Viewer section of the Dashboard Conĕ gura-
tion window, enter the IP address and port number, and click OK.

Double-click on a Call Processor will cause that Call Processor to ĕ ll the Call Viewer area and display detail 
information, as shown below. Right-click on the screen will present the option to pause or resume. To return to 
viewing all Call Processors, double-click anywhere within the Call Processor.

    

SQL database stores the Triton Connect parameters. If upgrading Triton Connect from a version earlier than 6.0 
and using the default settings, the automatic database upgrade processes performed at the end of installation, 
will automatically copy the parameters to SQL.
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  

If a user needs the current conĕ guration of a speciĕ c terminal, the Conĕ guration Overview will provide the de-
tails. Perform the follow steps. 
1. Navigate to the Terminal Manager > Terminal Data > View Terminal Parameters.
2. Click View Parameters button. 

 

3. If the Select Terminal ID: does not show the terminal needed, click the down arrow and click the desired 
terminal ID. In the upper right corner of the Terminal Parameters’ screen, the TID: shows the terminal ID 
selected. 

4. Click the Version Numbers tab. In the lower le  corner, click the View Conĕ g. Overview button.

**Note**
 e Conĕ guration Overview in version 6.1 provides more information: Terminal Messages, EMV Info, Coupon 
Info, Default Transaction, Default Account, Default Language, Scheduled close enabled status and time, and 
Screen File.
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At the bottom of the Conĕ guration Overview screen, click the Copy Text button. Open a text editor program. 
Paste and Save the overview in the document for future reference. Saving this document as soon as the ATM 
goes online will help establish the ATM’s baseline.
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  

  ,

Triton Connect 6.1 includes support for licensing 
based on the number of terminals in Triton Connect. 
To view the number of terminals supported by your 
license, from the Terminal Manager Navigate to Setup 
> Options > Comloc Information.

  

Once the license reaches the maximum number of 
terminals supported and the user attempts to add a 
terminal to Triton Connect, a message will indicate no 
terminal added and contact Triton Technical Support 
to update the license. 

, ,   ()

 e Comloc stores the licenses, users, and 
authorization (lua) information, along with number 
of terminals. An lua is used for each instances of  Call 
Monitor and Terminal Manager running.  ese items 
determine the Comloc’s pricing as per the customer’s 
needs
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    

**Note** 
Merge any databases prior to using this feature. A er 
completing the mergers and setups, migrate the jour-
nal archives at any time.

Follow the steps below to migrate a journal archive to 
SQL.
1. Locate the TC Database Utility.exe program locat-

ed in the installation folder.
2. Click the Migrate Journal Archive tab.
3. Enter or browse for the TC_Main.mdb database.
4. Enter or browse for the journal archive ĕ le.
5. Click the Begin button.

    

Use this feature on databases from Triton Connect 
5.x and above. Both the source and the destination 
databases require the same Triton Connect version 
for compatibility purposes. A copy of source database 
contents will transfer into the destination database.

**Note** 
As part of the merge process, all journal data removed 
from the source and destination databases convert to 
archives. Use the Migrate Journal Archive functionality 
to import the archives into SQL, if desired.
Combine databases by performing the steps below.
1. Close any Triton Connect components that may 

access either the source or the destination database.
2. Launch TC Database Utility.exe (located in the 

installation folder).
3. Navigate to the Merge Databases tab.
4. Enter or browse for the destination database loca-

tion.
5. Enter or browse for the source database location.
6. Click Start.
7. Time to complete the merge will vary. Any feed-

back or errors will be shown in the lower half of 
the Triton Connect Database Migration Utility 
window.

E  C
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  -  



 e Call Monitor application conĕ gures and monitors communications with Triton Connect devices.

    

 e Call Monitor connects to Triton Connect remote terminals, using standard dial-up, TCP/IP, wireless, or 
VSAT communication connections. Call Monitor gives Triton Connect the ability to make calls to terminals 
(call-out operations) and receive calls from terminals (call-in operations). 

 e Call Monitor exercises overall control of all call activity by assigning each telephone line, TCP/IP connection 
or VSAT satellite link (as applicable) to an application called a Call Processor. Each Call Processor will moni-
tor and control the calling activity of its associated connection.  e Call Processor will make calls to terminals, 
answer calls from terminals, provide indications of the activity taking place during a call, and terminates the 
connection a er a call.

 e Triton Connect design allows for a greater data-handling capacity. A single PC, running a single Call Mon-
itor and using 20 Call Processors, can handle in-coming and outgoing calls for up to 1000 terminals. In extreme 
large-scale operations, Triton Connect can meet the requirements for additional terminal-handling capacities. 

Primary functions of the Call Monitor listed below.
• Call Processor startup and shutdown.
• Data Manager startup and shutdown.
• Routing of Call Processor activity data to the Call Viewer.
• Coordination of Call Processor and Data Manager activities.
• Receive calls if other parts of the program shut down. 
• Manage communications between remote terminals and the Triton Connect Host Installation.

    

Once the Call Monitor starts, the Call Processors will start a er a twenty-second countdown. Users may also 
start the Call Processors manually, either as a group or individual.

       

Approximately every 15 seconds the Call Monitor reads the entries in the Call List database.  e Call List data-
base shows when to make the call and which terminal to call. When the scheduled time arrives for an out-going 
call, the Call Monitor assigns an available Call Processor to handle the call.
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    

 e Data Manager processes the raw data received and stored by each running Call Processor. It saves the pro-
cessed data to the appropriate Triton Connect database.  e Data Manager starts when the Call Monitor starts 
and shuts down when the Call Monitor and any active Call Processors shuts down.

**Note**
If the Database Manager shuts down with the Call Processors running, the Manager will not process the Ę at ĕ le 
data until it restarts.  is means that until the Data Manager restarts and processes the data, the databases and 
any reports generated from this data will not be current.

       

 e Call Monitor assigns one or more available Call Processors to monitor calls from the terminals. As these 
complete the incoming calls, the Call Monitor directs the Data Manager to process the received raw data and 
store it in the Triton Connect database.

A Call Processor receiving data from a terminal saves that data to a raw data ĕ le called a “Ę at ĕ le.”  is Ę at ĕ le 
temporarily resides in a sub-folder of the Data folder in the Triton Connect installation directory or other us-
er-speciĕ ed location. Each terminal sends data to its own designated sub-folder named with the Terminal’s ID. 

 e Data Manager deletes the Ę at ĕ le a er the database saves the data. Sometimes the user may wish to save this 
data for later review. Do not access the raw data Ę at ĕ les during normal operations. Use the Save Flat Files func-
tion on the Call Monitor Diagnostics/Data Manager Settings menu to save archive ĕ les for later review.

**Note**
 e Call Monitor communicates with the Data Manager using the TCP/IP protocol connection. For proper com-
munications install the Call Monitor PC and workstation on the same LAN or WAN.
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      
   

 e PC running the Call Monitor can view the activ-
ity of each active Call Processor. In locations with a 
network installation of Triton Connect, the computer 
running the Call Monitor may not be readily accessible 
to operator personnel.

In such cases, any operator workstation running a le-
gal-licensed copy of Triton Connect with Comloc can 
view the Call Processor’s activities via the Call Viewer 
application.  e Call Monitor communicates to the 
Call Viewer with a TCP/IP connection.

**Note** 
To monitor the Call Processor activities through the 
Call Viewer, enable the Call Viewer function from the 
Call Monitor/Diagnostic screen. See description in the 
Enable Call Viewer section for more information.

 e Call Monitor allows several ways to view the Call 
Processor activities.

1. Summary single-line status:  e Call Monitor 
dialog off ers a single-line status entry for each Call 
Processor.

2. Single Frame: Call Processor activity displays in a 
frame that overlays the Call Monitor main dialog.

3. Separate Frames:  e activity of each Call Proces-
sor displays in its own dialog window—the default 
view.

   

Access the Call Monitor application from the Start/
Programs/Triton Connect menu in the Windows task 
bar or Windows 10 Start/Triton Systems. Click the 
Launch Call Monitor option. 

**Note**
You may wish to place a shortcut to the Call Monitor 
application in the Windows Startup folder.  is will 
allow the application to start, once the PC running the 
program boots up.

When the Call Monitor starts, a twenty-second count-
down begins.

When the countdown reaches zero, all enabled 
Call Processors will start. Click the Stop command 
button to terminate the countdown or click the 
Start command button to start the call processors 
immediately.

Once either the Call Processors starts, or the count-
down terminates, the Call Monitor’s screen appears.
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 e user may change all processors at once by clicking 
on either the Start All Processors button or the Stop 
All Processors button.

    

On the Call Monitor screen, click the Quit Program 
command button to shut down the program

 e user can select the Exit option from the File menu 
on the Call Monitor menu bar.

**Note**
When the Call Monitor shuts down, all associated 
components—Database Manager and any active Call 
Processors—will shut down.

    
 

 e Call Monitor can conĕ gure up to 20 Call Proces-
sors.  e monitor will display the default number of 8 
processors. To add more Call Processors, navigate to 
the Call Monitor > Settings and click Add a call Proces-
sor (20 Max).

To change the number of displayed processors, nav-
igate to the Call Monitor > View and click Maximum 
Call Processors. Use the up or down arrows to set the 
maximum number of Call Processors displayed on the 
Call Monitor screen. Select a value from 1 to 20. Click 
the OK button.  e Call Monitor will display the num-
ber of Call Processors speciĕ ed.
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Click Database Settings. A warning message appears. 
Read it careful before clicking the OK button.

Caution

Before changing database settings, make sure all other 
Triton Connect programs—Terminal Manager, Alarm 
Monitor, Call Viewer—have been shut down.

 is dialog lets you specify the location of the Triton 
Connect databases.

• Main (main.mdb)
• Call List (callist.mdb)
• Error List (errlist.mdb)
• Reports (reports.mdb)
• Reports Blank (rptblk.mdb)
• Status (status.mdb)
• Status History (stathis.mdb)
• Terminal (termerr.mdb)

 e default Triton Connect installation folder stores 
the databases. If the default location does not contain 
the databases, use this function to record the new loca-
tion so the Triton Connect applications will locate the 
databases. Click the Browse command button to bring 
up a ĕ le browse dialog. 

/  

To enable or disable the Call Viewer, navigate to the 
Call Monitor > Diagnostics menu. 

A check mark shows an active option.  e Call Viewer 
establish a TCP/IP connection with the Call Monitor 
to receive Call Processor activity data. Click the option 
to remove the check mark and disable the Call Viewer.

If the Terminal Manager does not display the Call 
Viewer, Navigate to the Terminal Manager > Setup > 
Options > Dashboard Conĕ guration option. Click the 
Call Viewer Enable box. Click the OK button.  e ter-
minal Monitor screen should display the Call Viewer.

  

** Note **
 e following instructions assume the user can navi-
gate folders on a computer running Windows XP, 7, 8, 
or Windows 10 operating system. On a network instal-
lation, IT personnel should change these settings with 
adjustments made to workstations. Locate all databases 
in the same folder. In a standalone installation and 
most network installations, the default settings allow 
the program to operate. Incorrect settings will prevent 
correct program functionality. 

Navigate to the Call Monitor > File > Database Settings 
option menu.

**Note**
 e Database Settings option becomes available if all 
the Call Processors have stopped running.
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   

   

 e Database Manager starts when the Call Monitor 
starts, and shuts down when the Call Monitor shuts 
down.

Clicking the Launch Data Manager option in the Win-
dows Start/Programs/Triton Connect menu, will also 
start the Data Manager.

 e Data Manager displays this dialog box for the 
following reasons.

•  e user starts the Data Manager manually with 
the Call Monitor not running.

• No TCP/IP connection between the Data Manager 
and the Call Monitor.

 
Click the Connect button to start the Data Manager 
application.

 e RED indicator chip in the lower le  corner of the 
Data Manager dialog box starts as RED. It will remain 
RED, until the Call Monitor starts and connects to the 
Data Manager via a TCP/IP connection.  e indicator 
chip will turn GREEN for a good connection.

Navigate to the folder with the Triton Connect data-
bases and click the Open button. Click the App button 
to accept the selection without closing the Database 
Utilities dialog, or click OK to accept the entry and 
exit. In either case, a conĕ rmation message will appear.

A er accepting the location selection, test access to the 
databases by clicking the Test Connection button. A 
status of “Success” next to each database name shows a 
connection established with the database in the speci-
ĕ ed location.
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    

Navigate to the Call Monitor > File > Shutdown Data 
Manager option to manually shut down the Data Man-
ager. 

A VERIFY WARNING screen will appear. Please read 
and understand the warning before clicking on the OK 
button to shut down the Data Manager.

 is option changes to Restart Data Manager a er the 
Data Manager shuts down.

Caution

With the Data Manager shut down, the Triton Connect 
databases will not update even though it still receives 
data from the terminals.  e Call Processor (CP1) 
window displays the Data Manager scan results.

If the Call Monitor terminates without notifying the 
Data Manager, the Manager becomes visible and the 
user can click the Exit button to close the dialog.

 

Under some circumstances the Data Manager will 
become visible. When it does, the Manager has not 
processed the Ę at-ĕ le data. Although the Data Manag-
er will perform this operation several times per hour, 
the user may wish to initiate the process function.

With a visible Data Manager dialog, click the Scan but-
ton to manually initiate the processing of any received 
Ę at-ĕ le data not yet processed and stored in the data-
bases.

   

A er the Call Monitor starts and a TCP/IP connec-
tion connects between the Data Manager and the Call 
Monitor, the indicator chip will turn GREEN and the 
Hide command button will appear on the dialog.

Click the Hide button and the Data Manager will hide 
in the background until an event occurs to bring it to 
the front. Recommend hiding the Data Manager for 
normal operations.

On the Call Monitor screen click the Have Data 
Manager Scan for Flat Files button to initiate the Data 
Manager’s Ę at-ĕ le scan.
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Caution

In a standalone installation and most network installa-
tions, the default TCP/IP settings do not require alter-
ations. Incorrect settings will prevent correct program 
operations.

Selecting the TCP/IP Settings option brings up the 
TCP/IP Settings dialog

 e dialog allows the user to enter or modify TCP/IP 
port entries for the following connections

• Call Monitor to Data Manager.
• Call Monitor to Call Viewer.
• Inbound calls from terminals using TCP/IP com-

munications.  e port number serves the equiva-
lent of a Triton Connect “phone number.”

• Inbound SSL Port:

Timeouts: Connection Request: (seconds) sets the num-
ber of seconds Triton Connect will wait on a connec-
tion request.  is option has a default value of 9-sec-
onds but should change to meet the locations optimum 
connectivity.

**Note**
 e TCP/IP Settings dialog box displays the TCP/
IP address of the computer running the Call Monitor 
application.  e Call Viewer requires the IP address, 
along with the Call Monitor to Call Viewer port num-
ber, to ensure correct Call Viewer operation.

   

If the Data Manager shuts down or does not com-
municate with the Call Monitor, Navigate to the Call 
Monitor > File and click the Restart Data Manager 
option.

 / 

Access the TCP/IP Settings option from the Call Mon-
itor > Settings menu.

 e Call Monitor communicates with various Triton 
Connect components using the TCP/IP communica-
tions protocol.  e connection with each component 
requires a Port Number.  e Call Monitor creates a 
default Port Number for each connection; however, 
your network administrator can conĕ gure the Port 
Numbers manually, if required to avoid conĘ icts with 
existing network settings.

 e TCP/IP settings displays the IP Address, port 
numbers and timeout while the Call Processors run, 
but the port numbers become available for change 
a er all Call Processors stop.
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 is option becomes available, when all Call Proces-
sors stop running. Selecting this option brings up the 
following dialog.

 e user sets the duration in intervals of hours, days, 
months, or years. Change the settings as needed and 
click the OK button.

From the time of creation, the Call Monitor watches 
the life of each Terminal Originated Call entry in the 
Call List. When the interval time expires, the Call 
Monitor removes the entry from the Call List.

  

Navigate to the Call Monitor > Settings > First Journal 
Timeout option. 

 is option enables and conĕ gures an extended 
amount of time while retrieving the ĕ rst journal 
record. Selecting this option brings up the following 
dialog. 

 e user sets the amount of delay time allowed when 
receiving the ĕ rst journal record. Check the Use ex-
tended Timeout box to enable this option.

   
  

Only terminal’s that support the Terminal Originated 
Call will have this feature.

Navigate to the Call Monitor’> Settings > Terminal 
Originated Call Settings option.
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     

Navigate to the Call Monitor > Settings > Add a Call 
Processor and Remove a Call Processor options from 
the menu.

   

Click the Add a Call Processor (20 Max.) option to 
add a Call Processor to the available list up to the 
maximum allowable number of twenty. If necessary, 
the Call Monitor dialog window can scroll to provide 
access to any additional Call Processors.

   

Click the Removes a Call Processor to remove a Call 
Processor from the available list.  e list will always 
have a minimum of one.

/   
 

Navigate to the Call Monitor > View > Update Status 
Text option menu

A check mark indicates an active option. Extended 
status information, in addition to the summarized 
information that normally appears, will display in 
the single-line status view on the Call Monitor main 
dialog.

      
 

Navigate to the Call Monitor > View > Display each 
view in separate window option menu.

A check mark indicates an active option. Click the 
View command button for a Call Processor and the 
activities for that processor will display in a separate 
status window.  e separate status window is the de-
fault selection.
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      
 

Navigate to the Call Monitor > View > Display a single 
frame for views option menu

A check mark shows an active option. When the user 
clicks the View command button for a Call Processor, 
a window replaces the normal Call Monitor dialog and 
displays the activity of the single Call Processor. If both 
separate window and single frame options have check 
marks,  e Call Monitor presents both views.

    

Caution

Do not use this option unless directed to do so by tech-
nical support personnel. Use this option for diagnostic 
purposes only.

Navigate to the Call Monitor > Diagnostics > Display 
Data on Screen option.

A check mark indicates an active option.  is function 
enables each Call Processor port to send all transmit-
ted and received data in hex code.  is data will appear 
in the applicable Call Processor’s activity window.

      


Caution

 is option can create very large ĕ les, so do not use 
unless directed by technical support personnel.

Navigate to the Call Monitor > Diagnostics > Capture 
to File option.

A check mark indicates an active option.  e Call 
Monitor creates a data ĕ le for each Call Processor in 
the Triton Connect program folder (output1.DAT, 
output2.DAT, etc.).

 is data ĕ le records a copy of the associated Call 
Processor’s activity display. Use a text editor or word 
processor program to view the data ĕ le contents.

     


Caution

Do not use this option without a thorough under-
standing of the program. No further information 
provided.
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     -
 

Navigate to the Call Monitor > Settings > Reserve a CP 
for incoming calls option. 

 is option reserves exclusive use of one available Call 
Processor for in-coming calls from a terminal having 
problems reaching an available Call Processor in very a 
busy location.

   
 

Navigate to the Call Monitor > Settings > Communica-
tions Timeout option. 

Select the time—in seconds—the Call Processor will 
wait before reporting a failed callback attempt from a 
remote terminal. A check mark shows the current se-
lected value of 10, 20, 40, or 80 seconds with a default 
value of 20 seconds. International locations with di-
al-up connections may require a longer timeout setting 
to prevent excessive failed call reports.

 

A er opening the Call Monitor, in the background the 
Data Manager processes data received from terminals.

  

Navigate to the Call Monitor > Settings > Data Manag-
er > Settings option. Click the Save Flat File option.

A check mark indicates an active option. Instead of 
deleting the ĕ le a er processing the data, the Data 
Manager will save each Call Processor Ę at ĕ le to a sep-
arate folder and give a name consisting with the year, 
month, and day on which the Manager receives the 
terminal data, as an example 20191101.

Use a text editor or word processor program to view 
the Hex data. 

      

Navigate to the Call Monitor > Diagnostics > Data 
Manager Settings option. Click the Enable Logging to 
File option.

A check mark indicates an active option.  e Data 
Manager will log its activity to the ĕ le DM.log in the 
Triton Connect application folder. Use a text editor 
such as Notepad or other word processing program to 
open and view this log.
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   

Navigate to the Call Monitor > Diagnostics > Data 
Manager Settings option. Click the Output to CSV 
(Comma Separated Value) Files option

A check mark indicates an active option.  e Data 
Manager saves the incoming journal data to the CSV 
folder, located in the same folder location as the Data 
folder. Each terminal will have its own ĕ le in this 
folder.

 e Data Manager saves the data in a (CSV) format. 
CSV allows for easy importing into spread sheets and 
database programs. 

    

Navigate to the Call Monitor > Diagnostics > Data 
Manager Settings option. Click the Output to Tape 
Format Files option

A check mark indicates an active option.  e Data 
Manager saves the incoming journal data to a Tape 
folder named Tape, located in the same folder loca-
tion as the Data folder. Each terminal will have its 
own ĕ le in this folder.

 e Data Manager saves the data in the same report 
style format used by the terminal to print journal 
reports. 

 

Navigate to the Call Monitor > Diagnostics > Data 
Manager Settings option. Click the Export Journals 
option.

A check mark indicates an active option.  e Data 
Manager will export journals into another database 
named ExpJrnls.mdb in an expanded format.

     


Navigate to the Call Monitor > Settings > Call Proces-
sors option.

 e Call Processor Settings dialog opens.  is screen 
allows the user to conĕ gure each Call Processors not in 
use. On the Call Monitor screen, the user can conĕ g-
ure or access a stopped Call Processors by selecting 
Settings for individual Call Processors. 

**Note**
A grayed out Settings, available Stop button, and the 
individual Call Processor activity box shows “Call Pro-
cessors not in Use”, means this processor is stopped.
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   -


 e Call Processor > Settings dialog allows the user to 
enable and conĕ gure any available Call Processors. 
For dial-up communications, the user must have one 
available analog modem and a phone line for each Call 
Processor the user wish to conĕ gure.

For TCP/IP communications, one (1) connection can 
use up to twenty (20) TCP/IP connections.

**Note**
Users can only select a Call Processor not running. 

Use either of the following methods to open the Call 
Processor Settings dialog

• On the Call Monitor main dialog, click the Set-
tings command button for the Call Processor the 
user will conĕ gure.

• Select the Call Processor option from the Settings 
menu on the Call Monitor menu bar. When the 
dialog appears, click the down arrow to select the 
speciĕ c Call Processor the user will conĕ gure. 

 e Call Processor Settings dialog appears

Use the dialog to enable and conĕ gure the settings for 
any available Call Processor.  e following sections 
will explain the various conĕ guration settings.

  (  )

 e drop-down list shows all available Call Processors 
currently not running. Select a Call Processor from the 
list. 

  

Click the check box to enable/start the Call Processor 
shown in the drop-down list. 

   

Each Call Processor entry on the Call Monitor main 
dialog has a Start button

With the Call Processor enabled and properly conĕ g-
ured, click the Start button for the Call Processor.
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   

In addition to single-line status available from the Call 
Monitor main dialog, you can click the View button to 
display activity data for any Call Processor according 
to the current viewer settings: separate window, single 
frame, or both.

If the Call Monitor > View menu shows the separate 
window option selected, a separate status window dis-
plays the Call Processor’s activities.

If the Call Monitor > View menu shows the single 
frame option selected, a window that replaces the nor-
mal Call Monitor dialog displays the Call Processor’s 
activities .

Either type of viewing window provides two command 
buttons.

• Close. Close the viewer window. If a Single Frame, 
will return to the default Call Monitor dialog win-
dow.

• Pause/Resume. Pause or Resume the operation of 
the Call Processor.

 

 is drop-down list allows the user to pick the type of 
connection this Call Processor will use for terminal 
communications.

1. Phone Line: With this option the user must select 
an available modem in the Modems Available 
drop-down list, before the Call Processor can start.

2. VSAT X.121: With this option select an available 
COMM port in the Comm Port Selected drop-
down list sill connect to the VSAT communication 
device.

3. TCP/IP: With this option the Call Processor will 
use the IP Address and Port settings in the Call List 
to contact a terminal with a TCP/IP connection.

4. Radio Pad: With this option the user selects the 
comm port the modem will connect to the radio 
Pad device.

  

All Triton ATMs except RL/FT5000 XP/PC-based 
units can use the Dial-up phone line connection type.

ATMs with either TCP/IP capable (ARGO/FT or RL/
FT5000/RT2000) or have the (optional) External Eth-
ernet module installed (91XX/97XX/96XX) can use 
the TCP/IP connection type.

ATMs that support Very Small Aperture Terminal 
(VSAT) satellite-based communications can use the 
VSAT connection type. VSAT supports a wide range of 
communication protocols.
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 

A series of option buttons lets the user choose the di-
rection type of calls this Call Processor will handle

1. Select the In option and the Call Processor will 
handle in-bound calls ONLY.

2. Select the Out option and the Call Processor will 
handle out-bound calls ONLY.

3. Select the Both (In and Out) option and the Call 
Processor will handle both in-bound and out-
bound calls (the default option for normal opera-
tions.

4. Select the Alarms Only option and the Call Proces-
sor will handle on in-bound calls that carry termi-
nal alarm status ONLY.

 

With the Connection Type set to Phone Line, the Dial 
Modiĕ er becomes available. Enter any special dialing 
codes required when dialing out from your system, 
such as a dial-out preĕ x of ‘9.’

 

Modem Selected shows the currently selected modem 
this Call Processor will use when placing Phone Line 
calls.

 

When the Connection Type selects Phone Line fea-
ture, the Modem Available provides a list of available 
modems.

**Note**
Do not conĕ gure more than one (1) Call Processor for 
each available modem.
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 

Modem Settings allows access to modem properties.

Properties: Allows user to select Country/Region:, Area 
code:, Phone number:, and Connect using: preferences. 
Click the Conĕ gure button to set the modem hard-
ware settings. Click OK to save the settings.

**Note** 
 e default settings are normally correct.

  

 

When the user selects the VSAT/Radio Pad, the Con-
nection Type displays the Comm Port Selected text, 
which provides the current PC COM port connected 
to the VSAT/Radio Pad communications hardware.

Prev: Click the (<<Prev) command button or press 
Alt+P on the keyboard to access the settings for the 
previous available Call Processor.

Next: Click the (Next>>) command button or press 
Alt+N on the keyboard to access the settings for the 
next available Call Processor.

Save: Click the (Save) command button or press Alt+S 
on the keyboard to save the settings changes for the 
current selected Call Processor and remain in the Set-
tings dialog.

OK: Click the (OK) command button or press Alt+O 
on the keyboard to save the settings changes for the 
current selected Call Processor and exit the settings 
dialog.

Cancel: Click the (Cancel) command button or press 
Alt+C on the keyboard to exit without making any 
changes to the Call Processor settings.
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    

 e Challenge/Response communications between the 
ATM and Triton Connect may change due to interfer-
ence and corrupt the TID data. Instead of deleting the 
call, Triton Connect assumes a communication prob-
lem and keeps the call list entry.

 / -


A default timeout of 20 seconds occurs between pack-
ets. Sometimes Triton Connect will send the ĕ rst data 
packet before the ATM is ready to receive it. Triton 
Connect will set the initial timeout to 5 seconds for the 
ĕ rst packet attempt, then 10 seconds for the second 
attempt, then 15 for the third, and so on.

   

When the Call Monitor and Call Processors start, 
the Processors begin an 80 second “Waiting for call” 
state.  is prevents collisions with inbound calls and 
outbound calls when the call processors start.  e 
option—used for testing—reduces the delay time to 10 
seconds.

    (-)

 is option forces Triton Connect to send the ISO 
numbers in the old format (100, 10-digit ISO num-
bers), even though the terminal indicates it supports 
the X-scale format.
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  

 is option allows the user to schedule a Cycling (stop-
ping and restarting) of all call processors at a speciĕ c 
interval.  is option assist users with larger system 
having communication issues.

   

Navigate to the Call Monitor > RSF option to allow a 
3rd party interface to receive the ATM’s status infor-
mation via TCP/IP.  e screen opens

Enable Remote Status feed: Enable/Disable Remote 
Status Feed option.

IP Address: IP Address of Remote Status Monitor when 
connected.

Port:  e IP Port Triton Connect will listen for con-
nection with Remote Status Monitor.

10 characters of Terminal ID: Protocol limits the use of 
only 10 characters of the Terminal ID. Select either the 
Le most or the Rightmost 10 characters.

E  C
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     

 is version of Triton Connect adds the ability for a Windows service to launch the Call Monitor, thus removing 
the need for a user to log into the PC for the Call Monitor to function. 
 
Windows provides many ways to conĕ gure a service. A complete overview of conĕ guring the Windows services 
exceeds the scope of this document. However, consider the important items below: 
 
 
1. Before using the Call Monitor as a service, a user must conĕ gure the Call Monitor by opening the application 

and conĕ guring the various types of communications, port numbers, and other settings required. 
2. To change the Call Monitor’s conĕ guration, a user must log into the PC, stop the Tccm Controller service, 

launch the Call Monitor, then change the desired options. 
3.  e conĕ gured service running the account must access the SSL/TLS certiĕ cate location for a proper 

functioning SSL/TLS feature.  is may require exporting the certiĕ cate w/private key and then importing it 
into a proper location for the service account, such as the Machine personal certiĕ cate store. 

4. To view and conĕ gure the service, open the Start menu, right-click Computer, click Manage, expand 
Services and Applications on the le -most pane of the screen, click Services, and locate Tccm Controller.  

 

 

5. When in normal operation with the Call Monitor running as a service, the Windows Task Manager can ver-
ify the active operation of the Call Monitor (Tccm.exe) and verify the user name under which it runs, along 
with DataManager.exe and one Tccp.exe for each running Call Processor.

6.  e service may not allow access to mapped drive letters, so accessing network resources use the network 
paths. As a result, if the database is on a network share, conĕ gure the Call Monitor to use the network path 
and not a drive letter 
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To achieve this conĕ guration, with the service stopped and all other Triton Connect processes closed: 
• Launch the Call Monitor, navigate to File > Database Settings. 
• Click Browse. 
• In the address bar at the top of the path window, enter the desired network location and press Enter. 
• Select TC_Main.mdb and click the Open button. 
• Click the Apply button and then click the OK button. 
• Verify the ability to place a call to an ATM, to test. 
• Close the Call Monitor, start the service, and then place another test call to an ATM. 
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7. Because the service does not see the mapped drives, so ware updates residing on a network location must 
use the network path when scheduling the updates to an ATM. To schedule a so ware update call to an 
ATM, from the Load Terminal So ware screen, proceed as follows: 
• Select the desired Terminal ID.
• Click Select File. 
• Enter the desired network location in the address bar. 
• Click the ĕ le to send to the ATM and click Open. 
• Click Send File.
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  -  



 is chapter covers the functions to create, modify, delete, and view terminal records in the Triton Connect main 
database through the Terminal Manager application. In addition, the Terminal Manager sets up terminal data, 
database management, and automatic alarm message transmission.

Load each Terminal into the Triton Connect terminal database. Triton Connect uses the information it needs to 
identify and contact the terminal, and its associated data in the database.

   
 
 is function operates as a data interface for the Triton 
Connect database.  e screen consists of ĕ elds that 
make up a database record. 

Caution

Never attempt to access the Triton Connect database 
directly or alter the information other than through 
the Terminal Manager.  e user may cause the pro-
gram to become inoperable.

     

1. Navigate to the Terminal Manager > Setup > Add 
New Terminal option.

2.  e Add New Terminal window appears. 

- 

1. As a minimum to save a new terminal record, enter 
data into the Terminal ID ĕ eld. Under the ATM 
Connection Type, select a connection type. Enter 
a phone number or address in the Terminal Phone 
Number/IP Address ĕ eld.

2.  e Terminal ID converts to the uppercase when 
saved to the database

 

Your processor or service provider assigns a Terminal 
Number to the terminal during the physical installa-
tion. Enter the Terminal Number into the Terminal ID: 
block.



Triton Systems ©84

Caution

 e Terminal ID must match the value assigned to the 
Terminal Number parameter in the terminal.  e Ter-
minal ID can only be 17 alphanumeric characters. 

If a new terminal of a diff erent type replaces a termi-
nal at a location, and the new terminal uses the same 
Terminal ID, for instance, replacing a Model 9600 with 
a Model RL5000, archive the current information from 
the old terminal, before contacting the new terminal. 
Otherwise, the information for the new terminal may 
not display correctly.

 

 e Location Name identiĕ es the name of the estab-
lishment with the physical terminal.



Enter the address of the establishment identiĕ ed under 
Location Name.

 /

In the optional ĕ elds, enter the names of individuals 
or organizations who act as a point of contact at the 
address speciĕ ed above.

, ,  

Enter the requested information to complete the ad-
dress data.

   /  

A terminal connected to the standard telephone 
system, requires the complete telephone number that 
services the terminal at the operating location. 

A terminal connected to the TCP/IP or CDMA (wire-
less) network, requires an IP Address provided by the 
host processor organization or service provider. 

**Note**
 e address includes a two-part entry.  e ĕ rst part 
consists of four groups of numbers in typical IP Ad-
dress format. Each group contains a number, (0 to 
255). A period, dot character, separates each number 
group, example: 123.221.01.99.
 e second part of the IP Address, Port Number, con-
sists of 1 to 5 digits.

 

Your host processor organization or service provider 
speciĕ es the Port Number and any additional data 
routing information which allows Triton Connect to 
communicate with the selected terminal on the TCP/
IP or wireless network.

 -

 ese four optional ĕ elds provide additional termi-
nal identifying information to the database record. 
 e Filter capabilities of Triton Connect makes the 
User 1-4 ĕ elds a powerful tool to organize and group 
many terminals.  ree examples: special requirements, 
additional contact information, terminal’s technician’s 
name.

Use the Conĕ gure User Fields function, located later 
in this chapter, to change the default labels of the User 
ĕ elds.

 

Select either Manual or Automatic to clear the termi-
nal’s Electronic Journal .

Select Manual, if the terminal operator at the operating 
location will manually clear the terminal’s Electronic 
Journal. 

Select Automatic, if Triton Connect will initiate jour-
nal clearing a er the Get Journal Data function suc-
cessfully downloads the terminal’s journal.
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 e Electronic Journal cannot hold an unlimited num-
ber of entries.  e 8-bit machines (9100/96XX/97XX/
Mako/SS) can hold at most 2045 journal entries.  e 
32-bit machines (ARGO Series, FT/RL/RT/Traverse) 
can hold 32,768 entries. If the journal entry reaches the 
size limit, the terminal will enter an OUT OF SER-
VICE condition and will remain in this state until a 
user clears the journals.

Caution

With the Journal Clearing set to Manual any records 
received will not be marked as audited/cleared in the 
ATM. If the user does not clear the Electronic Journals 
before the next Get Journal Data command is issued, 
the received data will contain old journal entries.  ese 
old entries could duplicate the stored entries in the 
database received under the Manual download.

  

Select the correct connection type or the modem speed 
used by the terminal.

 

Click the down arrow on the Time Zone block and se-
lect the time zone for the terminal’s operating location.

   

Click the Use Daylight Savings Time check box, if used 
at the terminal’s operating location.


Click the Save button a er entering all required data. 

 e program will verify the terminal ID does not have 
a duplicate ID in the database. If it does, it prompts to 
change the Terminal ID to a unique identiĕ er. If no du-
plicate ID exists, the operation will continue.

  

 e user may enter the access code in the EPROM 
Access Code window at this time and click the Enter 
button. 

 e Screen displays the code character with asterisks 
for security reasons to verify a correct entry, a second 
prompt will appear for the user to enter the access code 
again.  e user may choose not to enter a code and 
leave the EPROM Access Code entry blank. Click the 
Skip Step button.

**Note**
For ARGO, Traverse, RL1600, RL/FT5000, RL/ RT2000 
model ATMs, assign the Triton Connect access code 
at the terminal and enter as the EPROM Access Code 
on Triton Connect for that unit.  e access codes must 
match on the ATM and Triton Connect. 
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  

Use this function to remove terminal records from the 
database.

Caution

A terminal deleted, also removes all information con-
cerning the terminal from the database, including any 
Journals related to the terminal. If deleted by mistake, 
add the terminal back in as a new terminal with no 
information and Journals.

    

1. Navigate to the Terminal Manager > Setup > Delete 
Terminal option. 

2.  e Delete Terminal Screen appears.

    

Click the down arrow in the Terminal ID block. Select 
the ID from the drop-down list.  e list will close and 
highlight the selected ID.

 e user may also click the Search button to ĕ nd the 
terminal ID.

A prompt appears with instructions in red to select a 
ĕ eld to search.

Click the mouse cursor on the ĕ eld to search, the fol-
lowing dialog box appears.

 e information entered depends on the kinds of data 
contained in the ĕ eld. For example, assume you have 
clicked on the Terminal ID ĕ eld. You want to locate the 
record that contains a terminal ID of Test 12. Enter the 
text “Test 12” in the search box. Click the OK button.

If there is a valid data record for Test 12, it will appear 
in the applicable ĕ elds. If the search function cannot 
locate a record that contains the exact text entered in 
the selected ĕ eld, the Manager displays the following 
message.
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**Note**
 e character “space” is not a valid character, so the 
space before the “12” makes “Test 12” not a valid ID.

Another method for selecting terminals involves the 
use of ĕ lters, which displays only terminal records that 
ĕ t some speciĕ c criteria. See chapter 8 for the use of 
ĕ lters.

   

Type the ĕ rst letter of a Terminal ID and a list of IDs 
starting with the chosen letter appears. Typing addi-
tional letters further reĕ nes this process and eliminates 
all, but the one desired Terminal ID.

  

Click the Delete button to remove the current terminal 
information.

A conĕ rmation message appears.

Click the Yes button to continue with the delete action. 
A conĕ rmation message of the Deletion appears.

  

1. Navigate to the Terminal Manager > Setup > Bulk 
Delete option. 

2.  e Bulk Delete Terminals dialog box appears.

3. Click the check box(s) to delete the terminal(s).
4. Click the Clean button.
5. Click the Yes button to delete all terminals with a 

checked box.
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      

On the bulk delete dialog, click the Select Input File 
button. Browse the PC ĕ le system to locate and open 
an input ĕ le.  e bulk delete application will evaluate 
the input ĕ le using the following criteria.

•  e ĕ le is a simple text ĕ le with a .TXT extension. 
•  e ĕ le contains a list of Terminal IDs.
• Each line contains no more than one Terminal ID.
• Each Terminal ID consist of up to a maximum of 

16 characters in length. 

**Note** 
If the bulk delete application has problems processing 
the text ĕ le due to corrupt or no data, the application 
will display the warning message.

 e bulk delete application will compare the input ĕ le 
to the current database. If the application does not ĕ nd 
a corresponding match in the database for each termi-
nal in the input list, it will display the invalid Terminal 
IDs in a dialog box.

 

Click the Clean button on the Bulk Delete Terminals 
main window and the application will use the list of 
valid Terminal IDs from the input ĕ le to locate and 
delete the associated tables, records, and folders from 
Triton Connect’s Main database.

**Note**
 e ### symbols following the names of the ĕ rst 3 ta-
bles denotes multiple tables with the same name. Each 
one of the tables is associated with a terminal ID.

DATABASE TABLE  DELETION TARGET
TC_MAIN  ADDATA### Entire Table
   J OURNAL### Entire Table
   PARAMETERS### Entire Table
  CONFIGURE Record matching speciĕ c ID
  STATUS  Record matching speciĕ c ID 
  FeatureSettings Records matching speciĕ c ID 
  ScheduleReboot Records matching speciĕ c ID 
  ExtErrorInfo Records matching speciĕ c ID
  EMVData  Records matching speciĕ c ID
 EMVParameterDataAppList  Records matching speciĕ c ID
 EMVParameterDataBoolean  Records matching speciĕ c ID 
  LCCassStructure  Records matching speciĕ c ID
  LCDayStructure  Records matching speciĕ c ID
 LCEEValues  Records matching speciĕ c ID 

 SurchargeScreen Records matching speciĕ c ID

 

A er the terminals deletion, a message box will con-
ĕ rm task completion. 
 

Triton recommends running the Repair/Compact/Re-
place Database function a er performing a bulk delete 
operation. Look under the Terminal Manager File 
menu for this function. 
If the bulk delete application runs into a problem pro-
cessing the Terminal IDs, the application will annotate 
these errors in a log ĕ le. 

 

 e Bulk Delete application will keep a log ĕ le named 
Delete.log of its actions in the current directory, typi-
cally the Triton Connect installation directory.
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   

Use the Modify Terminal function to change an exist-
ing terminal record.

    

1. Navigate to the Terminal Manager > Setup > Modi-
fy Terminal option. 

2.  e Modify Terminal window appears.

     

Use one of the following methods to select a record.
1. Select from the Terminal ID ĕ eld’s drop-down list.
2. Type a letter or two in the Terminal ID ĕ eld.
3. Use the Search button to ĕ nd the Terminal ID.
4. Use ĕ lters.

For detailed descriptions of the various methods for 
selecting a terminal, refer to the previous section, “De-
leting a Terminal”.

  

Once the screen ĕ lls with the selected terminal data, 
alter the data in a ĕ eld. Refer to the earlier section on 
Adding Terminal Records for detailed descriptions of 
the ĕ elds.  e following features are speciĕ c to this 
function: Reset, Update, Options, and Change EPROM 
Password.



Click the Reset button to clear any changes and restore 
the ĕ elds to their original contents from the last Save.



Click the Update button to save the current ĕ eld data 
to the database.

  

Click the Change command button to bring up the 
following dialog box.

Use this data entry box to initially enter or modify 
the copy of an existing EPROM Access Code in the 
database.  e code entered does not alter the Access 
Code at the terminal, thus the access code must match 
between the ATM and Triton Connect. 
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

Click the Options command button to access the Mod-
ify Status Message Settings for the currently selected 
terminal. See the Modify Status Message Settings topic 
later in the chapter.

   



Use this function to view the information for a selected 
terminal in the database.

    

Navigate to the Terminal Manager > View > Terminal 
Setup option.  e read-only Terminal Setup window 
appears.

  

Select a terminal to view using the procedures given 
in the section, “Deleting a Terminal,” earlier in this 
chapter.

To change the data in the ĕ elds, use the Modify Termi-
nal function, covered earlier in this chapter.

    



 is function enables Triton Connect to account for 
the time zone diff erences between the local PC and the 
remote terminal when scheduling calls.  is function 
includes all international time zones and a Daylight- 
Saving Time option.

  

 e PC Time Zone function aff ects the time zone of 
the Triton Connect PC itself. Triton Connect knows 
the time zone of the terminal’s location via the data-
base containing the terminal’s time zone and daylight 
savings time data. Refer to “Adding a New Terminal” 
earlier in this chapter.

     

1. Navigate to Terminal Manager > Setup > Options > 
PC Timezone option.  e PC Parameters window 
appears.

Click the drop-down list for the Local Time Zone and 
select the time zone of the PC’s location.
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    

If the PC’s location follows daylight savings time, check 
the box. 

  

 e database provides four, free-form entry ĕ elds, User 
1-4.  e user’s discretion will determine the informa-
tion contents of the User Fields.

During the creation or modiĕ cation of a terminal 
record, one or more of these ĕ elds can help to diff eren-
tiate the terminal from the others in the database. Also, 
grouping terminals with a common name and content 
in the User Field can extended this function’s useful-
ness. 

For example, change the name of the “User 1” to “Pro-
motion,” which creates a commonality to all or certain 
terminals. Add contents to the Promotion ĕ eld like 
“Summer Madness Sale”, for some terminals and for 
other terminal’s “Winter Sale” or some other message, 
in essence creating a group of terminals associated 
with the sale.

 is feature’s usefulness when combined with the 
Triton Connect ĕ lters can extend the previous exam-
ple by assuming that a created ĕ lter selects only those 
terminal records that include the “Promotion” ĕ eld 
and the contents “Summer Madness Sale” in the ĕ eld. 
Activating such a ĕ lter would display only those ter-
minal records that matched this criteria in the various 
terminal management functions.

 e default name of each User Field is User 1, User 
2, User 3, and User 4. Use the Conĕ gure User Fields 
function to change the default name.

    

Navigate to Terminal Manager > Setup > Options 
> Conĕ gure User Fields option.  e Conĕ gure User 
Fields window appears.

    

Perform the following steps to change the User Field’s 
default name.

1. Highlight the ĕ eld name. 
2. Type the new name for the ĕ eld.
3. Delete any characters from the old name that may 

be present in the ĕ eld.
4. Repeat steps 1 to 3 for the other user ĕ elds.
5. Click the Save command button.

A conĕ rmation prompt appears.

6. Click the Yes command button to save the change. 
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    

 is function restores the contents of all User Fields to 
their last saved values. If the user clicks the Save button 
by mistake, use the Change a User Field Name proce-
dure from above to correct the User Fields.

  

 is function establishes a default listing order for 
Terminal IDs in the following Terminal Manager func-
tions.

1. Add New Terminal
2. Modify Terminal
3. Terminal Setup
4. Terminal Status
5. Get Terminal Data
6. Set Terminal Parameters
7. View Terminal Parameters
8. View Journal Data

 e initial default state sorts by Terminal IDs.

/  ‘  ’ 


To access and change the default terminal sort order, 
perform the following steps.

1. Navigate to Terminal Manager > Setup > Options > 
Sort Terminal by option. 

2. Select either of the two options.
• Date  ey Were Added
• Terminal ID

3. A check mark appears next to the current default 
sort order choice. To change the sort order, click on 
the other option.
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   

 is feature reports terminal status messages to one/
two service providers via alphanumeric pager or email. 
For each service provider to receive status message no-
tiĕ cations, enter one/two pager numbers and (or) one/
two email addresses.

Triton Connect will send a message to the service 
provider immediately a er it receives the status mes-
sage from the terminal.  e message will include the 
terminal ID, terminal model, terminal location, time, 
the Status Code and Status Description. Triton Con-
nect will make ĕ ve attempts to send this message.  e 
Terminal Manager’s Alarm Monitor and View Termi-
nal Status screens will display the status messages.

     -
 

Perform the following to access the Modify Status
Message Settings.

Navigate to Terminal Manager > Setup > Options > 
Modify Status Message Settings option.  e following 
dialog appears.

  

You can also access the Modify Status Message Settings 
function from the Modify Terminal screen. Click the 
Options command button. Using this will save the 
selected options only for that terminal.

 e Modify Status Message Settings window covers 
these sections.

1. Terminal(s)
2. Mail Server Settings
3. Routing
4. Error Control
5. Status

()

 e Terminal(s) block displays the terminal ID aff ected 
by the speciĕ c settings, and accesses the Mail Server 
Settings. 

1. View Settings for Terminal contains a drop-down 
list showing the terminal IDs aff ected by the mes-
sage settings.  e list consists of all Terminal IDs 
currently loaded in the database unless an active 
ĕ lter speciĕ cation restricts the number of entries.

2. A check in the Route Error Messages to Email / 
Pager check box, enables the routing of notiĕ ca-
tion messages to the applicable pager numbers or 
email addresses. No check in the check box dis-
ables the notiĕ cation function.  e messages are 
still logged in the Status History feature, if enabled.

3.  e Mail Server Settings sets and views the Mail 
Server parameters.

  

Click the Mail Server Settings command button to 
bring up the following screen.
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 e Mail Server Settings screen allows the user to con-
ĕ gure the email settings required to enable the email-
based message notiĕ cation function. 

1. SMTP Mail Server: Enter the name of the Simple 
Mail Transfer Protocol (SMTP) Mail Server on 
your network. Typically, the email conĕ guration 
settings of the existing email client so ware in-
stalled on the PC lists the Mail Server information. 
Contact your network administrator for assistance 
in obtaining the server name. 

 e Internet email standard SMTP Mail Server 
manages incoming and outgoing email traffi  c. Gov-
ernment and education facilities widely uses SMTP 
for reliable and effi  cient email transfer.

2. From Email Address: In most cases, if an outgoing 
email message fails to deliver to the target email 
address, a failure message returns to the sending 
email address. Enter a valid email address to re-
ceive undelivered mail notiĕ cations. 

3. Mail Server Port: Enter the port number (default 
25) for the email communications. In case of a 
conĘ ict, obtain a valid port number from your 
network administrator.  ey will determine which 
SSL option to select (Automatic, Implicit, Explicit, 
or No SSL) and if the Accept Self-Signed Certiĕ cates 
requires a check mark in the boxes.

4. Email Username: Enter the email account’s user-
name.

5. Email Password: Enter the email account’s pass-
word.

6. Mail Server Connection Type: Select the type of 
connection between the Triton Connect PC and 
Mail Server. On LAN-based systems select the 
Local Area Network option. If the connection 
requires dial-up, select the Dial-up Connection 
option. 

7. Dial-up Connection: With the Dial-up Connection 
selected in the Mail Server Connection Type block, 
enter the complete telephone number required to 
call the Mail Server.

Click the Save button to accept the current Mail Server
Settings. 
Click the Reset button to restore all ĕ elds to the con-
tents from the last save. 
Click the Cancel button to return to the Modify Status 
Messages main window.



 is block allows for one or two Service Providers. 
Enter applicable pager ID and telephone numbers for 
pager calls, or email addresses for email-based notiĕ -
cation. 

1. Phone Number or Email Address #1:  is applies to 
Service Provider #1. If using pager calls, enter the 
pager phone number. If using email messaging, 
enter the applicable email address.

2. Unique Pager ID #1:  is applies to Service Pro-
vider #1. If using pager calls, enter the pager ID 
number. If using email messaging, leave this ĕ eld 
blank.

3. Phone Number or Email Address #2:  is applies to 
Service Provider #2. If using pager calls, enter the 
pager phone number. If using email messaging, 
enter the applicable email address.

4. Unique Pager ID #2:  is applies to Service Pro-
vider #2. If using pager calls, enter the pager ID 
number. If using email messaging, leave this ĕ eld 
blank.

**Note**
To setup a single service provider with email and a 
pager, add the pager information to one of the Service 
Provider #n and add the email information to the 
other Service Provide #n.
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 

Select the status messages reported to a service pro-
vider. Select any or all of the available Terminal Status 
Codes reported to Service Provider #1, Service Provid-
er #2, or both.

1. Apply To: Select the Service Provider who will 
receive a notiĕ cation of the status messages in the 
Active list.

2.  Active: A list of terminal status codes reported to 
the service provider selected in Apply To.

3. Inactive: A list of terminal status codes not report-
ed to a service provider.

 
To move a status code from the Inactive list to the 
Active list, click the code, then click the << Add but-
ton. To move all status codes in the Inactive list to the 
Active list, click the << Add All button.

To move a status code from the Active list to the 
Inactive list, click the code, then click the Remove >> 
button. To remove all status codes from the Active list, 
to the Inactive list, click the Clear All >> button.



Click the Save button to save the current settings. 
Click the Reset button to restore all ĕ elds to the set-
tings from the last save. 
Click the Clear button to exit the screen and return 
to the Terminal Manager. If the user clicks the Clear 
Button before clicking the Save button, they will lose 
all changes. 

  

 e function creates a terminal database backup ĕ le 
and establishes a database backup schedule.

Caution

 e backup process will not occur until all Triton Con-
nect applications close.

     


Perform the following steps to access the Schedule 
Database Backup function.

1. Navigate to Terminal Manager > Setup > Options > 
Schedule Database Backup option. 

 

2.  e following dialog appears.

3. Click the Select Backup Filename command but-
ton. A ĕ le navigation dialog box appears.

**Note**
 e screen automatically enters a default name (DB-
Backup) in the File name block.  e user may keep 
the name or enter a diff erent ĕ le name. Save the ĕ le to 
the default ĕ le location in the Triton Connect installa-
tion directory, or navigate to a location of your choice. 
Click the Save button to save the ĕ le.
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4. Check the Backup Database at Scheduled Time 
check box to enable backups. Uncheck the box to 
disable backups.

5. Determine the number of days between backups 
and enter this number in the Number of Days Be-
tween Backups ĕ eld.

6. A er conĕ guring the database backup settings, 
click the Done command button to save the infor-
mation and schedule the next backup (Date of Next 
Backup). Otherwise, click the Cancel command 
button to cancel any changes and return to the 
Terminal Manager screen.

Once the Date of Next Backup arrives and the user 
exits the Terminal Manager, a prompt will open for the 
user to click on either the Yes or No buttons to backup 
the database. 

If the user selects “Yes”, Triton Connect will backup 
the database and schedules the next backup date. If 
the user selects “No”, the Terminal Manager will exit, 
but will continue to prompt the user upon subsequent 
exits with the same message until the prompt receives 
a “Yes” or the user unchecks the Backup Database at 
Schedule Time box.

 e Date of Last Backup shows the date the backup oc-
curred. If this date shows a er the Date of Next Back-
up, the user selected “No” to the backup prompt.  e 
Number of Days Between Backups determines the next 
calculated backup date.

// 

 is function repairs or compacts the terminal data-
base, or replaces the terminal database with a previous-
ly created backup ĕ le.

  // 
 

Follow these steps to access the Repair/Compact/Re-
place Database functions.

1. Navigate to the Terminal Manager > File > Repair/
Compact/Replace Database option.

2.  e Repair/Compact or Replace Database screen 
appears.

Select either the Repair/ Compact Database button 
or Replace Original Database with Backup button to 
start the process.

/ 

 is function corrects errors that may occur in the 
Triton Connect main database. A er completion of the 
repair operation, the database compacts, if possible. 
 is can o en speed up access to the database.
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Caution

All other Triton Connect applications must close, be-
fore the repair/compact will start.

Click the Repair/Compact Database command but-
ton.  e database repair/compacting operation will 
start. No further input required.  e Terminal Man-
ager main screen will return at the conclusion of the 
operation.

   

If the Repair/Compact Database function does not ĕ x 
the problem, the user can replace the existing database 
with a backup.

**Note**
Users will lose any database information received since 
the last backup.

Follow these steps to replace the existing main data-
base with a backup copy.

1. Click the Replace Original Database with Backup 
command button.

2. A warning message will appear. Proceed only if the 
existing database requires reverting to an earlier 
version of the database. Click the OK button.

3. A ĕ le navigation dialog box appears. Locate and 
highlight the desired backup ĕ le. Click the Open 
button. 

4.  e database replace process will begin. Mes-
sage boxes will report the progress and successful 
conclusion of the process. Click the OK button to 
return to the Terminal Manager main screen.

    /

Triton Connect can send ĕ les to the ATM using serial 
ĕ le transfer mode over TCP/IP, excluding terminals 
using a serial communications device, such as Radio 
PAD.

   

 e user can enable the Serial File Transfer for a termi-
nal when added to Triton Connect. 

1. Navigate to the Terminal Manager > Setup > Add 
New Terminal option.

2. With the ATM Connection Type set to TCP/IP, 
click the check box for Use Serial File Transfer 
Protocol.

3. Continue conĕ guring the ATM in Triton Connect 
as normal.

  

If the ATM has a connection to the Triton Connect 
database, use the Modify Terminal screen to setup the 
Serial File Transfer Protocol. To modify a terminal to 
use Serial File Transfer, perform the following steps.

1. Navigate to the Terminal Manager > Setup > Modi-
fy Terminal.

2. Select the desired ATM from the list.
3. Click the check box for Use Serial File Transfer 

Protocol option.
4. Click the Update button.

E  C
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  -   



A er installing Triton Connect, conĕ gure the Call Monitor application; add; terminals to the database; and 
schedule calls to those terminals. Triton recommends collecting data from each terminals to obtain a reference 
or baseline prior to any future changes.

 e Get Terminal Data function provides several options to retrieve speciĕ c kinds of data from the selected ter-
minals.  e options fall into these categories

• Get Terminal Parameters
• Get Journal Data
• Synchronize Date and Time
• Get Error Status
• Get Selectable Coupon Data
• Get Selected Parameters
• Get File from Terminal

     


1. Navigate to the Terminal Manager > Terminal Data 
> Get Terminal Data option. 

2.  e Get Terminal Data screen appears.

  

 e Get Terminal Data ĕ elds help to identify a 
particular terminal.  ey provide the criteria for the 
search and ĕ lter capabilities of Triton Connect to 
locate, identify, and group terminals.

 e Terminal ID: provides the user a list of available 
terminals to select. 

 e Search feature provides an effi  cient means of 
 selecting a terminal, instead of scrolling through a long 
list. Utilize the Filters function to arrange terminals 
into smaller groups, according to speciĕ c criteria.



Triton Systems ©99

  

Click the Broadcast button and select multiple termi-
nals that meet the data retrieval request.

 e Build Broadcast List appears.

Highlight the terminals from the Available list.

To highlight a group of terminals, click on the ĕ rst 
terminal, then press the (SHIFT) key and click on the 
last terminal in the group.  is will highlight the ĕ rst, 
the last, and all terminals in between.

To highlight multiple terminals that do not fall neatly 
into a group, press and hold down the (CTRL) key 
while clicking on terminals in the list.

Click the <-Add button to add the highlighted termi-
nals to the Broadcast list.

If the user needs to broadcast to all terminals in the 
Available List, click the <-Select All button and all ter-
minals will move to the Broadcast list in a single step.

Click the Clear All -> button to move all terminals 
from the Broadcast list back to the Available List.

If the user needs to remove a selected terminal from 
the Broadcast List, Click the ĕ le(s), then click the 
Remove -> button to return the selected terminal to 
the Available List.
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When the user selects a terminal, in either the Broad-
cast or Available Lists, the terminal’s address ĕ lls the 
data blocks on the lower part of the screen.

Click the Done button to return to the Get Terminal 
Data main screen.

   

Click all required check boxes under the Select Options 
area to retrieve the data from the terminal. Uncheck 
the boxes of data not needed.

**Note**
Unselect all options to display functions—grayed out— 
not supported by the speciĕ c terminal. 

  

Triton Connect will obtain all terminal parameter data 
for the selected terminal(s).

  

 is function will obtain all journal data for the 
selected terminal(s). Click this option and the 
following screen will open.

Select Retrieve all the Journal entries for all Journal en-
tries, or select Retrieve the last number Journal entries 
and enter a number of desired entries. Click the OK 
button. On the Get Terminal Data screen, click the Get 
Data button and the following window appears.

Enter the Date/Time interval to obtain the journal 
data. See the Example on the above window. By not 
adding the last two characters and the two commas, 
the data retrieval will run only once.

 

 e Journal Clearing set to “Auto” causes the termi-
nal to clear and audit its Electronic Journal a er each 
scheduled Get Journal Data command activity. If the 
uncleared journal size reaches the terminal’s limit, the 
terminal will enter and remain in an OUT OF SER-
VICE condition until the user clears the journal.

Caution

With “Manual” selected and the terminal’s Electronic 
Journal not cleared before the next Get Journal Data 
command, the journal will contain previously saved 
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entries, which when downloaded and stored in the 
journal database will cause duplicate entries. 

   

 is function sets the selected terminal’s date and 
time to match the Triton Connect PC date and time. 
 is will account for time zone and daylight savings 
diff erences, if any.

  

Triton Connect will obtain all terminal error status 
information for the selected terminal(s). When the 
user clicks Get Terminal Parameters, the Select Options 
function automatically checks the Get Error Status 
option. If the user does not want to obtain error status, 
Click the Get Error Status to uncheck the box.

**Note**
To get only the error status, uncheck the Get Terminal 
Parameters and click the Get Error Status.

   

 is function retrieves the number of coupons dis-
pensed totals. Check the Get Selectable Coupon Data 
box and a message box appears.

Click the Yes button to clear stored coupon totals a er 
retrieving the coupon data. Click the No button to 
retain the previous totals a er retrieving the coupon 
data.

   
 e terminal can track up to 99,999 coupon dispenses. 
 e Get Selectable Coupon Data retrieves the totals and 
provides it for analysis in the Coupon Report function 
of the Reports Manager.

  

 is option allows the user to retrieve selected param-
eters instead of the entire parameter list. Click the Get 
Data button.

**Note**
 e user must uncheck the Get Terminal Parameters 
option to select Get Selected Parameters.

Highlight the required parameter. Press and hold the 
Control key (CTRL) to select more than one option.

Click the Add button to move the selected parameters 
to the Parameters to Receive column and click the OK 
button.
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   

Click the Get File from Terminal option and the follow-
ing window appears. 

 is option will retrieve the terminal’s recycling dis-
penser G60 Log File, if the terminal has this type of 
cash deposit and cash dispensing dispenser.

 

Select the terminal(s) and specify the data options 
required. Click the Get Data button and a scheduling 
window appears.

 e scheduling window provides a means to choose 
a date, time, and contact interval when calling the 
terminal(s).

 e scheduler appears with the current date and time 
already loaded. It provides a quick way to schedule a 
one-time-only call to the selected terminal(s). Click 
the OK button and the scheduled call activates imme-
diately.

 e scheduler window off ers all the information need-
ed for the user to create a customized contact time, 
including a breakdown of the scheduling format and 
an example entry.

As an additional aid in understanding and composing 

call times, the next page includes a table, which 
provides an additional example, as well as a breakdown 
of each part of the contact time.  e table also provides 
space for the user to write in the values for a contact 
time, if desired.

A er composing a suitable contact time, click the OK 
button to accept it. Status Monitoring in the next chap-
ter covers the various ways to view the call status.

 

 ese calls repeat on a continuing basis. 

 e values assigned to Interval Count and Interval 
specify when to contact the terminal on a repeating 
basis. An Interval Count and Interval of (2,d) for 
example, tells Triton Connect to make calls every two 
days, until you change the contact schedule.

As additional examples, (4,h) speciĕ es a call, every 
four hours; (3,d) speciĕ es a call, every three days; (2,w) 
speciĕ es a call, every two weeks; and (6,m) speciĕ es a 
call, every six months.

**Note**
When entering Persistent Calls values, ensure the time 
contains no spaces between the AM/PM, commas, and 
values.
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   

Call the terminal on December 5, 1996, at eight thirty in the morning, then two days 
later, at the same time. Continue making calls every two days.

 12/5/96 8:30 AM,2,d
___ __ __ ___ ___ __ __ ___

Month Day Year Hour:Minute AM/PM Interval Count Interval

12 5 96  8:30 AM 2 d

:

:

:

:

VALUES
Month Use 1-12, corresponding to the months January through December.

Day Use 1-31, as appropriate for the month in question.

Year Valid for years 1980 through 2080.

AM/PM Hours in standard 12-hour time format. Minutes can be 0-59.

Interval
Count

Select an Interval Count appropriate to the Interval type chosen.  e Interval Count 
represents the number of Intervals between calls, beginning at the start day and time 
you speciĕ ed. For one-time-only calls, do not include an Interval Count.

Interval Valid intervals are: H=Hours, D=Days, W=Week, M=Month. For one-time-
only calls, do not include an Interval.

E  C
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  - 



 ere are several ways to monitor Triton Connect activities as it performs call operations.  ese methods exist 
throughout the suite of Triton Connect applications. For example,  e Call Monitor, provides two methods of 
monitoring Call Processor operation covered in Chapter 4, Call Monitor Setup.

In addition to those methods, others can be found in the Terminal Manager, Call Viewer, and Alarm Monitor 
applications.  ese methods enable the user to monitor call activities and see the results of status queries to the 
terminal, including errors detected during attempted calls and terminal error conditions. In this chapter, we will 
cover these methods.

  

 is function enables you to see the last error code 
received from a terminal, along with a description of 
that error code. In this section you will learn how to 
access and view the status information provided by this 
function.

    

Navigate to the Terminal Manager > View > Terminal 
Status option. 

 e Terminal Status window provides information in a 
tabular format. Note the column headings.

 

 is column will list the IDs of every terminal contact-
ed by Triton Connect and has returned status informa-
tion.

 

 is column will hold the last status code received 
from the terminal. Unless an error has occurred, this 
code will be zero (0).

 

 is column will hold a description of the last status 
code received from the terminal. Unless an error has 
occurred, the block displays the code “0 - No Errors”.
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  

 is column indicates a paging message sent to the 
e-mail address or the pager as conĕ gured in that status 
message setting and the success or failure of sending 
the message.

 /  

 

Auto Refresh - A check mark indicates the screen 
updates each time the Data Manager has new informa-
tion for this function.

Refresh - With Auto Refresh unchecked (Disabled), 
click the Refresh button to update for new informa-
tion.

   

When the user schedules a terminal for contact, the 
call moves to the Call List, which holds a record of the 
request, waiting until the scheduled call time occurs. 
At that time, Triton Connect attempts to place the call 
to the terminal, using an available Call Processor to 
handle the communication details involved.

 

A non-changeable ĕ  een (15) second delay takes place 
between consecutive outgoing calls.  is delay pro-
vides a “window of opportunity” to receive incoming 
calls from terminals.

**Note** 
If the ATM does not or will not call back, Triton Con-
nect will wait up to an hour before picking up the next 
call in the call list.

If while monitoring the call list, the user observes an 
unusually long delay in receiving a return call from a 

terminal.  e user may delete the call from the list, so 
the aff ected telephone line can process other calls.

In such cases, troubleshoot the aff ected terminal’s re-
turn call delay problem.

 e Call List provides information concerning each 
call.  e tabular layout makes it easy to check the call 
status of a terminal. In this section, you will learn how 
to access and interpret the information provided by 
the Call List.

    

Navigate to the Terminal Manager > View > Terminal 
Call List option.  e Call List window opens.

**Note**
Click on a ĕ eld heading to sort the column in ascend-
ing and descending order.

   

 e Call List uses a table approach to present informa-
tion. It provides a single-line entry for each terminal 
ID scheduled for contact. On each line, column head-
ings identify the types of information available in the 
entry. To see all the column headings, scroll the display 
horizontally, as in the following examples.
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 e following paragraphs discuss these headings.

Terminal ID.  e name Triton Connect uses to iden-
tify this terminal in the database.

Time to Call.  e time of the next scheduled call to 
this terminal.

Attempt.  e number of attempts Triton Connect has 
made to contact this terminal. Triton Connect will 
make up to ĕ ve attempts to reach the terminal before 
reporting a call error.

Time Contacted.  e time the terminal achieved a 
successful call.

Called.  e Ę ag indicates the result of a terminal con-
tact. (-1) deĕ nes a successful contact. (0) deĕ nes failed 
contact to the terminal.

Terminal Phone.  e telephone number used to contact 
the terminal. Upon the initial creation of the terminal 
record, the database stores the telephone number. 

Call Interval Count.  e Interval Count chosen when 
scheduling this terminal for contact.  e number of 
Intervals between calls, beginning at the start day and 
time speciĕ ed.

Call Interval.  e Interval chosen when scheduling this 
terminal for contact. Valid intervals: H=Hours, D=-
Days, W=Week, M=Month.

Record Busy. If changes to the terminal’s call status, oc-
curs as the database accesses the Call List entry, a (-1) 
will appear in the ĕ eld. If not, the value will be (0).

Auto/Manual.  is entry shows whether the terminal’s 
Journal Clearing option is set for Automatic (-1), or 
Manual (0).

CMD1 - CMD2.  e Command ĕ elds contain codes 
representing the commands in the terminal message. 
Each contact message contains up to eight commands.

 e character that appears in each ĕ eld represents a 
speciĕ c command to the terminal. (P = Get Parame-
ters), (C = Change Parameters), (E = Get Error Status), 
(J = Get Journal Data), and (T = Synchronize Date and 
Time).
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    

User deletes a call from the Call List by clearing it. 
Follow these steps

1. Click the arrow symbol next to the Terminal ID 
ĕ eld to highlight the entry for deletion.

2. Place the mouse cursor in the Terminal ID ĕ eld 
and click once.

3. Press the DELETE key on the keyboard to remove 
the entry from the Call List.

   

If the user needs to remove all entries from the Call 
List, follow these steps.

1. Click the Clear button.

A conĕ rmation message appears.

2. Click the Yes button to clear all items from the 
Call List.

    

 e Terminal Error List stores entries for failed termi-
nal contacts, which falls into the following two catego-
ries.

• Five attempts were made to contact a terminal, but 
the terminal did not answer.

• A terminal called successfully, but did not return 
the call.

     

Navigate to the Terminal Manager > View Terminal 
Call Error List option.  e Call Error List window 
appears.

    

 e Error List information displays in a table format. 
Each line entry represents a single terminal contact. 
 e columns hold the various data ĕ elds that contain 
the data associated with that terminal contact attempt. 
To see all the column heading, scroll the display hori-
zontally.

Terminal ID.  e name Triton Connect uses to identify 
this terminal in the database.
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Time to Call.  e time of the next scheduled call to 
this terminal.

Attempt.  e number of attempts Triton Connect has 
made to contact this terminal. Triton Connect will 
make up to ĕ ve attempts to reach the terminal before 
reporting a call error.

Time Contacted.  e time of a terminal’s successful 
call.

Called.  e Ę ag indicates the result of a terminal con-
tact. (-1) deĕ nes a successful contact. (0) deĕ nes failed 
contact to the terminal.

Terminal Phone.  e telephone number used to contact 
the terminal. Upon the initial creation of the terminal 
record, the database stores the telephone number. 

Call Interval Count.  e Interval Count chosen when 
scheduling this terminal for contact.  e number of 
Intervals between calls, beginning at the start day and 
time speciĕ ed. Example below: make attempt to con-
tact the terminal a er every tenth count.

Call Interval.  e Interval chosen when scheduling 
this terminal for contact. Valid intervals: H=Hours, 
D=Days, W=Week, M=Month. Example below, (10, d): 
make attempt to contact the terminal every tenth day.

Auto/Manual.  is entry shows whether the terminal’s 
Journal Clearing option is set for Automatic (-1), or 
Manual (0).

CMD1 - CMD2.  e Command ĕ elds contain codes 
representing the commands in the terminal message. 
Each contact message contains up to eight commands.

 e character that appears in each ĕ eld represents a 
speciĕ c command to the terminal. (P = Get Parame-
ters), (C = Change Parameters), (E = Get Error Status), 
(J = Get Journal Data), and (T = Synchronize Date and 
Time).

 

If the user wishes to place a failed call back in the Call
List, use the rescheduling function.

1. Click the Reschedule button.

 e following conĕ rmation message appears.

2. Click the Yes button. A call scheduling dialog box 
opens.
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Schedule a time for the next attempt and click the OK 
button.  e Terminal Manager removes the entry from 
the Call Error List and places it back in the Call List.

    

 e Terminal Error List may contain only entries not in 
need of rescheduling, or serve no other useful purpose. 
Follow these steps to remove these entries from the list.

1. Click the Clear command button.

2. A series of conĕ rmation messages will appear.

Click the Yes button to these messages to clear ALL 
entries from the Terminal Error List.

   

 e Call Error List displays a “snap shot” of the termi-
nal’s current contact errors.  is picture of events may 
not reĘ ect the most recent entries, especially if some 
time has passed with the list still open.

To refresh the display, click the Refresh button.

 e display will update with the most current Error 
List status.

   

Call Processors manages the details of placing calls to 
terminals and answering calls from terminals.  ey 
communicate directly with the communications hard-
ware to process the transfer of data between the Tri-
ton Connect PC or network and one or more remote 
terminals.

Because the Call Processors will usually be running 
on the Modem Server PC in a network environment, 
other PCs on the network may not have convenient 
access to the Call Processors. Triton Connect provides a 
solution.  e Call Viewer application allows any legally 
licensed PC on the network to remotely view the activ-
ity of each Call Processor.

In this section of the chapter, you’ll learn how to access 
and use the Call Viewer.

   

1. Navigate to the Terminal Manager > View menu.
2. Select the Call Processors option.

- OR -

3. Click the Windows Start/Programs menu. 
4. Navigate to the Triton Connect applications group 

and select the Launch Call Viewer program.

 e Call Viewer dialog box appears.
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    

When the Call Viewer window opens, the utility will 
attempt to contact the Call Monitor, using a TCP/IP 
connection.

Caution

Call Viewer-to-Call Monitor communications requires 
the TCP/IP protocol installed on the computer. (See 
Chapter 2, Installation, for instructions on installing 
the TCP/IP protocol.)

 e viewer lists Call Processors running.

If no Call Processors listed, check the following.

• Are any Call Processors running? Check the Call 
Monitor and start Call Processor(s), if necessary.

• Is the Call Viewer enabled at the Call Monitor? 
Make sure the Call Monitor’s Diagnostic menu has 
checked Enable Call Viewer option.

•  Are the TCP/IP address and/or Port Number 
settings correct? Click the TCP/IP Settings option 
in the Call Monitor > Settings menu.  is will open 
the TCP/IP Settings dialog. Make a note of the 
TCP/IP Address and TCP/IP Port number for the 
Call Monitor-Call Viewer entry.

Click the TCP/IP Settings option in the Call Viewer > 
Settings menu.  is will open the Settings dialog.
Check the IP Address and Call Monitor Port Number 
settings.  e settings should match those noted for the
Call Monitor. If necessary, change the values to match 
the Call Monitor settings.

  

To see the activity of an individual Call Processor, se-
lect it in the list and click the Show button.

A viewer window will open and show the activity of 
that Call Processor, as in this example.

 e Show button changes to a Hide button if the high-
lighted Call Processor appears in the viewer window. 

Click the Hide button to make the currently selected 
viewer window invisible.  e Hide button changes to a 
Show button.

To quickly display the viewer windows for ALL run-
ning Call Processors, click the Show All button.
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Or use the Hide All button to temporarily make ALL 
displayed viewers invisible.

Use the Make All Same Size button to force all open 
viewer dialogs to match the size of the currently select-
ed call viewer dialog.

Pause and resume the activity of all displayed viewer 
windows by clicking the Screens Paused option in the 
Settings menu.

A check mark indicates that all viewer windows are 
paused. Check the title bar of a viewer window to see if 
the status shows “Screen Paused”.

Also pause the activity of a selected viewer by clicking 
the Pause button on that viewer’s dialog.

 

 e Alarm Monitor application provides a log of ter-
minal error conditions. With the application running, 
it automatically receives error status as calls from the 
terminals. In this section, the user will learn how to 
access and view the status information provided by the 
Alarm Monitor.

    

Start with Windows Start/Programs/Triton Connect 
menu. Select the Alarm Monitor application.

   

 e Alarm Monitor status window provides informa-
tion in a tabular format. A single-line entry for each 
terminal ID reports an error condition. On each line, 
column headings identify the types of information 
available in the entry. To see all the column headings, 
you will need to scroll the display horizontally.

Most of the information presented for each terminal 
ID arrives from the database, and provides additional 
identifying information, such as terminal address, and 
points of contact.  e database receives this informa-
tion with each new terminal added. See Chapter 4, 
Terminal Setup, for the procedure.

 e Error Condition column provides the termi-
nal’s most recent error indications. Look up the error 
code at www.tritonatm.com/service_and_support/
error_code_lookup for a complete listing of the error 
descriptions and recommended user’s action. Refer to 
your ATM manual for further information on error 
codes.
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“-” 

Normally, the Alarm Monitor will run in a minimized 
state in the Windows Task Bar. Every 30 seconds, the 
Alarm Monitor will check the terminal status table in 
the database for changes. When it detects a change, the 
Alarm Monitor will “pop” to the front of any applica-
tion windows.  e most recent error status will appear 
at the bottom of the Alarm Monitor status listing. To 
disable this feature, Click Settings and click the Disable 
Pop-up button.

    

 e Status Message Log holds a record of the attempts 
by Triton Connect to report terminal status conditions 
to personnel using email message or pager calls.

    

Navigate to the Terminal Manager > View > Status 
Message Log option. 
 e Status Message Log window replaces the Terminal 
Manager screen area, shown below.

E  C
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For an active ĕ lter, the icon appears as shown.

Place the mouse cursor over the icon and a “help bal-
loon” displays the name of the ĕ lter.

With no active ĕ lters, a cross overlays over the icon as 
shown here.

   



 e ĕ lters function permits the creation of special ĕ ltering statements that act as database ĕ lters, limiting the 
number of records visible at any one time to only those records which match a set of conditions the user speci-
ĕ es in the statement.  e ĕ lters usefulness shows for operators in a network environment who work with many 
terminal records, but handle only small groups of the entire terminal database, or search for certain records of 
immediate interest.

For example, the function displays only those terminal records for a city, or only those terminals belonging to 
an organization. In general, activating a ĕ lter allows only those terminal records that match the ĕ lter criteria to 
show in the various terminal management functions.  is includes all Terminal Data menu functions as well 
as the Delete and Modify Terminal, View and Set Terminal Parameters, View Terminal, Journal Data, Terminal 
Setup, and Report Manager functions. When working in the terminal management functions, a small icon sits in 
the lower right corner of the function window.  is icon shows the status of the ĕ lter function. 

  

Navigate to the Terminal Manager > Filters > Create/
Edit/Delete option.

 e Create/Edit/Delete function creates and manages 
ĕ lters.  e Set Active Filter option, a cascading menu, 
lists the available ĕ lters by name, as shown in this 
example.

Click the ĕ lter’s name to enable a ĕ lter.  e selected 
ĕ lter becomes the active ĕ lter and appears in a list at 
the bottom of the Filters drop-down menu box, as the 
Current Filter.
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To turn off  all ĕ lters, navigate to the Terminal Manag-
er > Filters > Set Active Filters and click the No Filter 
option.

   

Navigate to the Terminal Manager > Filters > Create/
Edit/Delete Filters option and the function window 
appears.

   

As stated earlier, the Create/Edit/Delete Filters func-
tion creates and manages the ĕ lter statements.  ese 
statements act as database ĕ lters, making only those 
terminal data records that match a descriptive criterion 
available at any given time. 

 e user creates and manages these statements de-
scribed under these headings.

• Creating A Filter
• Viewing A Filter
• Saving A Filter
• Editing A Filter
• Deleting A Filter

  

To create a ĕ lter, the ĕ lter statement joins a combi-
nation of drop-down list selections and user-deĕ ned 
entries. 

  

Click the New command button to clear the File Name: 
text entry box, which prepares the controls to accept 
the entries that will make up a new ĕ lter statement.

Enter a new ĕ lter name in the Filter Name text entry 
box.
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    

 ree drop-down list and a text entry box provides the 
tools to build the ĕ lter statement.

 e ĕ rst lists contains the ĕ elds common to each 
terminal data record. Data created from the terminal 
record’s initial creation populates these ĕ elds, and rep-
resent searchable parameters. One or more ĕ elds from 
this listing makes up the ĕ lter statement, which results 
in a speciĕ c or limited number of records displayed. 
Perform the following steps to create a new ĕ lter state-
ment.

1. Select the initial ĕ eld of interest from the ĕ rst drop 
down list. If necessary, a second row will permit 
the selection of an additional ĕ eld from this list.

2. Choose a comparison parameter from the second 
list.  ese values will compare the ĕ eld in the ĕ rst 
box to the user-speciĕ c value selected in the third 
box. 

3. Enter a value for comparison in the third box.  e 
selected value should create a small number of 
records within the range of the selected ĕ eld in the 
ĕ rst block.

4. Finish the ĕ lter statement with the END command. 
If further reĕ nement of the ĕ lter statement is nec-
essary, use the And/Or commands. Selecting either 
And or Or, provides a second line with four ĕ elds. 
 e fourth ĕ eld only has the END command.

 

 e image displays an example of combined ĕ lter com-
mands.

Combining the available ĕ lter criteria commands with 
words or phrases that describe speciĕ c terminals or 
groups of terminals in your database, creates ĕ lter 
statements to meet a wide range of needs.

  

 e Generated SQL Statement window displays the 
actual commands joined together as the user builds 
the ĕ lter statement.  e ĕ nal statement appears below 
using the entries from the example image above.
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  

Click the Save command button to save the ĕ lter state-
ment with the name you speciĕ ed earlier. All ĕ elds will 
clear and allow for the creation of another ĕ lter.  e 
saved ĕ lter will appear in the drop-down portion of the 
box

On a standalone (non-network) system, click on the 
ĕ lter entry in the Set Active Filter menu to activate it. A 
network environment requires some additional consid-
erations.

To access ĕ lters created at other workstations on the 
network, update the Filters database by selecting 
any available ĕ lter, or by existing and re-entering the 
Terminal Manager application.  is operation will 
update or refresh the list in the Set Active Filters menu, 
and display any additional entries for ĕ lters created by 
other operators.

  

 e following steps summarize the procedure to modi-
fy an existing ĕ lter.

1. Select an Existing Filter.
2. Click the Load command button.

3. Change the Filter Name, if desired. 
4. Change the ĕ lter statement components as nec-

essary. If the statement has multiple lines, select 
and edit the additional lines as needed. If you wish 
to delete a line, select the END statement on the 
previous line. 

5. Click the Save command button.

  

When a ĕ lter is no longer needed, delete it by perform-
ing the following steps.

1. Select a Filter from the Filter Name list box.
2. Click the Load command button to load the ĕ lter 

statement.

3. Click the Delete command button and click the 
Yes button on the conĕ rmation message to remove 
the ĕ lter.

  

To create a ĕ lter utilizing parameters, perform the 
following steps.

1. Navigate to the Terminal Manager > Filters > Cre-
ate/Edit/Delete Filter option.
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7. Click the Save button, then click the Yes button.

E  C 

2. Enter the name for the new ĕ lter in the Filter 
Name: ĕ eld.

3. In the Build Parameter Filter area, select the param-
eter in the ĕ rst ĕ eld. Select Matches or Is Not in the 
second ĕ eld.

4. Enter a Value in the third ĕ eld.

5. In the last ĕ eld, select either End, And, or Or. 

6. For (And or Or), an additional parameter row ap-
pears to either Match or IsNot additional values. 
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  

Navigate to the Terminal Manager > Terminal Data > 
View Terminal Parameters option. By default, the Select 
Terminal section appears ĕ rst in the Terminal Parame-
ters screen.

Select one or more terminals to view or conĕ gure. 

   -  

1. Use the Select Terminal ID drop-down list and 
select a terminal’s ID. 

Alternatively, click the Next and Previous buttons to 
move forward or backward through the list of available 
terminals.

When the user selects a terminal, a portion of the ad-
dress data for that terminal ĕ lls in the ĕ elds at the le  
of the main window.

C  -  



 is chapter introduces the terminal parameters.  ese values aff ect the terminal operation or reports the status 
of various terminal operations. 

Many terminal parameters allow a user logged in with the Supervisor’s password to alter the value or state of the 
applicable parameter, which changes the operation of a selected terminal. Other parameters do not allow the 
user to change the values, but allow them to view the read-only parameters. 

Caution  
Triton Connect provides a powerful feature to change the terminal’s operations. Exercise caution when making 
any changes and only when the user understands the exact eff ect it will have on the terminal!
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2. Click the View Parameters button.

 e Terminal Parameters screen changes to a tab for-
mat screen.

 e screen provides a list t erminal parameter catego-
ries.

 • Ad Graphics/File Manager
 • Advanced Settings • Passwords 
 • Amounts  • Receipt Graphics
 • Cassette Stat  • Status
 • Comm   • Surcharge
 • Control   • Terminal Totals
 • Format   • Text Ad Screens
 • ISO No./Owner Info • LED Sign Message
 • Triton Connect Settings
 • Messages/Coupons
 • Version Numbers

3. Click a tab to view the parameter.  e tab pres-
ents the state of the parameter as of the last time 
the terminal sent the parameters. See Chapter 5, 
Getting Terminal Data, for more information.  e 
upper-right corner of the Terminal Parameters 
screen displays the last contact date and time for 
the selected terminal.

4. If the user wishes to select a diff erent terminal, 
click the Previous or Next button at the top of the 
screen.  e Select Terminal block replaces the tab 
screen.  e user can continue to click the Previous 
or Next button, or select a terminal from the Select 
Terminal ID list box.

5. Click the View Parameters button.

** Note**

Triton Connect must contact the terminal prior to the 
terminal downloading its parameters for viewing. If 
the user selects a terminal for which no data has been 
previously downloaded, the Terminal Parameters 
screen will display a warning message with the View 
Parameters button grayed out.

     -
 

**Note**
Selecting the View Terminal Parameter option grays 
out the Broadcast button.  e user must select Termi-
nal Manager > Terminal Data > Set Terminal Parame-
ter option to enable the Broadcast button.

1. Click the Broadcast button.

 e Build Broadcast List appears.

2. Highlight the terminal(s) for selection in the Avail-
able list.

  

• To highlight a group of terminals, click once on 
the ĕ rst terminal, then hold down the SHIFT key 
while clicking on the last terminal in the group. 
 is will highlight the ĕ rst terminal, the last termi-
nal and any terminals in between. 
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• To highlight multiple terminals that do not fall 
neatly into a group, hold down the CTRL key while 
clicking on any terminal anywhere in the list.

3. Click the <-Add button to add the highlighted 
terminal(s) to the Broadcast list.

4. Repeat the last two steps for any other terminal(s) 
desired in the Broadcast List. 

5.  e user may wish to broadcast to all terminals in 
the Available List, click the <-Select All button to 
highlight all the terminals and click the <-Add but-
ton to move them to the Broadcast list in a single 
step.

Caution

Moving multiple terminals from the Available List to 
the Broadcast List may trigger a Broadcast Warning 
message. Read and understand the warning message 
before selecting one of the three response buttons.

6.  e User may remove one or more terminals from 
the Broadcast List. Use the procedures described in 
Step 2 to highlight the terminal(s) and then click 
the Remove -> button to return the terminal(s) to 
the Available List.

7.  e user may move all the terminals in the Broad-
cast list back to the Available List, by clicking the 
Clear All -> button. 

8. Select a terminal in the Broadcast List to activate 
the V iew Parameters button.

9. Click the View Parameters button to view the 
terminal parameter tabs. 

10.  e Broadcast List appears in the upper-le  corner 
of the Terminal Parameters main dialog. Use the 
up and down arrows to scroll through the list.
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  

Select the parameter tab and make the necessary pa-
rameter changes. 

1. Changes to a parameter entry will appear RED to 
indicate the value has been changed. 

• If a data entry ĕ eld or control is not applicable to 
the currently selected terminal, the ĕ eld or control 
will be grayed out or disabled. 

**Note**
If all choices are grayed out, verify the user chose “Set” 
parameters rather than “View”.

2. If a single terminal is selected, each parameter 
change will apply to that terminal only.

3. If a broadcast list was used, each parameter change 
will be applied to all terminals in the list. 

**Note**
When broadcasting parameters, all ATMs should be of 
similar type. For instance, graphics for a Model 97XX 
ATM cannot be sent to a Model RL5000 ATM unit.

A er changing all parameter, click the Send Parame-
ters button to schedule the terminal(s) for contact.

 is will bring up a call scheduling window.

 e scheduling window provides a means to choose a 
date, time, and contact interval when calling the termi-
nal(s). Notice the scheduler appears with the current 
time, by default, as the contact time already loaded and 
ready to use. It provides a quick way to schedule an im-
mediate, one-time only call to the selected terminal(s). 
If the user needs to schedule the call immediately, click 
the OK button.

If the default contact time is not acceptable, change the 
date, time, interval count and interval.  e scheduler 
window off ers all the information needed to create a 
customized contact time, including a breakdown of the 
scheduling format and an example entry.

 e changes will be sent to the selected terminal (or 
multiple terminals, if the Broadcast feature was cho-
sen) at the scheduled time. 

Once a suitable contact time has been composed and 
entered in the scheduling window, click the OK button. 
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   

Messages use the terminal display screen to convey 
information to the customer. Messages greets the 
customer, makes promotional off ers, and encourages 
repeat use.

**Note**
 e Store and Marketing Messages also print on the 
customer’s receipt.

Promotional incentive, awarding a product, service, or 
discount as an incentive for making withdrawals from 
the terminal, typically use Coupons. Prizes refer to 
such awards or incentives.

Occurrence of either a withdrawal above a certain 
level, Level Coupon, or as a random percentage of all 
withdrawals, Random Percentage, triggers Coupons. 

When triggered as either a level-based or random 
event, the terminal prints the coupon a er the transac-
tion.

A notiĕ cation screen appears on the terminal display 
to inform the customer that a prize award coupon is 
printing.

 is tab lets the user change the message text, conĕ g-
ure coupon parameters, and select the language used 
by the terminal to present customer screens.

 

Follow the steps below to change a message.

1. Click the option button for the message needing 
change, as in this example.

2. Edit the existing message or type a new message in 
the text window.

**Note**
For the Z180 ATMs, (9100/9600/9700) will have the 
Coupon conĕ gurations on this screen. Refer to Triton 
Connect Revision 6.0, chapter 8, page 8-7 for details.

/
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

 

 is tab provides a read-only display of the status of various aspects of the terminals’ operating conĕ guration, 
such as the current operating mode, current terminal status, and security settings. It also allows the user to clear 
error conditions and reset the terminal.

 - 

• Check Digits.  is screen shows the PIN Master, PIN Working, and MAC Master/Working (if used) check 
digits. A er loading the Keys, the terminal generates the Check Digits, which must match a reference set of 
Check Digits.  e terminal displays the Le /Right check digits information if the terminals so ware requires 
inputting the key information in that format.

**Note**
 e parameters identiĕ ed as ‘Master Key’ and ‘Comms Key’ refer to ‘PIN Master Key’ and ‘PIN Working Key’.

• Sequence No.  is number increments each time the terminal performs a transaction.  e Sequence Num-
ber prints on the customer’s transaction receipt and records in the terminal’s electronic journal entry for the 
transaction. 

• Last Authorization No.  e host processor generates the authorization number and authorizes the terminal 
to perform a transaction.  e block reports the most recent authorization number.

• DES Chip Loaded. DES (Data Encryption Standard) encrypts the customer’s data.  e word YES indicates 
the terminal has a DES system installed.

• Security Module Present.  e Security Module protects communications between the terminal’s control 
electronics and the dispenser mechanism.  e word YES indicates a Security Module installed in the termi-
nal.

• Demo Mode. In Demonstration Mode the terminal will operate in a simulated customer transaction mode. 
 e word NO indicates the terminal processes customer transactions normally.

• Last Dispensed Status. A er each dispense operation, usually the result of a customer withdrawal transac-
tion, the dispenser mechanism in the terminal reports its status. Use the status value to evaluate dispenser 
problems.
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     

 e Error Code line displays the most recent terminal status condition.

If the Error Code block displays an error status, follow the steps below to clear the error status.

1. Click the Clear Error and Reset ATM button.  e Error Code block displays the <Cleared> label marked in 
RED.  e Red font indicates a changed parameter not sent to the terminal.

2. A er making any other required parameter changes, click the Send Parameters button to schedule the ter-
minal for contact.

**Note**
For error condition 924 - Counterfeit Note Detected, A message to verify if the user wants to continue when at-
tempting to reset a counterfeit note detected error condition.  is applies to ATMs with cash recycling dispens-
ers only. 

When parameters are sent to the terminal, the error status will reset. A er correcting the condition the Error 
Code displays an updated status. If the same error appears, contact your service organization. If no errors exist, 
the Error Code displays a status of ‘0 - No Errors’. 

    

 is button shows the terminal service status that will take eff ect once the terminal receives the parameters. By 
default, the service status is set to Terminal In Service. Clicking the button changes the status to Terminal Out 
of Service.

**Note**
 e ATM so ware determines whether the terminal supports the Terminal In Service or Out of Service func-
tion. Otherwise, selecting this function will have no eff ect on terminal operation.

   

 is function discontinued.

 

Click the NMD Status Button to view the NMD dispenser’s conĕ guration. If the ATM does not use NMD Dis-
pensers, the Tab does not display the button.
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  ./ 

 e ISO Number identiĕ es an Independent Sales Organization (ISO) or other organization that provides ATM 
transaction processing services.  e magnetic strip on a bank card stores the ISO Number. During a transaction, 
the ATM reads the ISO Number and determines which action to perform, such as blocking the surcharge.

 

• Terminal Owner.  is message will appear to the customer on the surcharge warning screen. It identiĕ es the 
name of the terminal’s owner. 

• Surcharge Owner.  is message will appear on the Conĕ guration Summary Report in the X-Scale series 
ATMs or the Printer Test report on all other model terminals. It identiĕ es the name of the individual or orga-
nization receiving the surcharge. 

To change the Terminal or Surcharge Owner entries, click inside the Terminal Owner or Surcharge Owner entry 
and type the new message.

   

Select the check boxes to aff ect the operations of the ISO numbers Action.
• Click the check box for the “Send ISO regardless of changes”.  e terminal will request Triton Connect to 

send the ISO list if no other options change in the tab.
• Click the check box for the “Allow only ‘Accept’ ISO#”.  e terminal will act on the ISO numbers with the 

ISO Action of ‘Accept’ and ignore all other ISO numbers are ignored.

 /   

Click the View/Modify ISO Numbers button to open the ISO Entry Form. Use this form to view and modify the 
terminals ISO-based behavior. Enter an ISO number and specify a speciĕ c ISO Action. If the terminal reads an 
ISO number on the customer’s card, an ISO action activates against the customer’s transaction.  e terminal may 
have multiple ISO Numbers.
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  

**Note**
 e table below will assist the user to add data to the above ISO Entry Form. If the Host Processor requires the 
user to enter their data ĕ le to the text boxes, proceed to Import ISO File section. 

Control Event Function

Spreadsheet 
/ Flex Grid

Double Click ‘Le ’ mouse 
button in a cell under the 
ISO Number Column

Cell opens to receive input data. Pressing the <Enter>, <UP>,or 
<DOWN> arrows saves the keyed information to the selected cell 
and adds a new row to the spreadsheet.

Single Click ‘Right’ mouse 
button in a cell under the 
ISO Number Column

Menu options appear: Copy, Paste, Delete data.

Single Click ‘Right’ mouse 
button in a cell under the 
ISO Action Column

Menu Options appear to change the value of the cell: Block Sur-
charge, Decline Card, Use Deĕ ned Surcharge, Accept, Award Cou-
pon, MPTU Block, Block Transaction Type, Screen Action,or Use 
Deĕ ned Balance Surcharge.  is function will change the values of 
several cells, when user selects multi-cells.

Single Click ‘Right’ mouse 
button in a cell under the 
ISO Value Column

Provides a text ĕ eld to enter data. Not all ISO Action require a 
Value entry

OK Button Single Click ‘Le ’ mouse 
button.

Checks for incomplete and inconsistent data ĕ elds. Saves changes 
made by user. Closes the ISO list , spreadsheet.

Cancel 
Button

Single Click ‘Le ’ mouse 
button.

Closes the ISO Entry Form without saving changes.

Apply But-
ton

Single Click ‘Le ’ mouse 
button.

Checks for incomplete and inconsistent data ĕ elds. Saves changes 
made by user. Allows user to continue working
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    

Perform the following steps to add a new entry.
1. Double click (with the le  mouse button) on an 

empty cell under the ISO Number column. A data 
entry box will appear.

2. Type in a new ISO number and press Enter.  e 
adjoining cell, in the ISO Action column receives a 
default entry.

3. In the new entry under the ISO Action column, 
right-click the cell and select an available Action 
from the pop-up menu.

4. Right click in the Value column and select an avail-
able Value from the pop-up menu, type a monetary 
value, or the block will stay grayed out. 

**Note**
If the user selects the Use Deĕ ned Surcharge, User 
Deĕ ned Balance Surcharge, or Maximum Withdrawal 
Amount, ISO action in Step 3, a text box will appear. 
Select Screen Action and a pop-up menu appears. All 
other ISO Actions do not have a Value.

  

A few host processors require the user to import their 
ISO numbers via a data ĕ le.  is section describes the 
import procedure and selectable options.

Click the Import File button on the ISO Entry Form 
to access the text ĕ le in the ISO Folder.

1. Click the Select File button.
2. Locate the text ĕ le with the ISO bins and click the 

Open button. 
3. Verify that the setting for Overwriting Existing En-

tries, the Action, and the Value are set correctly. 
4. Click the OK button. Depending on the number of 

entries, there may be a delay before the ISO entry 
form ĕ lls. 

5. Click the Apply button, then click the OK button. 
6. Click the Send Parameters button. 
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**Note**
A check in the Overwrite Existing Entries box will 
cause the imported ĕ le to overwrite all entries on the 
ISO Entry form. No check in the box will append the 
imported text ĕ le a er the last ISO number row.

A description of each Action option provided below. 
 
• Block Surcharge. Selecting this action will cause 

the terminal to allow surcharge - free transactions 
when a customer uses a card with the currently 
displayed ISO number.

• Decline Card. Selecting this action will cause the 
terminal to refuse to process transactions when a 
customer uses a card with the currently displayed 
ISO number.

• User Deĕ ned Surcharge Amount. Selecting this 
option will cause the terminal to apply the appli-
cable surcharge to transactions performed with a 
card that uses the currently displayed ISO number. 
 e user enters the surcharge amount into the “ISO 
Action Parameter” box.

• Accept.  is action supports the ‘Bingo’ feature 
applicable to UK versions of ATM so ware.  e 
action applies to transactions performed with cards 
that use the displayed ISO number.

• Award Coupon.  is function awards a conĕ g-
ured customer coupon to customer cards with the 
displayed ISO numbers. 

• MPTU Block. (Mobile Phone Top Up-UK only) 
 is function disallows paying a wireless phone bill 
for customer cards with the displayed ISO num-
bers. 

• Block Transaction Type.  is function disallows 
PIN Services for cards with the displayed ISO 
numbers. 

• Screen Action.  is function allows user to alter 
the options on the customer transaction screen to 
include or block certain transaction options for 
cards with the displayed ISO numbers. 

• Use Deĕ ned Balance Surcharge. (Australia only) 
 is function works in conjunction with Balance 
Inquiry Surcharge enabled at the ATM and allows 
user to enable a surcharge for balance inquiries on 
cards with the displayed ISO numbers.

 e Value list displays values for speciĕ c Action items. 
Not all items will have a value, but present a text box to 
enter a monetary value.

With the Screen Action selected in the Action block, 
the Value block will show a list of value options.

• Allow Mini Statement 
• Block Mini Statement 
• Allow PIN Change
• Block PIN Change 
• Bansi Customer BIN
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 

Use this screen to setup or change the EMV parameters and applications applied to the bankcards. 
Click the EMV Settings button. 

Click the check boxes on the EMV speciĕ c parameters and applications to enable/disable the functions. Click the 
OK button to save the selected option. Click the Reset button to default the selections.  e host processor will 
determine appropriate parameters and applications for the terminal’s site.
• Enable EMV.
• Allow terminal to process magnetic stripe based transaction.
• Allow terminal to process magnetic stripe data as a fallback.
• ICC will latch and remain latched until user receives a prompted to remove card.
• Terminal will add the tag data stored on the terminal to journal entries.
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

  

Use this screen to change the communications conĕ g-
uration of the selected terminal.  e settings shown 
apply to communications with the Host Processor 
servicing the selected terminal. 

 


 e Predial function enables the terminal to dial out to 
the processor as soon as the customer’s ATM or credit 
card has been scanned, thus reducing the overall trans-
action processing time. With the Predial disabled, the 
terminal waits until the customer conĕ rms a speciĕ c 
transaction before dialing out. 

**Note**
 e host processor must support the Predial feature.

Follow the steps below to conĕ gure the Predial setting.

1. Click the down arrow in the Predial list box to 
view the options: Yes and No.

2. Select Yes to enable the Predial, or No to disable 
the Predial.

 

  . 

If the terminal’s modem requires a non-standard 
conĕ guration, type a Hayes-compatible setup string in 
the text box.  e string is sent to the modem when it 
initializes.

Follow the steps below to enter a Modem Init. String.

1. Click inside the Modem Init. String.

2. Type the Modem Init. String.
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 

If the terminal communicates with the host processor 
over a dial-up phone line, enter the Host Phone No. 
and the Alt. Host Phone No. at the terminal during the 
initial setup. 
 
 e Comm tab displays the Host and Alt. Host Phone 
Numbers in read-only mode.

 

 

In some cases, the host processor may require com-
munications using 8-bits per character and no parity, 
instead of the more commonly used conĕ guration of 
7-bits per character and even parity.  e Parity Selection 
function allows the user to switch between the two types 
of data-bites and parity.

Follow the steps below to change the parity type.

1. Click the box or the sentence to place a check mark 
in the check box and use 8-bites with no parity. 

2. Remove the check mark to use the 7-bites with even 
parity.
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   () 

Triton Connect views the state of Remote Key Trans-
fer (RKT) as enabled or disabled. With RKT enabled, 
Triton Connect can disable this feature. However, once 
RKT switches to disabled. a technician must visit the 
ATM to enable the feature. 

  

Click the Remote Key Transfer button. 

 e Remote Key Transfer screen opens.  is window 
shows the RKT status as enabled

**Note**
If the button does not appear, either the terminal does 
not support RKT or a user disabled the feature. 

    

Triton Connect uses a two-step sequence to disable the 
Remote Key Transfer (RKT).

1. Click the Disable RKT button.

 

A warning message appears. Read and understand 
the message. Once the RKT is disabled, a techni-
cian can only enable the feature at the terminal.

2. If the user does not wish to disable the RKT fea-
ture, click the Do Not Disable RKT button and the 
screen displays the “RKT is Enabled” message.

3. If the user wishes to disable the RKT feature, Click 
the Apply button and click the OK button. A RED 
band will surround the Remote Key Transfer but-
ton until the user clicks the Send Parameter button.

4. Click the Cancel button on either screen will re-
turn to the Comm tab screen.  
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  

 is tab lists signiĕ cant terminal transaction totals. 
 e values shown are read-only.

   

 e total number of checking and savings account 
withdrawal transactions applied since the last Day 
Close.

   

 e total number of credit card withdrawal transac-
tions applied since the last Day Close.

   

 e total number of balance inquiry transactions re-
quested since the last Day Close.
 

  

 e total number of account transfer transactions per-
formed since the last Day Close.

  

 e cash number represents the total monetary value 
of all Debit transactions since the last Day Close.

  

 e cash number represents the total monetary value 
of all Credit transactions since the last Day Close.

**Note**
 e value diff erences from Day Close to Day Close 
calculates the Terminal Totals. If Day Close function 
not performed daily, the totals cumulate.

 



Triton Systems ©134

  
 is tab applies only to Z180 (9100, 9600, 9700) ATMs.

   

 is tab sets up the terminal to download text-based 
Ad Screens.  e Ad screens will appear with the 
“Transaction Processing Please Wait” message, while 
the customer waits for the completion of the transac-
tion.

 e user can create up to four Ad Screens. Each screen 
consists up to eight lines of text.  e Display Duration 
(in seconds) sets the number of seconds the ATM dis-
plays the Ad Screen.

    

Graphics Ad Screens take priority over text-based 
screens. Terminals running Graphics Ad Screens, will 
not display Text Ad Screens.

Terminals will display Text Ad Screens, if no loaded 
Graphics Ad Screens available and the Triton Connect 
or by the local terminal control enabled the Text Ad 
Screen function

Follow the steps below to create a text-based Ad 
Screen.

1. Select the Ad Screen (1, 2, 3 or 4).

2. Move the mouse cursor into the message window 
area and click the le  mouse button to establish the 
starting point of the message.

3. Type the text as it will appear on the display. Use 
the Alt-key sequences to help format the text.

4. Assign a duration for the Ad (typically 5 to 10 
seconds).

Disable a speciĕ c Text Ad Screen by changing the Dis-
play Duration to zero (0).



Triton Systems ©135



  

Due to the increased amount of information to cover all dispensers, click the Currency Information button to 
access the Fast Cash amounts assigned to each dispenser. Each column displays the cash amounts for a speciĕ c 
dispenser.

Use this screen to change the cash amounts applicable to the listed parameters, by typing the values directly into 
the related text boxes.
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  

Up to seven fast cash amounts off er the customers a 
quick-cash withdrawal. 

Follow the steps below to change the Fast Cash 
amounts.

1. Click inside a Fast cash text box.
2. Type the fast cash amount.

**Note**
Fast cash amounts are multiples of the denomination. 
Other amounts will cause an error condition at the 
terminal.

.    

 is sets the maximum non-cash purchase limit.  e 
amount entered must equal an even multiple of the 
value of a single unit of non-cash purchases in the 
cassette.  e value is in dollar amounts only. No cents 
allowed.

Follow the steps below to change the maximum 
amount.

1. Click inside the Max Non Cash Withdrawal 
Amount text box.

2. Enter the maximum withdrawal amount.



 is read-only ĕ eld indicates the denomination of the 
currency in the cassette(s).

 .  

 is sets the maximum amount allowed per customer 
withdrawal transaction.  e amount ranges from 1 to 
999999 in increments of 1, but must be an even mul-
tiple of the denomination in the cassette.  e value 
uses whole amounts only. No fractions of a whole 
note allowed. Example: $30.00 is Okay, but $30.55 not 
allowed.

 e ATM compares the withdrawal amount entered, 
either through a Fast Cash selection or by user-deĕ ned 
entry, to the maximum withdrawal limit. If the amount 
is larger than the limit, an error message warns the 
user and displays the maximum allowable amount.

**Note**
The maximum withdrawal amount cannot exceed the 
lesser of the terminal’s max amount or the maximum 
set by the ATM’s host processor, since the processor 
must approve any selected amount.

Example: The terminal’s max amount equals to 
$450.00, but the processor has set the max to $400.00. 
The customer’s max withdrawal limit equals to 
$400.00. If the terminal’s max equals to $350.00 and 
the processor max equals to $400.00, the customer’s 
max withdrawal amount equals to $350.00.

Follow the steps below to change the maximum 
amount.

1. Click inside the Max Withdrawal Amount text 
box.

2. Enter the maximum withdrawal amount.
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  

 is tab provides read-only status information for 
each cassette in the terminal. Each cassette has its own 
Cassette Data ĕ elds.

  

Indicates the denomination of notes for multi-cassette 
terminals. A single cassette unit uses the Cassette A 
Data ĕ elds. Cassette B, C, D Data default to Zero (0) 
values.

  

Displayed for single-cassette terminals only. Total 
number of cash withdrawal transactions involving this 
cassette.

  

Amount of cash initially loaded into this cassette. Per-
sonnel responsible for loading the cassette with cash 
enters the value at the terminal.

** Note**
A correct Cash Loaded amount entered at the terminal 
prevents an ATM error with the actual amount of cash 
in the cassette.

 

 e number represents the total number of rejects 
during the dispensing of cash from this cassette.

 

Amount of cash dispensed from this cassette since the 
last cassette load.

 

Cash remaining in the cassette. Equals Cash Loaded 
minus Dispensed Amount.

  
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  

 is tab allows the user to view the read-only version 
numbers for key components of the operating so ware 
loaded on the terminal. 

  

 e Model # identiĕ es the terminal.

    

 e EPROM holds so ware downloading, initializa-
tion, testing, and low-level interface routines.  e Tri-
ton Controller Version # identiĕ es the so ware loaded 
on the EPROM chip installed in the terminal.

  

 e Program Version # identiĕ es the terminal’s oper-
ating so ware. Triton Connect or a user at the local 
ATM will download the so ware into the terminal.

  

 e Screen Version # identiĕ es the table components 
loaded in the terminal’s operating so ware.  e table 
components refer to the part of the so ware that pro-
vides the ATM user interface and associated terminal 
control functionality. 

  .

Triton Connect supports retrieving and displaying 
an increased amount of information about the ATM, 
devices, and general conĕ guration.

**Note**
If the user clicks on the Version Number tab and this 
feature is not available, contact Triton Technical Sup-
port to determine if your ATM has a so ware upgrade 
with this feature.

 

 



Triton Systems ©139

Click the View Conĕ g. Overview button.  e screen 
displays the ATM’s conĕ guration. When Technical 
Support asks for the conĕ guration and the user is not 
at the ATM, the following screen displays the hard-
ware and so ware and parameter setup.  e screen has 
a Copy Text button to copy the information into an 
email or text ĕ le.
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 / 
Refer to Triton Connect Manual Version 6.0 for this screen. 

Otherwise, click the Extended Parameters button under the Control Tab

 
Refer to Triton Connect Manual Version 6.0 for this screen. 

Otherwise, click the Extended Parameters button under the Control Tab

  
 e feature requires custom so ware for a speciĕ c customer.  is feature is not available to other customers.
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  

 is screen provides access to additional terminal pa-
rameters. Unless the user understands the eff ect of the 
parameters on the terminal’s operation or instructed to 
enable a feature by the host processor or by Technical 
Support personnel, do not alter these extremely sensi-
tive functions.

**Note**
A check in the check box makes the parameter active 
or enabled.

     -
 

Checking this option enables the terminal to include 
the Communication Header in all request messages to 
the host processor.  e user adds the header to the ter-
minal during the setup and conĕ guration procedures. 

   

Check this option to provide the status monitoring in-
formation to the host processor. Monitoring this status 
provides important information about the terminal’s 
operational readiness. 

    

Check this option to enable the terminal to send the 
terminal totals to the host processor during a close 
operation.

  

Check this option to enable the terminal to send a 
reversal to the host in the event the original request 
failed for a communication problem during sending/
receiving the transaction message.

  

Depends on your ATM as to which options are available.
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     

Follow the steps below to use this functionality. 
View or change the Bill Mix Method by clicking the 
drop down box and viewing the available options. 

   

 e READ-ONLY check box displays the current value 
set in the terminal’s Management Functions program. 
Check the box only if the terminal uses a rear dispens-
ing model.

 ()   . 
(=, =,  -

=)

 e READ-ONLY text box displays the current value 
set in the terminal’s Management Functions program.

 (-)  -

Use the check boxes in this section to control the ser-
vice status of each note cassette installed in the termi-
nal. Four check boxes support the maximum number 
of dispenser cassettes a terminal will use. Some dis-
pensers have few than four cassettes. A check in the 
corresponding check box will place the cassette to an 
In Service status. Verify the check boxes before initiat-
ing the “Send Parameters” command. 

**Note** 
To enable a cassette for In Service status, follow the 
proper loading procedure at the terminal. 

If the terminal has fewer than four cassettes installed, 
the remaining options will have no eff ect on its opera-

   

Check the check box for international currency value 
support. It enables the terminal to accept non-U.S. 
standard note denomination values.

  :

 is option allows the user to select the pick method 
for dispensers that employ multiple cassettes with the 
same denomination. 
•  e Minimize method minimizes the number 

of bills dispensed, and depletes an entire cassette 
before using another when both cassettes have the 
same denomination. For example, a three-cassette 
dispenser with $10 bills in cassette A and $20 bills 
in cassettes B and C will ĕ ll a $150 transaction 
request with 1 bill from cassette A and 7 bills from 
cassette B. Cassette C will not dispense notes until 
cassette B is empty. 

•  e Minimize EW method means the terminal 
rotates cassettes ĕ lled with the same denomination 
a er every customer transaction. For example, if 
cassettes A and B have the same denomination, 
the ĕ rst transaction a er a terminal restart will use 
cassette A.  e next transaction will use cassette B. 
Each subsequent transaction will rotate between 
the cassettes.

**Note**
To use this functionality, the ATM so ware must 
support this functionality. RL2000/FT5000/RT2000/
RL5000 ATM so ware version 2.4 introduces support 
for this functionality. If uncertain, please check with 
Triton Technical Support to verify if your ATM so -
ware version supports this functionality. 
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-

 

E-Flags are Advanced features for future use. DO 
NOT make any adjustments to these settings!

tion; however, the state of these unused options change 
to match that of the active options. For example, un-
check both Cassette A and Cassette B on a two-cassette 
terminal will automatically uncheck the Cassette C and 
Cassette D options.

**Note** 
 e Advanced Setting tab will display the Cassette 
Service check boxes when the selected terminal has a 
multi-cassette dispenser.



Triton Systems ©144



 e user can remotely change the terminal Master and Administrative passwords from this screen.

C P

**Note**
This function applies to Z-180 processor units (Mod-
els 8100/9100/9600/9700 etc.). To change passwords 
for X-Scale units (Models RL/FT/RT), use the “CON-
TROL” function, Eඑඍൾඇൽൾൽ Pൺඋൺආൾඍൾඋඌ > Mංඌർ 
option.

Clicking the Change Terminal Master Password but-
ton brings up the following.

 

Enter the current password in either case. If the pro-
gram accepts the current password, it will allow the en-
try of a new password, which will take eff ect a er the 
next scheduled parameter download to the terminal.
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

 is screen is read only.

A S C

Use the controls on this tab to enable or disable sur-
charging, enter a surcharge amount or percentage, 
and determine where to display the surcharge message 
during the transaction, either beginning or end of 
transaction. 

 e ATM’s processor or other appropriate regulatory 
agency will determine the speciĕ c surcharge require-
ments.

S C

Click the Modify Settings button.  is screen summarizes 
the surcharge settings and screen selected.

Perform the steps to conĕ gure the surcharge settings.

1. Click the down arrow in the Transaction Type list 
box and select a transaction.  e Surcharge Set-
tings will apply to transaction type: Withdrawal. 
See Step-10 for Tiered.

2. Enable Surcharge: Click the Enable Surcharge list 
box. A check in the box enables the surcharge 
function. Uncheck the box to disable the function. 

3. Amount: If the transactions require a ĕ xed sur-
charge amount, click inside the Amount textbox 
and enter the amount.  e value may be from 
$0.00 to $999,999.99 inclusive.

4. Credit Fee:  e Host will determine if this feature 
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is required. If yes, the Host will determine the 
additional fee added to the Surcharge. If no, 
leave this value at $0.00 to disable the feature. 
No additional fee added to the surcharge if the 
surcharge amount equals zero.

**Note**
If the transactions require a ĕ xed surcharge amount, 
and not use the surcharge percent, ensure the sur-
charge comparison option is set to GREATER and the 
surcharge percent is set to zero (0).  is will ensure 
the customer will see only the ĕ xed surcharge amount. 
Failure to do so can cause the terminal to report an 
incorrect surcharge value.

5. Set Will/May.  is lets the customer know if a fee 
for processing a transaction “may” or “will” occur.

6. Set Percentage. If the transaction amount requires 
calculated percentage surcharge, click the Sur-
charge Percent list and select the required percent-
age (0 to 99 percent)

7. Set Display Surcharge Screen location.  is option 
determines when the customer will see the sur-
charge message. 

8. A check in the check box displays the surcharge 
message AFTER the customer has entered a cus-
tom withdrawal amount or a balance request. 
Remove the check to display the surcharge message 
BEFORE the customer enters a withdrawal amount 
(the message will appear as soon as the customer 
removes their card from the card reader).

9. Set the Lesser/Greater option.  e surcharging sys-
tems calculates a surcharge based on a comparison 
between a ĕ xed surcharge and a percentage-based 
surcharge.

** Note **
If the processor or other authority requires that the 
surcharge be the lesser of either the surcharge amount 
or surcharge percentage, select the LESSER option. If 
the surcharge must be the greater of either the sur-

charge amount or surcharge percentage, select the 
GREATER option.

10. Select the surcharge Screen number the terminal 
will display. Click the Screen list box and select a 
screen.  e message text for this screen will appear 
in the preview window.

**Note**
 e Screen displays read-only text.

**Note**
If the user right-clicks in the text box, a second screen 
pops up.  is screen applies to the Z180 ATMs only.
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11. Right-clicking in the grid area will present the choice to add a new entry or delete a current entry.
12. Use the backspace, numeric, and decimal buttons on the keyboard to modify a current entry.
13. Click the OK button once the desired changes have been made.

14. Click Send Parameters button to schedule the terminals call to update the values.
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Use this screen to enable or disable Call Back and 
conĕ gure the parameters the terminal will use when 
placing calls to the Triton Connect host PC.

**Note**
With the Call Back disabled, the user must enter the 
EPROM access code in the terminal setup.

   

 is function determines whether not the terminal will 
return a call a er ĕ rst receiving an initiating call from 
a Triton Connect host computer.

    

 e terminal creates call blocks to contact the Triton 
Connect host computer. Each block consists of mul-
tiple attempts to reach the host computer, using the 
Triton Connect primary and backup phone numbers. 

During each block, the terminal will place a call to the 
primary number. If there is no answer in 60 seconds, 
the call will use the backup number, if one is available.

If there is no answer using the backup number within 
60 seconds, or there is no backup number available, 
the terminal will repeat the cycle by returning to the 
primary number, then the backup.

If there is still no answer a er two calls to the primary 
number and two calls to the backup number, the ter-
minal will pause for the time established by the Tri-
ton Connect Redial Delay parameter, then will begin 
the communications attempt again with the next call 
block. 

 e cycle of call blocks repeats for the number of times 
established in the Triton Connect Max Retries setting 
before abandoning the attempt to reach the host com-
puter.

  
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  

Use this function to determine the waiting period, in 
seconds, he terminal will observe between attempts to 
call back to the Triton Connect host computer.

   

Enter the numbers the terminal will use when calling 
back the Triton Connect host computer. Enter a pri-
mary number, and if a secondary number is available, 
enter it in the Backup Phone Number entry box.

   

In some applications the terminal monitors for alarm 
conditions. In these cases, the user provides a separate 
set of primary and backup phone numbers, which the 
terminal will use when attempting to report errors or 
other alarm conditions to a Triton Connect host com-
puter.

**Note**

When the user enables Triton Connect, enter a Primary 
number. The other phone numbers are optional.
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

 is screen controls various parameters associated with close scheduling, alarm threshold conditions, journaling, 
terminal monitoring and status reporting. 

 e following sections provide descriptions of the 
various parameters.

 

 is option appears for 32-bit terminals (RL/FT5000, 
RT2000, 98XX, ARGO and AGRO-FT) to conĕ gure 
speciĕ c parameters. 

Click the Extended Parameters button to access a 
sub-system of dialogs to conĕ gure speciĕ c parameters. 

• Misc
• Ad Data
• Option Screens
• News Ticker
• Couponing

• Service Provider (requires custom so ware)
• Gi  Cards (requires custom so ware)
• Propane (requires custom so ware)
• Anti-Skim

**Note**
A er completing the required parameter changes, click 
the Save Changes button to save the current settings 
and return to the Terminal Parameters main dialog. 

Click the Send Parameters button and the terminal(s) 
will receive the new settings.
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  

Click the Enable scheduled close check box and the 
terminal(s) will perform the Day Close function.

  

A er enabling the schedule close, the terminal will 
automatically generate a Day Close. Specify the time of 
day when the close will take place. Use the arrow con-
trols to select an hour, minute and AM or PM value.

  

 e Day Close report shows the cumulative value of all 
transactions (withdrawals, transfers, balance inquiries) 
performed by the ATM since the previous Day Close. 
 e report also shows the corresponding Host totals, 
to compare the ATM totals against the Host processor 
records.

Perform a Day Close once each business day. Because 
the Host Processor also performs a business Day Close 
for the ATM, perform the close at the same time each 
day at the time speciĕ ed by your Host Processor.  is 
will help ensure the Day Close reports reĘ ects the 
Host’s current business day totals for your ATM.

   

Check this option to direct the terminal to automati-
cally send the unaudited electronic journal records to 
the Triton Connect host computer at a speciĕ ed time.

   

Enter the time hours in 24-hour format at which the 
terminal will automatically send the contents of its 
electronic journal to the Triton Connect host comput-
er.

  

 e terminal will initiate the call at some random time 
that is within one hour of the speciĕ ed time.  e pur-
pose of this behavior is to avoid a situation in which 
multiple terminals attempt to call the Triton Connect 
Host Computer at the same time.
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      
 

Check this option to direct the terminal to place a call 
to the Triton Connect host computer whenever the 
number of records in the terminal’s electronic journal 
reaches a speciĕ ed value.

   

Enter the number of journal records that will estab-
lish an activating threshold for the Journal Records 
function. If this function has been enabled (see previ-
ous paragraph), when the number of journal records 
equals the value entered here, the terminal will auto-
matically call and transfer the journal to the Triton 
Connect host computer. 

     

Check this option to direct the terminal to place a call 
to the Triton Connect host computer whenever the 
level of cash in the terminal’s cash cassette reaches a 
speciĕ ed value.

   

Enter a quantity of cash in the cassette to establish a 
threshold for the Cash  reshold function. With this 
function enabled (see previous paragraph), when the 
number of notes in the cassette drops to the value 
entered, the terminal will automatically send an alarm 
notiĕ cation call to the Triton Connect host computer. 

   

Clicking this button provides access to enable the ter-
minal to go “Out of Service” for a Printer error. 

       


Check this option to force the terminal to remain in 
operation despite a low receipt paper condition.
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     

Click the Allow Heartbeat to be enabled check box 
which allows the terminal to display the Heartbeat 
option the operator.

 e Heartbeat option will appear in the applicable 
Management Functions menu area of the terminal. 

 / 

Click the Enable Heartbeat by delay period check box 
and enter a value in the Delay Period text box to set the 
number of minutes the terminal will wait before send-
ing the Heartbeat message to the host processor.

     

Click the Enable Heartbeat at Speciĕ c Time check box 
and enter a speciĕ c time when a heartbeat message will 
be sent to the host processor. 

 

 e single most important feature of an ATM is the 
communications between itself and the host processor. 
When communications break down neither the host 
processor or the ATM will know of the failure. 

In real-time, the host has no way of determining if 
communications failure has occurred as a result of 
equipment failure or the absent of transactions due to 
a slow period.  e ATM’s Heartbeat feature provides a 
means of reporting communication’s system status to 
the host processor via dial-up or TCP/IP. 

With the Heartbeat feature enabled, the terminal will 
call the host a er a period of inactivity. During this 
call, the terminal will request a COMMS KEY DOWN-
LOAD, the normal conĕ guration download request, 
and will report the status to the STATUS MONITOR-
ING function.  e host determines the terminal’s com-
munication status without the terminal performing 
any transactions at the time. 

An internal timer will initialize to the number of min-
utes set in the DELAY PERIOD parameter at system 
power-up and a er a reset.  is timer restarts each 
time the terminal makes a call to the host. A call in-
cludes any transaction, ĕ nancial balancing, or conĕ gu-
ration that communicates with the host.  is includes 
up to the point that the host recognizes the Terminal 
ID. 

A customer declined transaction will reset the timer, 
while a failed call because of a busy host phone num-
ber will not.
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   - 

 e Extended Parameters - Misc tab allows the user to 
perform the following conĕ guration actions.

1. Change Default Language.
2. Change Default Transaction.
3. Change Default Account.
4. Change Protocol Type.
5. Change Message Type.
6. View User List.
7. Schedule Reboot.
8. Delete users and/or modify user name (32-bit 

terminals only)

  

Use the Default Language to display and print customer 
and management reports, and receipts.

 e default language sets the language initially dis-
played on customer transaction screens. In most cases, 
the terminal’s location and customer language consid-
erations will determine the default language. Usually, 
the default language will suffi  ce for most of the intend-
ed customers. 

In other cases, give customers the option of selecting 
a diff erent language via the language selection screen. 
 e ATM will use this language in all transaction 
screens for the current session only, a erwards the 
ATM will return the language to the default language. 

Follow the steps below to change the Default Language.

1. Click the down arrow in the Default Language list 
box to view the available languages. 

2. Available languages include: English, Spanish,-
French, and German.  e terminal’s so ware 
determines the availability of other languages. 

3. Click a language for default.

  

 e Default Transaction enables the ATM to present 
a default transaction to the customer: Withdrawal, 
Transfer, or Balance. In most cases, the ATM presents 
some or all three of these options to the customer. In 
some instances, the ATM has additional transaction 
options disabled and not displayed to the customer.

If no other transaction options are available or enabled, 
the ATM displays the default transaction type (such as 
withdrawals) to the customer.

Follow the steps below to change the Default Transac-
tion.

1. Click the down arrow in the Default Transaction 
list box to view the available transactions. 
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2. Available transactions include: Withdrawal, Bal-
ance, Transfer, Purchase, and Other depending 
upon the terminal’s so ware version.

3. Click the transaction type for default.

  

 e Default Account enables the ATM to present a de-
fault account for customer transactions: CHECKING, 
SAVINGS, CREDIT CARD, or OTHER. In most cases, 
the ATM presents some or all account options to the 
customer. In some instances, the ATM has addition-
al account options disabled and not displayed to the 
customer.

If no other account options are available or enabled, 
the ATM displays the default account type (such as 
checking) to the customer. 

Follow the steps below to change the Default Account.

1. Click the down arrow in the Default Account list 
box to view the available account types. 

2. Typical account types include: Checking, Savings 
and Credit. 

3. Click the account type for default.

  

 e communications protocol setting depends on 
the type of communications environment the termi-
nal operates and the host processor’s requirements. 
 e Triton Standard communications protocol, for 
example, suffi  ces for many locations in the continen-
tal United States. International markets may require 
diff erent protocol, such as Datapak, Radiopad, or other 
specialized protocols.

Follow the steps below to change the Protocol Type.

1. Click the down arrow in the Protocol Type list box 
to view the available protocols. 

2. Click the protocol type desired.

  

 e communications message setting speciĕ es the 
content and structure of messages pass between the 
terminal and the processor during transactions and 
status updates.  e Triton Standard communications 
message speciĕ cation suffi  ces for many locations in the 
continental United States. International markets may 
require a diff erent message speciĕ cation.

 e communications message setting will depend on 
the processor’s communications requirements. 

Follow the steps below to change the Message Type.

1. Click the down arrow in the Message Type list box 
to view the available message formats.

2. Click the message type desired.
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 

Triton recommends a periodic scheduled reboot of 
PC-based units at least once a week. Use these ĕ elds to 
Enable the Scheduled reboot and set the time for the 
reboot of the terminal.

  

Passwords restrict management functions access to 
designated personnel. Each authorized user has an 
assigned password, 2-digit ID code, and a username. 
Enter the ID code and password to access the terminal 
management functions.  e username can consist up 
to 40-characters and refers to the currently logged user. 

 e User List shows the ID code and corresponding 
username for each user on the terminal.

 /   ()
 is option available with the X3/32-bit terminals only. 

To Delete a User, not the Master, highlight a User, then 
click on the Delete User button.  e ATM deletes the 
user’s name. 
To Modify a User’s name or change a User’s password 
highlight a User and click the Modify User button.  e 
following screen will appear.

Change the User’s name and/or password and click the 
Apply button.  e ATM updates the user’s name and/
or password.

**Note**
 e terminal must run so ware version 1.8.2 or newer 
to modify the Master and User passwords.

Import ATM Passwords from File

Triton Connect adds the ability to import user pass-
words to the ATM.  e ĕ le reduces typographical 
errors or re-typing the passwords if they will be sent 
to several ATMs or groups of ATMs at diff erent times. 
 e format of the ĕ le is one user’s data per line con-
taining the User ID, Username, and the password, each 
separated by a comma. NotePad or a any standard text 
editor can create the ĕ le.

To use this feature, perform the following steps.

1. Open the Triton Connect Terminal Manager
2. Click the Terminal Data menu and select Set Ter-

minal parameters.
3. Select the desired ATM and click View Parameters.
4. Navigate to the Control tab.
5. Click the Extended Parameters button.
6. Navigate to the Misc tab.
7. Click Import From File in the User List area.
8. Browse for the ĕ le, select it, and click Open.
9. Click Save Changes.
10. Click Send Parameters to schedule the call to the 

ATM.
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   

 is tab enables the user to perform the following ad 
conĕ guration actions.

1. Add and Remove Ads.
2. Conĕ gure Ad Display Times, Duration and Loca-

tion.
3. Conĕ gure Ad Sequence.
4. Select a Screen File.

   

Follow the steps below to add an Ad ĕ le to the Active 
Ads list.

1. Check the Terminal Data Directory list. Locate and 
highlight an Ad ĕ le in the list. Click the Activate 
Ad button to transfer the ĕ le to the Active Ads list.

2. To highlight a group of ads, click once on the ĕ rst 
ad, then hold down the SHIFT key while clicking 
on the last ad in the group.  is will highlight the 
ĕ rst ad, the last ad and any ads in between. 

3. To highlight multiple ads that do not fall neatly 
into a group, hold down the CTRL key while click-
ing on any ad anywhere in the list.

4. If the list does not contain the desired Ad ĕ le, click 
the Add Ad button to bring up a browse dialog.

5. Browse to the Ad ĕ le’s location and click the ĕ le-
name. Click the Open button and return to the Ad 
Data window.  e Terminal Data Directory and the 
Active Ads list will display the new Ad ĕ le.

6. When the Active Ads list receives a new Ad ĕ le, 
the scheduling, duration, and ad location controls 

 
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opens. Conĕ gure the ad display times, duration 
and location. See the next section Conĕ gure Ad 
Display Times, Duration and Location for instruc-
tions.

Follow the steps below to remove an Ad ĕ le from the 
Active Ads list.

1. Locate the Ad ĕ le for removal from the Active Ads 
list and click on the entry to highlight it. 

2. Click the Remove Ad button to remove the ad ĕ le.

  

 e arrangement of the Ad ĕ les in the Active Ads list 
determines the order in which the terminal’s display 
presents the multiple ads to the customer.  e user 
controls this order by moving ads up and down in the 
list.

Click on the Ad ĕ le in the Active Ads list to highlight 
it. Click the Move Up button to move the Ad ĕ le up 
or click the Move Down button to move the Ad ĕ le 
down. Each click of the button moves the ĕ le one posi-
tion up or down.

    , , 
 

Performing either of the following actions will show 
the ad display times, duration and location controls.

• Add an Ad ĕ le to the Active Ads list. 
• Highlight an entry in the Active Ads list and click 

the View Schedule/Field button.

Follow the steps below to conĕ gure ad display times, 
duration, and location for the selected Ad ĕ le in the 
Active Ads list.

1.  e Active Hours schedule shows a check box for 
each hour of the day. New ads receive the default 
setup with all boxes checked for a 24-hour display. 

 
Remove the check marks for those hours, in which, 
the terminal will not display the ad. Click the Ap-
ply button to accept the changes.

2.  e Duration sets the length of time (in seconds) 
the terminal displays the ad. By default, the text 
box contains a value of zero (0) and the terminal 
will not display the ad. 

To set the time, click inside the Duration text box 
and enter a duration in seconds, between 0 and 
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120. If the ad is a video with a zero (0) Duration, 
the terminal will display the ad for the entire play-
ing time of the video. Click the Apply button to 
accept the changes.

3.  e Active Field speciĕ es where the terminal dis-
plays and/or prints the ad graphics. To conĕ gure 
the location for the current ad, click inside the 
Active Field to view the location options. 

Click the required option, then click the Apply 
button to accept the choice.

4. When clicked, the Apply button becomes the 
Done button. Click the Done button to return to the 
main Ad Data window.

   

 e Screen File speciĕ es the appearance and function-
ality of the screens the terminal displays to the custom-
er. 

**Note**
Screen ĕ les must be in the *.tsm ĕ le format. 

Follow the steps below to select a Screen File.

1. Locate and click the screen ĕ le in the Terminal 
Data Directory list to highlight it. Click the Acti-
vate Screen File button.  e selected Screen File 
name is shown next to the button.

2. If the list does not show the desired Screen File, the 
user must add the Screen File via a so ware update 
procedure.

 -/ 

Disk/Flash memory stores the Graphic ĕ les. RAM 
memory temporarily holds the ĕ les while in use by the 
terminal’s display.

 

 e terminal reveals graphics in designated ĕ elds on 
the display. Optimize graphics by creating them in 
sizes that ĕ t their intended use. Graphic dimensions 
are in pixels.

 
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        

ARGO 15 & FT 15” Full Screen 1020 x 764 jpg, gif, bmp

Welcome Ad 500 x 500 jpg, gif, bmp

Header 1020 x 120 jpg, gif, bmp

Transaction Ad 1020 x 485 jpg, gif, bmp

Receipt Graphic 480 x 120 bmp / Black Only

ARGO 12.0 12.0” Full Screen 796 x 596 jpg, gif, bmp

Welcome Ad 408 x 329 jpg, gif, bmp

Header 796 x 90 jpg, gif, bmp

Transaction Ad 796 x 341 jpg, gif, bmp

Receipt Graphic 480 x 120 bmp / Black Only

ARGO 7.0 7” Full Screen 796 x 476 jpg, gif, bmp

Welcome Ad 446 x 294 jpg, gif, bmp

Transaction Ad 796 x 300 jpg, gif, bmp

Receipt Graphic 480 x 120 bmp / Black Only

X-MIGRATED

RL/FT5000/RT2000 10.4” Header 636 x 90 jpg, gif, bmp

Welcome Ad 310 x 385 jpg, gif, bmp

Full Screen 636 x 476 jpg, gif, bmp

Transaction Ad 636 x 260 jpg, gif, bmp

Receipt Graphic 480 x 120 bmp / Black Only

RL2000 8.0” Header 636 x 90 jpg, gif, bmp

Welcome Ad 310 x 385 jpg, gif, bmp

Full Screen 636 x 476 jpg, gif, bmp

Transaction Ad 636 x 260 jpg, gif, bmp

Receipt Graphic 480 x 120 bmp / Black Only

X UNITS

RL2000 5.7” Full Screen 636 x 476 jpg, gif, bmp

Transaction Ad 636 x 260 jpg, gif, bmp

Transaction Ad 636 x 475 jpg, gif, bmp

Receipt Graphic 480 x 120 bmp / Black Only

X-SCALE UNITS

RL/FT5000/RT2000 Full Screen 636 x 476 jpg, gif, bmp

LOGO 310 x 85

Transactions Ad 636 x 260

Banner 205 x 56

Header 636 x 90

Welcome Ad 310 x 385

Receipt Graphic 480 x 120 bmp / Black Only

Coupon Graphic (Top or Bottom - Only) 450 x 225 bmp only

Coupon Graphic (Top and Bottom - Only) Applies any X2 Display 320 x 160 bmp only
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  - 

**Note**
 is feature is part of a custom so ware. Contact the ATMs host processor to determine if the custom so ware 

is required for this ATM.

  -  

  

Use this function to enable/disable optional screens and screen buttons at the terminal. 
Follow the steps below to conĕ gure Optional Screens and Screen Buttons.
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1. Click the down arrow in the screens list box. Select 
a screen type. 

2. Click the Screen Enabled check box to enable 
(check) or disable (uncheck) the currently selected 
screen. 

3.  e Optional Buttons choice applicable to the 
selected screen will appear. Click the check boxes 
to enable (check) or disable (uncheck) the buttons, 
as applicable.

4. A er completing any required parameter changes, 
click the Save Changes button at the top of the 
screen to return to the Terminal Parameters main 
dialog.

 e types of screens and screen button choices can 
vary depending upon the Screen File that is currently 
in use.  e available screen options will generally fall 
into the following categories.

/

 ese screens off er additional keypad-based and 
audio-transaction based account and transaction-type 
selections to the customer, such as for balance inqui-
ries, transfers and cash withdrawals.

**Note**
Main transaction/account selections may necessitate 
the conĕ guration of other options. See the terminals 
Operation/Conĕ guration manual for more details.

 

 is screen off ers the customer the opportunity to 
select a favored language in which to perform the 
transaction, such as Spanish or French.  e terminal 
supports both displayed and audio-based language 
selections. A er the completion of the transaction, the 
ATM returns the screens to the default language.

 

 e host processor may require speciĕ c wording in the 
surcharge notiĕ cation message presented to custom-
ers.  ese screens off er a choice of surcharge message 
types.  e location of the surcharge message in the 
transaction Ę ow (Beginning or Ending) is also select-
able.

  

 ese screen buttons off er the customer the conve-
nience of choosing from several predeĕ ned withdrawal 
amounts, rather than having to enter a value.

 

 is selection of buttons is currently not available.
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 

Coupons notify customers of awards, prizes, sales, or 
other promotional opportunities. From the Extended 
Parameters - Coupon tab the user performs the follow-
ing coupon conĕ guration actions.

1. Select Coupon Type.
2. Set Minimum and Maximum Levels.
3. Enter a Random Percentage.
4. Enter a Coupon Prompt.
5. Enable Award Based on ISO Properties.
6. Conĕ gure Printed Coupon Message, Graphic, and 

Layout.
7. Conĕ gure Dispensed Coupon Cassette and Num-

ber of Dispenses.

  

Customers may receive one of two types of coupons: 
Printed or Dispensed.  e user must select the coupon 
type, before conĕ guring the coupon’s settings.  e user 
may set up as many as four Printed and two Dispensed 
coupons.

Follow the steps below to select the coupon type.

1. Click the coupon types drop-down list. 

• Printed0.  is is the ĕ rst of four available printed 
coupon types.  e receipt printer prints coupons to 
the customer. 

• Printed(1-3). Additional printed coupon selec-
tions.

• Dispensed0.  is is the ĕ rst of two available 
dispensed coupon types. A designate dispenser 
cassette(s) dispenses coupons to the customer. 

• Dispensed1. Additional dispensed coupon.

2. Select a coupon type. Set the coupon parameters as 
required.

    

 e Minimum Level parameter represents the mini-
mum withdrawal amount that will trigger the print-
ing or dispensing of a coupon.  e Maximum Level 
parameter represents the maximum amount that will 
trigger the printing or dispensing of a coupon.

Follow the steps below to set the minimum withdrawal 
amount for the currently selected coupon type.

  - 
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1. Click inside the Minimum Level text box.
2. Enter a value.  e value must be at least as large 

as the Multiple Amount parameter, and no greater 
than the Maximum Cash parameter.

3. Click inside the Maximum Level text box.
4. Enter a value.  e value must be at least as large 

as the Multiple Amount parameter, and no greater 
than the Maximum Cash parameter. 

If the customer performs a successful withdrawal 
transaction for an amount equal to or greater than the 
Minimum Amount parameter and less than or equal 
to the Maximum Withdrawal Amount parameter, the 
Coupon Type selected will determine whether to print 
or dispense a coupon. 

   

 is function sets the frequency when to print or dis-
pense awards coupon.  e random percentage can be 
set from 0 to 100%. For example, a random percentage 
of 10% will print or dispense one prize coupon out of 
every ten successful transactions.

Follow the steps below to enter a random percentage 
value.

1. Click inside the Random Percentage textbox.
2. Enter the random percentage, from 0 to 100. 

   

On the ATM display a brief message informs the cus-
tomer of a coupon, and they should retrieve it.

Follow the steps below to enter the coupon prompt 
message.

1. Click inside the Prompt text box.
2. Enter a brief message to prompt the customer to 

retrieve the coupon. 

     

 is function allows customers to receive coupons 
based on the detection of a ISO Number, when the 
terminal scans the customer’s ATM card. 

**Note**
 e ISO Number must have the Award Coupon action 
selected.

Click the Award Based on ISO Properties check box. A 
check mark in the box enables the function, 

   , 
  

 e settings in the Printed Coupon area applies to 
printed coupons only.  e Printed Message text box 
allows the user to type a descriptive statement that 
will appear on printed coupons.  e message should 
describe the purpose of the coupon, such as a dis-
count coupon, prize claim slip, or other statement.  e 
Graphic File Name adds an image to the printed cou-
pons.  e Layout parameter establishes the orientation 
of text and graphics on printed coupons. 

Follow the steps below to conĕ gure the coupon mes-
sage, graphic, and layout for printed coupons.

1. Click inside the Printed Message text box. Enter a 
brief coupon message.
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2. Click the down arrow in the Graphic FileName list 
box to view the available graphics and select the 
desired graphic. 

3. If the list does not contain the desired graphic 
ĕ le, click the Send Coupon button to bring up a 
browse dialog. 

4. Browse to the location of the graphic ĕ les and click 
to highlight the ĕ lename. Click the Open button 
to accept the selection and return to the Coupon 
window. 

5. Click the Layout list box to view the available 
alignment types. 

 e alignment can be set to one of three types. 

• Top & Bottom Graphics orientate along the top 
and bottom of the receipt paper.

• Top Graphic orientates along the top of the receipt 
paper.

• Bottom Graphic orientates along the bottom of the 
receipt paper.

6. Click the layout type needed.

    
   

**Note**
 is feature is available only for NMD dispensers that 
have two or more cassettes.

 e settings in the Dispense Coupons area apply to 
dispensed coupons only.  e Cassette selection deter-
mines the cassette that will dispense the coupons.  e 
Count parameter determines the number of coupons 
dispensed for each qualifying transaction.

Follow the steps below to conĕ gure the coupon cas-
sette selection and number of dispenses.

1. Click the Cassette list box to view the available 
cassettes. Select the cassette that will dispense 
coupons. 

2. Click inside the Number to dispense text box. Enter 
the number of coupons to dispense for the selected 
cassette.
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 

 
**Note**

 is feature is part of a custom so ware. Contact the ATMs host processor to determine if the custom so ware is 
required for this ATM.

 

**Note**
 is feature is part of a custom so ware. Contact the ATMs host processor to determine if the custom so ware is 
required for this ATM.
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   -  

**Note* 
Consult the Propane Pump Payment Module (PPPM) Users Manual for information on these settings.
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-

 is feature adds the ability to view and change values speciĕ c to the anti-skim card reader.  is feature only 
applies to ATMs with an anti-skim card reader.

 

• Metal Preset Time (sec) for temperature corrected 
is the time for which metal must be continuously 
detected to be considered a skimmer. Set to 0 sec-
onds to disable. 

• Metal Absent Time (sec) for temperature corrected 
is the time for which metal must be continuous-
ly removed before terminal recognizes skimmer 
removed. 

• Detection Voltage (mV) for temperature correct-
ed is the voltage sensed by the metal detector by 
which any higher voltage is considered a skimmer. 

• Warning Voltage (mV) for temperature corrected 
option currently unavailable.

 

• Metal Present Time (sec) for diff erential voltage is 
the time for which metal must be continuously de-
tected to be considered a skimmer. Set to 0 seconds 
to disable. 

• Metal Absent Time (sec) for diff erential voltage 
is the time for which metal must be continuous-
ly removed before terminal recognizes skimmer 
removed. 

• Detection Voltage (mV) for diff erential voltage is 
the voltage sensed by the metal detector by which 
any higher voltage is considered a skimmer. 

• Warning Voltage (mV) for diff erential voltage op-
tion currently unavailable.
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

 is screen enables the user to conĕ gure miscellaneous formatting options if so ware supports these features 
permits.

  

 is function enables the user to select the symbol that 
is appropriate for the currency type being used in the 
terminal.

“” . “”

Terminals installed in certain international locales may 
require the variant of the word “checking.”

   

Check this option will alter the format of the customer 
transaction receipt to ĕ t the requirements of the Latin 
American marketplace.

  

Use this option to select the date format that is most 
appropriate for the terminals’ location.

E  C
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    

Follow these steps to access the View Journal Data 
function.

1. Navigate to the Terminal Manager > Terminal Data 
> View Journal Data option. 

2.  e View Journal Data screen opens.

   

Follow these steps to view journal data for the selected 
terminal.

1. Select a terminal ID using the Terminal ID drop-
down list. 

2. Click the View button.  e Journal Data screen 
opens, as shown here.

3. By default, the screen displays the ĕ rst journal 
data record. Click the Next button to see the next 
journal entry.



Navigate through the journal data for the selected ter-
minal by using the navigation buttons.

   



In Chapter 5, Getting Terminal Parameters, the user learned how to retrieve terminal data, consisting primarily of 
terminal parameter data and journal data. Once Triton Connect receives and stores the data in the database, the 
user can access and view the data. In this chapter the user will learn how to view the stored journal data, how to 
extract, and to archive selected journal information from the journal database.
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**Note**
Use ALT (key) combinations to quickly scroll through 
the journal entries. To do so, hold down the ALT key 
on the keyboard then press one of the following keys.

 F - Moves to the First record.

 P - Moves to the Previous record.

 N - Moves to the Next record.

 L - Moves to the Last record.

First: Click the First command button to move to the 
ĕ rst journal data record in the database for the selected 
terminal and displays the data.

Previous: Click the Previous command button to move 
to the previous journal data record in the database for 
the selected terminal and displays the data.

Next: Click the Next command button to move to the 
next journal data record in the database for the select-
ed terminal and displays the data.

Last: Click the Last command button to move to the 
last journal data record in the database for the selected 
terminal and displays the data.

  

Search the journal record using deĕ ned criteria with 
the help of the search deĕ nition function. To activate 
it, click the Search button.

 e search deĕ nition window opens.

Choose the criteria from the drop-down list to deĕ ne a 
search.

Scroll through the list for more options. For each 
option the search window will automatically provide 
additional controls to help reĕ ne the criteria selected.

With the search criteria selected, click the Apply but-
ton to conduct the search. A separate window displays 
the ĕ rst record that matches the search criteria.

   

Click the Print button to print the entire journal, or 
selected portions of the journal.

 e Print window opens.
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  

 

Use the Entry Range options to choose the number of 
journal entries you want to print. 

 e Current Journal Entry option will print the infor-
mation for the entry currently displayed in the View 
Journal main window.

 e All Journal Entries option will print the infor-
mation for ALL database journal entries.  e option 
label  lists the number of entries stored in the database, 
(8 entries in this example), so exercise caution when 
choosing this option.

   

 e print function default has a check mark in the 
Print All Entries option box.  is feature selects all 
journal entries in the speciĕ ed range for printing, in-
cluding previously printed entries. 

If the user wishes to print only those entries in the 
print range excluding the previously printed entries, 
uncheck the Print All Entries check box.

 

Use the options in the Report Format area to control 
the format of the journal printout.

 e Expanded option will print all information asso-
ciated with each journal in an extended format that 
is more “user friendly” than the abbreviated Comma 
Delimited and Journal Tape options.

Select the Print to File option to activate the Comma 
Delimited report format.  e print function will send 
the report output to a speciĕ ed ĕ le instead of to the 
printer.

   

Triton recommends using the Comma Delimited 
option with compatible external applications such as a 
spreadsheet and database programs.

Quotes and commas, enclose data associated with each 
entry shown in this example.

 is type of output allows spreadsheet, database, or 
word processor programs to easily store journal data in 
a structured way for retrieval and formatting.  

 e Journal Tape option produces a report formatted 
in an appearance like the terminal’s receipt paper out-
put, as in this example.

  

Select the Print to File option to print Expanded, Com-
ma Delimited and Journal Tape reports to a ĕ le instead 
of to the printer.
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Select the Print Transactions Only option to exclude 
non-transaction speciĕ c entries from a report.  is 
option becomes active with both the Print to File and 
Comma Delimited options checked.

With a check in the Mark Entries as Printed box, the 
database will mark any journal entries printed as “Pre-
viously Printed”. 

Select the Print All Entries option to include all entries 
in the speciĕ ed range in the printout. To exclude en-
tries marked as “Previously Printed,” do not select this 
option.

A er choosing the print options, click the OK button 
to print the selected journal data to your default print-
er or ĕ le.

   

 e transaction-processing organization passes these 
codes to the terminal and stores them in the journal 
records. Triton Connect downloads these codes upon 
command.  e Journal Text Entry ĕ eld shows the 
codes in the View Journal window, as shown in this 
example.

Response Code  

 e example shows the host processor declined the 
transaction because of an INVALID PIN (Response 
Code 0050).

TRANSACTION RESPONSE CODES

CODE DESCRIPTION CODE DESCRIPTION CODE DESCRIPTION

000 Transaction approved 014 PIN tries exceeded 028 Pre-pay transaction failed

001 Expired card 015 Database problem 029 Pre-pay transaction rejected

002 Unauthorized usage 016 Withdrawal limit 
already reached

030 Invalid mobile phone number

003 PIN error 017 Invalid amount 031 Pre-pay account limit reached

004 Invalid PIN 018 External decline 032 Pre-pay system unavailable

005 Bank unavailable 019 System error 033 Response would exceed message size limit

006 Card not supported 020 Contact card issuer 034 Necessary information missing to process transaction

007 Insuffi  cient funds 021 Routing lookup 
problem

035 Second Invalid PIN (second “invalid PIN” try in a 
row and one try is le  before deactivation)

008 Ineligible transaction 022 Message edit error 036 Fallback Not Allowed

009 Number of daily with-
drawals exceeded

023 Transaction not 
supported

037 Invalid Exchange Rate (for Currency Exchange trans-
actions)

010 Cannot process trans-
action

024 Insuffi  cient funds 085 Request AAC from ICC (for Balance Inquiry and 
PIN Change chip transactions – see 10.10.1)

011 Amount too large 025 Western Union 
sender data error

111 Reversal Declined

012 Account closed 026 Western Union 
receiver data error

222 PIN Change Declined

013 PIN tries exceeded 027 CRC error 223 PIN Unlock Declined
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   

Follow these steps to access the View Archived Journal 
Data option.

1. Navigate to Terminal Manager > Terminal Data > 
View Archived Journal Data option.

2. A ĕ le search dialog box opens. Use the dialog box 
to locate and select the archive ĕ le with the .ach 
(archive) extension. 

3. Click the Open button to open the archive ĕ le.  e 
View Archived Journal Data screen opens. Because 
this screen has the identical form layout as the 
View Journal Data screen, refer to the beginning of 
this chapter for additional information on select-
ing, viewing and printing the archived journal 
entries.

4. Select the ID of the terminal using the Terminal ID 
drop-down list. 

5. Click the View button.  e journal data window 
opens.

6. By default, the screen displays the ĕ rst journal data 
record. To see the next journal entry, click the Next 
button.

 e View Archived Journal Data screen controls are 
identical to those in the View Journal Data window. 
Refer to the coverage of that function earlier in this 
chapter for details on navigating the associated screens 
and viewing the journal data.
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   ( ) 

 is application only used for older TC Databases that might gave unmasked data in an Access Database.
 is utility will mask Personal Account Numbers (PAN) data in journal records for Triton Connect databases 
and journal archived ĕ les.   ese records show the ĕ rst six (6) digits and the last four (4) digits of the account 
numbers.  e equal (=) sign representing the masking character replaces the middle digits.  An example of  PAN 
data: 123456======7890.

Follow these steps to access the Mask Journal Data (PAN data) function.
Navigate to the Terminal Manager > File > Mask Journal Data option.  e following screen opens.

Log window.  Lists actions of program

Will end programWill close/open Log window

Files selected for batch operation Log fi le Will process fi les in batch list

Will add to batch list below Will process current info

Used to select a fi le for processing

Displays location and name of current fi le selected
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      
 

Triton Connect allows a Journal Archive ĕ le (.ach) 
as the data source to generate a Journal Data Report. 
Follow these steps.

1. Navigate to the Terminal Manager > Utilities > 
Reports Manager option.

2. Select Journal Data in Available Reports scroll box.  
3. Click the check box to enable Select Archive File. A 

Browse button appears.

Click the Select All button to select all entries or click 
the Start Date or End Date calendar to set the date 
range.

4. Click the Browse button. A dialog screen will open. 

Use this dialog to locate and select an existing jour-
nal archive ĕ le (.ach).

 

5. Click the Open button on the browse dialog to 
load the ĕ le and return to the main dialog window. 
An entry for the selected journal ĕ le will appear in 
the main window.

6. Select the Disable Error Messages to suppress any 
unexpected or corrupted data messages. Normally 
not selected.

7. Conĕ gure the dialog controls as needed and click 
the View button to generate the report.

     
  

 e Triton Connect databases use the Microso  Access 
database management system and thus have a 1 giga-
byte limit.  e Data Manager in the Triton Connect 4.4 
and above will not add any more data if the database is 
close to the 1 gigabyte limit.

E  C 
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 

**Note**
 is feature requires custom so ware for a speciĕ c customer. If you believe you are that speciĕ c customer, con-
tact the ATM’s Host Processor to verify this ATM needs the custom so ware.

Refer to Triton Connect Revision 6.0 for detailed information about the LED Sign Messages feature.

E  C
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   

Navigate to the Terminal Manager > Utilities > Reports 
Manager option and the following screen opens.

  

 e Available Reports off ers a list of report types. Fol-
low these steps to view a report.

1. Select the type of report from the Available Reports 
list provided below.

Call Failures Journals Downloaded

Call List Report Journals Not Downloaded

Cassette Close Most Common Status 
Messages

Cassette Status Scheduled Close Status

Check Digits Terminal Conĕ guration

Check Digits 3Des Terminal Down Time

Coupon Report Terminal Files

Day Close Terminal Status

Denied Transactions Terminal Status Messages

Down Time Per 
Error

Terminal text Messages

EMV Data Terminal Totals

ISO Numbers Triton Connect Numbers

Journal Data Version Numbers

2. Additional controls will appear in the Reports 
Manager for some reports. Use these controls to 
reĕ ne the report criteria.  e Changing Report 
Criteria section describes the control functions.

3. Make any needed control selections to further de-
ĕ ne the output of the selected report type. Click the 
View button to generate the report.

  

If errors exist in the data used to generate the report, 
such as incorrect or corrupted terminal data in the da-
tabase, a series of error messages will appear.  e user 
must dismiss each error message to view the report. 

If the report criteria include many terminals, the 
Report Manager may show an excessive number of 
error messages. In such cases place a check mark in the 
Disable Error Messages check-box before clicking the 
View button.  is will temporarily disable the display 
of error messages for ALL reports.

To view error messages, remove the check mark before 
viewing the next report.

  

 e Reports Manager off ers additional controls for 
some report types.  ese controls allow you to select 
criteria to further reĕ ne the output of the report.

- 

Cassette Close and Day Close reports require addition-
al controls to select the type of close data for viewing. 
Select either, (Trial Close or Close), and either (Most 
Recent Record or All Records). 

  -  



Triton Connect enables the user to produce detailed reports based on the parameter, journal, and close data ob-
tained from your terminals. In this chapter, we’ll show how to access and view reports.
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 e Reports Manager main window shown below.

Click Close to generate a report based on ĕ nal close 
data.

Click Trial Close to generate a report based on trial 
close data.

Click Most Recent Record to generate a report based on 
the most recent close data for each terminal.

Click All Records to generate a report based on all 
available close data for each terminal.

    

By default, the Reports Manager generates reports 
from the data stored in the terminal database.  is 
data accumulates from contacting all terminals. Avail-
able controls for each report type allows for report 
customization. Most of these controls do not allow the 
user to produce reports for speciĕ c terminals.

To generate reports for speciĕ c terminals, establish a 
ĕ lter using the Filters function of the Terminal Man-
ager. Enable the ĕ lter before choosing and viewing a 
report.  e Reports Manager will display the selected 
report using only the data from the terminals that ĕ t 
the ĕ lter criteria.

-   

 e Journal Data, Journals Downloaded, Journals Not 
Downloaded, Most Common Status Messages, Termi-
nal Down Time, and Terminal Status Messages reports 
provide a calendar-based date-range selector, as shown 
below.

 e Start Date and End Date list boxes become active 
when the user selects the Journal Data report. 

**Note**
Not all selected reports will active the Start Date and 
End Date list boxes.

By default, the starting and ending dates for the report 
are automatically set to the current day, which selects 
for the most recent one-day range of journal activity.

Specify a start date by selecting a month and year using 
the Start Date drop-down lists. Click the day of the 
month and the day becomes highlighted.  is selects 
the day/month/year as the new starting date.

Specify an end date by select a month and year using 
the End Date drop-down lists. Click the day of the 
month and the day becomes highlighted.  is selects 
the day/month/year as the new end date.

Click the Select All command button to view all jour-
nal data in the database.
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 

 e Terminal Status report requires additional con-
trols to further reĕ ne the data returned by the Reports 
Manager.

Select the Terminal Status report and the window pro-
vides additional Report Details controls as shown. 

Click All Terminals to generate a Terminal Status re-
port using all terminals in the database.

Click Any Terminal Error to generate a Terminal Status 
report using only those terminals currently experienc-
ing some sort of error condition.

Click Terminals Reporting Low Cash to generate a Ter-
minal Status report using only those terminals report-
ing a low cash condition.

Click Speciĕ c Terminal Error # to generate a status re-
port for terminals that are experiencing a speciĕ c type 
of error, select this option and enter the error number. 
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 e Report Viewer screen displays the generated report.

Printer Button

 e Printer button prints the report to the default 
printer used by the PC.

Envelope Button

 e Envelope button exports the on-screen report into 
another format or application. 

Lightning Button

 e Lightning Bolt button refreshes the data on screen 
with the latest information from the databases.

Tree Button

 e Tree button toggles from Preview to Report Only 
and back again.  e Preview displays every report 
requiring more than one line of entry for any terminal. 
Selecting the Terminal ID from the Preview section 
jumps to the data in the report regarding that terminal.

Percentage of View

 e Percentage of View drop-down changes the size 
of the page viewed in the report window.

Navigation Control

 e Navigation Control allows the user to move from 
one page to the next, forward and backward. Type a 
page number in the text box to jump directly to the 
page. 

Search Button

Type the text or values in the search box, and click the 
Find Next button to Search or click the Cancel button 
to exit the Search mode.

 
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  

 e Call Failures Report provides a listing of all ter-
minals that Triton Connect failed to reach a er ĕ ve 
attempts from the scheduled Call List.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.
 
Time to Call -  e last scheduled call date and time 
that Triton Connect failed to contact the terminal.

Interval -  e interval represents the amount of time 
between the last failed attempt and the next attempt 
to contact the terminal.  Interval equals Hours, Days, 
Week, or Months.

Count -  e number of Intervals needed to pass before 
Triton Connect attempts to contact the terminal.

Tries -  e number of attempts to contact the indicat-
ed terminal. Triton Connect will make ĕ ve attempts to 
reach a terminal before reporting a call failure. 

Called - Identiĕ es if Triton Connect successfully con-
tacted the terminal. 

Total Failed Calls -  e total number of failed call 
entries in the report.

  

 e Call List Report provides information on the cur-
rently scheduled and persistently scheduled calls in the 
active Call List.  e report also provides a list of com-
mands the call will perform, the next scheduled time 
to call, and whether or not that attempt has been made.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database. 

Phone Number -  e phone number or TCP/IP ad-
dress Triton Connect will use to contact the terminal.

Commands - Triton Connect will request speciĕ c 
parameters from the terminal.  e table below displays 
the command list.



Call Summary (Case Sensitive)

J Journal Data

a All Journal Data

x X-entries Journal Data

P Parameters

p Selected Parameters

T Synchronize Date/Time

E Error Status

B Coupon Data

Time Contacted -  e actual date and time Triton 
Connect successfully contacted the terminal.

Int -  e Interval between attempted calls; h=hours, 
d=days, m=months, or y=years.

Amt -  e number of Intervals (Int) Triton Connect 
waits before attempting to call the terminal, again.

Time To Call -  e scheduled date and time Triton 
Connect will attempt to contact the terminal.

Called - States whether Triton Connect completed the 
call successfully, Yes or No.
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 e Cassette Close Report provides information sum-
marizing the most current ĕ nancial transactions, 
involving an indicated cassette, performed by the 
indicated terminal. Typically, this summary covers the 
period of time since the last Cassette Close operation 
performed on the terminal.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.
 
Date -  e date represents the last time the terminal 
performed the Cassette Close operation.

Contact Time -  is time represents the last time the 
terminal uploads the close information.

Cassette ID - Identiĕ cation for the cassette(s) installed 
in the ATM. For single-cassette ATMs, the ID is simply 
‘Single’. An alpha code designation in the series ‘A’, ‘B’, 
‘C’, or ‘D’, represents the cassette ID of a multi-cassette 
ATM, depending upon how many cassettes installed in 
the unit.

Bill Size -  e denomination of the currency loaded in 
the designated cassette.

Transactions -  is represents the total number of 
withdrawal transactions involving the designated cas-
sette since the last Cassette Close operation. 

Reject Events -  e number of times currency routed 
to the reject cassette or vault in the terminal instead of 
dispensing to the customer. Rejects occur for a several 
reasons, such as poor note quality, currency not loaded 
correctly in the cassette, or machine error.

Quantity - Number of bills in the cassette applicable to 
the Start, Dispensed, and Remaining headings.

Amount - Total value of the currency in the cassette 
applicable to the Start, Dispensed, and Remaining 
headings.

Start -  e Quantity heading displays the number 
of bills in the cassette a er the completion of the last 
Cassette Close operation.  e Amount heading displays 
the total value of the currency in the cassette a er the 
completion of the last Cassette Close operation. 
 e Quantity and Amount numbers will change to 
include the restocking of cash into the cassettes.

Dispensed - Under the Quantity heading, the number 
of notes dispensed including rejected notes since the 
last Cassette Close.  e Amount heading displays the 
total cash value dispensed including rejects since the 
last Cassette Close.

Remaining -  e Quantity heading displays the num-
ber of notes remaining in the cassette when the close 
operation take place.  e Amount heading displays 
the total cash value remaining in the cassette when the 
close operation takes place.

**Note**
Due to changes in ATM so ware version 4.2.2 and 
later, use Triton Connect version 6.2 to correctly reĘ ect 
the Day Close settlement amount and Cassette Close 
multiple amounts properly in the journal.  Earlier ver-
sions will show N/A for these ĕ elds.

  
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 e Cassette Status Report provides information on the 
cassette as of last contact with the terminal.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.
 
Terminal Location -  e terminal location description 
initially entered into the database.  is is usually the 
name of the store or other location where the terminal 
is installed.

Date/Time -  e ĕ eld indicates when the ATM last 
communicated with Triton Connect.

Cassette ID - Identiĕ cation for the cassette(s) installed 
in the ATM.

Bill Size -  e denomination of the currency loaded in 
the designated cassette.

Reject Events -  e number of times currency autho-
rized for dispense to the customer, but re-routes to the 
reject cassette or vault in the terminal. 

Cash Loaded - Amount of cash loaded in the cassette 
during restock.

Cash Dispensed - Amount of cash dispensed since the 
last cassette close.

Cash Remaining - Cash remaining in the cassette.

Totals -  is displays the cumulative totals for all cas-
settes in the indicated terminals.

  

 e Cassette Status parameters summarizes the de-
scriptions providing additional details in the previous 
section, which covered the Cassette Close Report. See 
that section for more information on the following 
parameters.

• Terminal ID
• Cassette ID
• Reject Events
• Cash Loaded (See description of the Start parame-

ter)
• Cash Dispensed (See description of the Dispensed 

parameter)
• Cash Remaining (see description of the Remaining 

parameter)

  
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 

 e Check Digits Report displays a management report that shows the check digits string associated with the 
currently loaded Master and Working keys.

Terminal ID -  e name used to identify the terminal initially entered into the Triton Connect database. 

Master Check Digits -  e string veriĕ es the PIN Master keys when added to the keys to the terminal.

Comm Check Digits -  e string veriĕ es the PIN Working keys when sent by the Host processor.

Last Contacted -  e date and time Triton Connect last contacted the terminal.

   

 e Check Digits Triple DES displays a management report that shows the check digits strings associated with the 
currently loaded Master and Working keys for Triple DES encryption.

Terminal ID -  e name used to identify the terminal initially entered into the Triton Connect database.

PIN Master Key Le /Right -  e strings verify the PIN Master keys when added to the terminal.

MAC Master Key Le /Right -  e strings verify the MAC Master keys when added to the terminal.

PIN Working Key Le /Right -  e strings verify the PIN Working keys when sent by the Host processor.

MAC Working Key -  e strings verify the MAC Working keys when sent by the Host processor. 

Last Contacted -  e date and time Triton Connect last contacted the terminal.
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 e Coupon Report provides information summariz-
ing the types and numbers of coupons printed by the 
indicated terminal. Typically, this summary covers the 
period of time since the beginning operation of the 
terminal.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.
 
.TCC File - Name and location of the coupon ĕ le as-
sociated with the coupon graphic ĕ les listed under the 
Coupon heading.

Total Coupons Printed - Total number of coupons 
printed since the beginning operation of the terminal.

Coupon - File name of a Receipt Graphic ĕ le.

Number Printed - Total number of a Receipt Graphic 
printed since the beginning operation of the terminal.

 
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 e Day Close Report provides information summariz-
ing the most current ĕ nancial transactions performed 
by the indicated terminal. Typically, this summary 
covers the period of time since the last performed Day 
Close operation.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.
 
Transaction Date - Day Close operation performed on 
this date.

Transaction Time -  e time the terminal sends the 
close information.

Business Date - Business closing date for which the 
current Day Close operation is applicable.

Host - Total number of transactions of each type and 
a ĕ nal Settlement value for those transactions record-
ed by the Host processor for Withdrawals, Inquiries, 
Transfers and Settlement values.

Terminal - Total number of transactions of each type 
and a ĕ nal Settlement value for those transactions 
recorded by the terminal for Withdrawals, Inquiries, 
Transfers and Settlement values.

Withdrawals -  e total number of withdrawals from 
the terminal including rejects since the last Day Close 
operation, as reported by the terminal and the Host.

Inquiries - Number of balance inquiries performed 
since the last Day Close, as reported by the terminal 
and the Host.

Transfers - Number of account transfer transactions 
performed by the terminal since the last Day Close 
operation, as reported by the terminal and the Host.

Settlement - Total monetary amount of all transac-
tions performed since the last Day Close, as reported 
by the terminal and the Host.

Host Totals -  e report displays the word Received, if 
data received from the Host or will leaves it blank.
 

  

 e Denied Transaction Report provides the number of 
terminal transactions (of any type) denied by the Host 
Processor since the last Day Close operation.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.
 
Last Contacted Date/Time -  e date and time the 
terminal sends the Journal data. 

Number of Denied Transactions -  e number of 
terminal transactions of any type denied by the Host 
Processor since the last Day Close operation.

Total Number of Denied Transactions -  e total 
number of transactions for all terminals shown in the 
report denied by the Host Processor since the last Day 
Close operation.

  
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   

 e Down Time Per Error report shows a terminal’s 
detected error and how long it took to clear.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Error - List of error codes and description detected by 
the terminal.

Down Time - In hours, minutes, and seconds, this fea-
ture records the amount of time from error detection 
to error cleared.

 

 e EMV Data report shows the available options 
enabled for the terminals EMV card reader.

TID -  e name used to identify the terminal initially 
entered into the Triton Connect database.

EMV Enabled -  is option enables the EMV card 
reader to read the card’s integrated data chip.

Allow Magstripe - With the EMV Processing enabled, 
this option allows the terminal to process magnetic 
stripe-only transactions.

Allow Magstripe Fallback - With the EMV Processing 
enabled, this option allows the terminal to process a 
card as a magnetic stripe transaction if the IC on the 
card fails.

Latch ICC - With the EMV Processing enabled, this 
option enables latching in the EMV card reader.

Store in Journal -  is option directs the terminal to 
record extra data received during an EMV transaction 
to the journal for disputed resolutions.

Application Enabled -  e list shows the EMV Aids 
enabled on the ATM.

  

 e ISO Numbers report displays the ISO Numbers 
used by the listed terminals.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

ISO Number(s) -  e ISO Numbers loaded in the 
indicated terminal.  e terminal stores up to 100 Block 
ISO numbers; however, the terminal will accept only 
ĕ ve numbers entered manually. Triton Connect man-
agement so ware allows the terminal to accept addi-
tional ISO numbers up to the 100 numbers limit.

ISO Action -  e Independent Sales Organization, or 
ISO, numbers allow the terminal to block surcharging 
and to disable surcharge messages for ĕ nancial insti-
tution’s ATM or Credit Card transactions.  is report 
shows ISO actions the ATM will take.

ISO Value -  e assign value to a speciĕ c ISO number

See the applicable terminal operations manual for ad-
ditional information on the Block ISO feature.
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 e Journal Data Report provides a concise list of ter-
minal activities, including customer transactions and 
machine-speciĕ c events and operations.

**Note**
 e following note appears on the Report Manager 
screen: Surcharges on Unsuccessful transactions will not 
appear in the Journal Data Report.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Rec # -  e Record Number counter increments a er 
each transaction, machine operation or any other 
event tracked by the journal function of the terminal.

Date -  e date the speciĕ ed event took place.

Time -  e time of day the speciĕ ed event took place.

Sequence Number -  e Sequence Number counter 
increments a er each transaction performed by the 

terminal; such as, withdrawal, transfer, or balance 
inquiry. Some versions of terminal so ware allow the 
manual reset of the Sequence Number to zero.

Transaction Type - A short description of the speciĕ c 
type of customer transaction performed at the indicat-
ed date and time, if applicable. 

Journal Entry -  is column indicates the general type 
of event which took place at the speciĕ ed date and 
time.  e word “Transaction” refers to each customer 
transaction. Short, descriptive terms describe other 
machine operations and events, such as “Reset” in the 
case of an operation that re-initializes the terminal 
hardware and so ware. 

Primary Account # - A sequence of numbers that typ-
ically consists of a combination of the Bank Identiĕ ca-
tion Number and customer account number associated 
with the ATM, debit, or credit card used to make the 
transaction. Enable “Suppress Account Numbers” to 
show only the last four (4) digits.

# of Surcharges -  e number of surcharges assessed 
for a cash transaction.

Surcharge Amount -  e surcharge fee assessed for a 
cash withdrawal transaction, if any.

Amount Dispensed -  e amount of cash dispensed to 
the customer during a withdrawal-type transaction. 

     
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Totals -  ese amounts represent the sum of all Sur-
charge Amount and Amount Dispensed values related 
to the speciĕ c terminal.

Grand Totals -  ese amounts represent the sum of 
all Surcharge Amount and Amount Dispensed values 
related to all the terminals shown in the Journal Data 
Report.

    

 e Journal Downloaded report provides information 
on the ĕ rst and most recent journals received.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Earliest Time Received -  e date and time the jour-
nal ĕ rst downloaded. 

Latest Time Received -  e date and time the journal 
last downloaded.

     

 e Journal Not Downloaded report provides a list of 
terminals for which no journals downloaded within 
the speciĕ ed date range.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Earliest Time Received -  e date and time the jour-
nal not ĕ rst downloaded. 

Latest Time Received -  e date and time the journal 
not last downloaded.

   

 e Most Common Status Messages report lists all the 
status message received over a speciĕ ed time interval, 
listed in order of greatest number of occurrences. As a 
management tool, this report helps the user to pin-
point problem areas.

Status Messages Reported From - Shows the time 
interval which the status messages in the report oc-
curred.

Number of Occurrences -  e number of times the 
Status Message code occurred.  e list presents the 
most common status message at the top of the list, fol-
lowed by the next most common status message, and 
so on for all status messages logged over the speciĕ ed 
time frame.

Status Message - Displays a code with a short descrip-
tion of the terminal’s status.

Total Number of Status Messages -  e total number 
of all status messages received over the time interval 
shown in the Status Messages Reported From block.

  

 e Scheduled Close Report provides information on 
the Scheduled Day Close setup of each terminal.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Scheduled Close Time -  e time the terminal will 
perform a scheduled Day Close.
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Last Contacted -  e date and time Triton Connect 
last contacted the terminal to perform a scheduled Day 
Close.

  

 e Terminal Conĕ guration Report provides infor-
mation about each terminal entered in the Terminal 
Manager.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.
 
Location -  e data entered into the Triton Connect 
terminal database that describes the name of the store 
or other location where the physical terminal resides.
 
Address -  e data initially entered into the Triton 
Connect terminal database that describes the physical 
location of the terminal, such as the street address, city, 
state and zip code of the store or other location.
 
Phone Number -  is entry will include the contact 
phone number for dial-up terminals, or a TCP/IP 
address for Ethernet or wireless terminals. For more 
information, see Chapter 4, Call Monitor Connection 
Type.

    

 e Terminal Down Time Report logs the number of 
down time hours for each terminal during a speciĕ ed 
time range.

Down Time From - Shows the time frame of the mon-
itored terminals listed in the report.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Down Time (In Hours) - Displays the number of 
Down Time hours for the indicated terminal.

Total Down Time - Total number of down time hours 
logged during the speciĕ ed time frame, for all the ter-
minals listed in the report.

 

 e Terminal Files report only applies to Z180 ATM’s 
though (9100/9600/9700). It is basically a list of ĕ les 
(ad graphics, plug-ins, etc.) stored on the terminal 
Ę ash.

  

 e Terminal Status Report provides information on 
the status of the terminal as of the last contacted date 
and time. 

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Location -  e data entered into the Triton Connect 
terminal database that describes the name of the store 
or other location where the physical terminal resides.
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Date/Time -  e date and time Triton Connect last 
contacted the terminal and downloaded the error 
status data. 

Error Description -  e most recent error codes and 
descriptions shown for the indicated terminal. 

   

 e Terminal Status Messages Report lists the type and 
number of status messages received from speciĕ ed 
terminals over a user-deĕ ned time frame. 

Status Messages Reported From -  e time range of 
the data collected for this report.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Date -  e date and time Triton Connect received the 
indicated terminal’s status message.

Status Message -  e code number and a short de-
scription of the terminal’s status at the date/time 
received.

Total Number of Status Messages - Shows the total 
number of status messages in the report.

  

 e Terminal Text Messages report provides a list of 
information presented to the customer before, during, 
or a er their transaction.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Message Type - Messages displayed on the Terminal 
screen, printed receipt, or coupon.

Message - Speciĕ c information provided to the cus-
tomer depending on the message type.

  

 e Terminal Totals Report provides ĕ nancial infor-
mation accumulated from Day Close to Day Close as 
of the last contacted date and time. If the user does not 
perform Day Closes, the report will show the cumula-
tive totals.

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Debits -  e number of checking and savings account 
withdrawal transactions collected since the last Day 
Close operation.

Credits -  e number of credit card withdrawal trans-
actions performed since the last operation of a Day 
Close.
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Inquiries -  e number of balance inquiries per-
formed by the terminal since the last Day Close opera-
tion. 

Transfers -  is is the number of account transfer 
transactions performed by the terminal since the last 
Day Close operation was performed.

Debit Amount - Total monetary value of all Debit 
transactions that have taken place.

Credit Amount - Total monetary value of all Credit 
transactions that have taken place.

Totals - Total of all values for all terminals listed in the 
Terminal Totals Report.

  

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Last Contacted -  e date and time Triton Connect 
last contacted the terminal to perform a scheduled Day 
Close. 

Call Back - If enabled, Triton Connect will disconnect 
and wait for the terminal to call back via the Primary 
phone number or TCP/IP address. If the Primary does 
not connect, the terminal will use the Backup number 
or address.

Primary -  e Primary phone number or TCP/IP 
address to Triton Connect and Alarm.

Backup -  e Backup phone number or TCP/IP ad-
dress to Triton Connect and Alarm.

Terminal Count -  e total number of terminals listed 
on this report.

  

 e Version Numbers Report provides information on 
hardware versions for all terminals reporting informa-
tion to Triton Connect. 

Terminal ID -  e name used to identify the terminal 
initially entered into the Triton Connect database.

Model # -  e assigned model number of the indicated 
terminal.

EPROM Version # -  e EPROM holds so ware 
downloading, initialization, testing, and low-level 
interface routines.  e version number assigned to the 
EPROM chip currently installed in the terminal.

Program Version # -  e version number assigned 
to the so ware currently loaded in the terminal.  e 
terminal operating so ware downloaded either locally 
or remotely via Triton Connect.

Table/Screen Version # -  e version number assigned 
to the so ware component that provides ATM user 
interface and associated terminal control functionality.  
X-Scale terminals have Screen ĕ le, While X2 and X3 
have Table Files. Both ĕ les serve the same purpose. 

Printer Version # -  e version number assigned to 
the Printer. Availability of this data depends upon the 
version of ATM so ware running in the terminal.

SPED Version # -  e version number assigned to the 
SPED ĕ rmware. Availability of this data depends upon 
the version of ATM so ware running in the terminal.

Dispenser Version # -  e version number assigned to 
the Dispenser. Availability of this data depends upon 
the version of ATM so ware running in the terminal.

Total Number of Terminals -  e total number of 
terminals listed on the Version Numbers Report.

E  C
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  -  



A Triton Connect feature performs remote so ware downloads to terminals. In this chapter, we’ll show you how 
to access this function.

    


Follow these steps to access the So ware Download 
function.

1. Using the Supervisor Password, Navigate to the 
Terminal Manager > Utilities > So ware Download. 
 e Load Terminal So ware screen appears.

 

 e Load Terminal So ware screen displays similar in 
the overall appearance to other terminal data screens 
in Triton Connect. Most of the data ĕ elds serve only 
to help identify and locate the desired terminal.  e 
Terminal ID list provides a quick way to select a termi-
nal. If the list contains many terminals, use the Search 
or Filter features to locate a terminal or reduce the 
number of terminals displayed in the list.

Follow these steps to initiate a so ware download.

1. Select the ID of the terminal you want to load with 
so ware. If applicable, select the Broadcast option 
to select multiple terminals.

2. Click the Select File button and use the ĕ le brows-
er window to locate the correct download ĕ le for 
the ATM.

3. Choose the appropriate download options, as ap-
plicable.

4. Click the Send File button. When the call sched-
uling window appears, schedule a time for the 
download and click the OK button.

  

Select the Send option to schedule a so ware down-
load. Unless the database has the Access Code and 
if the terminal operates with Z-180 version 5.0 ATM 
so ware or greater, the program will prompt the user 
to enter the terminal’s EPROM Access Code.
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    

Above the Send File button on the Load Terminal So -
ware screen list three download options to change the 
way the download normally performs. 

  

 e Terminal’s EPROM stores Parameters, specify op-
erational conditions, and provide necessary operating 
information for the terminal.

During initial so ware load at the factory, production 
loads the terminals with default parameter values.  e 
user modiĕ es these values during the installation of the 
terminal, to ĕ t speciĕ c operational requirements.

Caution

With this option checked, the values contained in the 
so ware load ĕ le will erase the terminal’s existing pa-
rameters.  e terminal will need a site-speciĕ c conĕ g-
uration, including re-enabling Triton Connect.

  

If the terminal previously sent its parameters for 
storage in the database, Triton Connect automatically 
chooses the correct so ware download type.

If the terminal operates with a Z-180 version 5.0 so -
ware or greater, Triton Connect will attempt an unat-
tended remote download.

    

 is option speciĕ es the erasure of the terminal’s 
EEPROM prior to loading the parameters contained 
in the so ware load ĕ le. Check the Include EEPROM 
Parameters option to activate this option.

Caution

Erasing the EEPROM will disable the ATM and re-
quire the terminal’s reconĕ guration at the ATM site 
before operations can resume.

  

If an unsuccessful attempt to download the so ware 
to a terminal operating Z-180 version 5.0 so ware or 
greater, check the Force Tricomm Download option 
to force a download using the Tricomm protocol.  is 
type of download will require the assistance of support 
personnel at the terminal location.

**Note**
Terminal’s with TCP/IP connection type will not allow 
a Forced Tricomm download and will display an error 
message.

 

Use Tricomm, a separately available PC-based utility, 
to load terminal so ware. It typically resides on a PC 
or laptop computer near the terminal location and 
physically connected to the terminal by a serial cable 
(8-bit machines).

Tricomm-type downloads require the EPROM Access 
Code entered at the terminal. With access granted, use 
the special menu to conĕ gure the terminal to accept 
the so ware download.

For instructions on performing this type of down-
load, see the operating instructions that came with the 
Tricomm utility or the ATM service manual.
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  

For Load File Formats, refer to the table below.

EEE value EEE meaning

tlf XScale

tlv X2 CE 5

tr6 X2 CE 6

tr7 X3 CE 7

    

Navigate to the Terminal Manager > Utilities > So -
ware Download.

Click the Select File button.  e application will dis-
play an Open Load File dialog box.  e ĕ le type dis-
played will depend on the Terminal ID selected. As an 
example, if the application identiĕ es the terminal as an 
X2 terminal, the Open Load File screen displays load 
ĕ les with the .TLV or TR6 ĕ le extension.

If the version information identiĕ es the terminal as an 
XScale or Z-180, the dialog will display the ĕ le formats
with the .TLF extension. 

**Note**
If the database does not have the selected terminal’s 
parameters, the system will display a message prompt-
ing the user to download parameters for the selected 
X2 terminal.

  

Select a load ĕ le with a tlf, tfv, tr6, or tr7 extension 
and press the Open button.  e application will start 
the ĕ le validation process and if it identiĕ es a valid tlf, 
tfv, tr6, or tr7 load ĕ le, the Open Load File dialog box 
will close and display the So ware Download dialog 
screen. 

 e application will display an error message for invalid 
load ĕ le.

Acknowledge the error by pressing the OK button and 
the screen returns to the So ware Download dialog 
screen.

E  C
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 is Applies to ALL ATMs except the Z180 ATM Series.

For the Z180 Series go to next page.
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**Note**
 e ĕ lename of the image must be no longer than eight 
characters (not including the period and ĕ le name 
extension).

   

 e Ad Designer will not allow images larger than 320-
by-240 pixels. If the user forgets the maximum size, 
click the Help option on the menu bar and the screen 
below opens.

 is message box also shows the allowable color-depth 
values allowed for Ad Screen images: 16-color or 
256-color.

  -  

**N**
T A D   Z ATM  .



 e Ad Designer combines bit-mapped graphics and text together to create Ad Screens for non-PC based units. 
Download these Ad Screens for display on selected terminals via Triton Connect. 

 e Ad Designer editing utility imports and manipulates bit-mapped graphics (BMP format) to create Graphic Ad 
Screens. Additional tools enable the merging of text with bit-mapped images or creation of text-only Ad Screens.

**Note**
Terminals equipped with one or more Expansion Memory modules (96XX) can download Graphic Ad Screens. 
Text-only Ad Screens do not require additional storage memory.

Navigate to Terminal Manager > Utility > Ad Designer.

  

 e Ad Designer can only import and manipulate bit-
mapped graphic images. It cannot create them. Use a 
third-party graphics application to create the graphic 
images for use as Ad Screens. 

In creating your graphics, ensure the images conform 
to the following requirements.

•  e images will use either 16-color or 256-color.
•  e maximum image size limited to 320 pixels 

wide by 240 pixels high.  e maximum size rep-
resents the dimensions of the terminal’s LCD 
display screen.

 e Windows Paint application creates bitmap ĕ les in 
a generic format fully compatible with the Ad Screen 
capabilities of the terminal. If the user uses another 
graphics program to create the bitmap images, Tri-
ton recommends opening and re-save the ĕ le using 
Windows Paint before processing the ĕ le with the Ad 
Designer to ensure maximum compatibility with the 
terminal.
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Triton Connect will not transfer ĕ les to a terminal if 
those ĕ les have names that contain non-alphanumer-
ic characters. Use only the characters A-Z (upper or 
lowercase) and the numbers 0-9. Any other characters 
will prevent Triton Connect from downloading the 
graphics to the terminal. Only the display schedule 
will be sent, resulting in the display of blank screens 
on the terminal at scheduled times.

   

Follow this step to access the Ad Designer.

Navigate to the Terminal Manager > Utilities > Ad 
Designer option and the screen opens below.

  

 is section provides a brief outline of the functions 
of the Ad Designer.



 e primary options available through the menu bar 
allow the user to open and save graphics ĕ les, place 
graphic images within the display area, clear the 
display area, and set the Ad Screen display duration of 
how long the terminal screen displays the Ad Screen.

Additional options enable the user to see the color 
depth (16-color or 256-color) of the image viewed in 
the display window, to view various help displays, and 
to restore warning messages.

 .   

Graphics Ad Screens will take priority over text-based 
screens. Terminals equipped with one or more option-
al Expansion Memory Modules and run Graphics Ad 
Screens, will not display text-based screens.

Terminals with no Graphics Ad Screens loaded, or the 
Ad Screen function turned off , will display Text Ad 
Screens, if loaded.

 is behavior allows the user to design both graph-
ic and text versions of Ad Screens, to broadcast to 
a group of terminals.  ose terminals that support 
graphics will automatically display the graphics ver-
sions of the Ads, while terminals not equipped (or not 
enabled) to display graphics Ads will automatically 
display the text-based versions.

 

 e Ad Designer manipulates Ad Screen contents, 
graphic and text entities, as discrete “objects.”  is 
gives the user the ability to select individual compo-
nents of an Ad Screen for various editing operations.

 e Display Window provides a location to compose 
the Ad Screen. Place both text and graphic elements 
within the display area and position them as needed to 
create the ĕ nal Ad Screen composition.
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 e text-entry block below the display window allows 
the user to add any textual words or phrases to an ex-
isting graphic or to create a text-only Ad Screen.

 e Redraw Screen button refreshes the display as 
needed during editing operations.

 e Text Display Options enhances the Ad Screen text 
within the display.

 e options include the following:

• Reverse. Checking this option reverses the fore-
ground and background color selections in the text 
object.

• Transparent. Checking this option, places the text 
directly on a BMP graphic without erasing the im-
age behind the text.  e text will appear to “Ę oat” 
over the underlying image.

• Foreground Color.  e color box next to the button 
displays the current font color. To select a diff er-
ent color, click the Foreground Color button and 
select a color from the pallet of sixteen colors.  e 
new color will apply to the next text entry. 

• Background Color.  e color box next to the button 
displays the current background color. To select a 
diff erent color, click the Background Color button 
and select a color from a color pallet of sixteen col-
ors.  e new color will apply to the next text entry. 

• Font Size. Click the down arrow in the list box and 
select a font size; Small, Medium, or Large.

 

Because the Text Display Options provide only a basic 
set of conĕ guration settings, consider using a separate 
graphics application to add text directly to your Ad 
Screen bitmaps. 

Most commercial graphics programs contain many 
typeface and font size options, and off ering a wider 
range of creative choices in the creation of your Ad 
Screens.
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   

Follow the procedures below to create an Ad Screen.

1. Click the Place BMP option on the Menu Bar. Nav-
igate to the folder containing the screen ĕ les. 

2. Select the BMP graphic by either double clicking 
on the desired BMP ĕ le name, or click on the ĕ le 
name to highlight it and then click the Open but-
ton.

 e Ad Designer will evaluate the “color depth” of the 
image and will present one of two warning messages. 

     

 e warning messages have a means of turning off  the 
messages, so the appearance of these screens does not 
interrupt subsequent operations.

Click the check box to turn off  the display of that  
warning screen. 

Select Help on the menu bar and click Enable Messages 
to turn all currently disabled warning messages back 
on.

 - :

 is warning screen gives the user the option to 
proceed with the selection of the 16-color bitmap 
image, or return to the ĕ le-selection dialog and select a 
256-color bitmap image.

If the terminal has a 16-color display, only a 16-color 
Ad Screen will work in this terminal, in which case, the 
user should click the DON’T SELECT 256-color BMP 
button.  e selected image will appear in the display 
area.

However, if the terminal uses a 256-color display, you 
may also wish to select another, 256-color image.  is 
may be a version of the ĕ rst, 16-color image, or a com-
pletely diff erent image. In this case, click the SELECT 
256-color BMP button. You will be presented with the 
ĕ le selection dialog, which will allow you to choose a 
256-color image. Both images will be loaded into the 
display area.  e ĕ rst image (16-color) will be visible, 
while the second image (256-color) will be hidden. You 
can switch between images using the Window option 
on the menu bar.

Of course, a 256-color display can also display a 
16-color image (although there will be no improve-
ment in the image), so if the terminal uses a 256-color 
display either 16-color or 256-color images may be 
used.
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 - :

 is warning screen the gives the user the option of 
proceeding with the selection of the 256-color bitmap 
image, or of opting to return to the ĕ le-selection dialog 
to select a 16-color bitmap image.

If the terminal has a 256-color display, choose the 
DON’T SELECT 16-color BMP button to proceed 
with the operation.  e selected image will appear in 
the display area.

If the terminal uses a 16-color display, only a 16-color 
image will work in this terminal. In this case, choose 
the SELECT 16-color BMP button. You will then be 
presented with the ĕ le selection dialog, which will 
allow you to locate and select a 16-color image. Both 
images will be loaded into the display area. Use the 
Window option to select the image you wish to work 
on.

  -  - 


To determine the color depth of the image visible in 
the display area, select the Window option from the 
menu bar.

A check mark will appear next to the type of image dis-
played. If the display area has a second image, click the 
appropriate image type to view it.

3.  e BMP graphic will appear in the display area. 
To move the graphic, click on the image while 
holding down the le  mouse button and drag the 
graphic to the desired location. Note how the im-
age is replaced by a black bounding-box during the 
dragging operation.

4. To place text with the graphic, type the text into 
the text box.

- 

 e text entered does not wrap. Each line of 
text must be entered individually.

Using Small/Medium font selection, approxi-
mately 30 characters will ĕ t on one line; using 
large font, approximately 20 characters. Ten to 
ĕ  een lines of text will ĕ t vertically within the 
image display window, depending on the font 
size.

5. Next, use the Text Display Options to change the 
text characteristics as needed. 

6. Move the mouse cursor to a location in the Display 
area where the text will appear on the Ad Screen 
and click the le  mouse button.  e ĕ rst-time text 
is added to the image the following warning mes-
sage will appear.
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 e screen off ers a caution concerning the display of 
text on terminals with 256-color displays will not dis-
play correctly.

    - 

To avoid text display problems on 256-color displays, 
use a graphics application to add text directly to your 
Ad Screen bitmaps, also, create a 16-color Ad Screens 
with text in this way.

An advantage of this technique is that most commer-
cial graphics programs enable you to select from many 
typeface and font size options, off ering a wider range 
of creative choices in the creation of your Ad Screens.

Text and 16-color graphics combined in the Ad De-
signer will display on 16-color terminals correctly.

Click the OK button.  e text appears on the screen. 
To move the text place the cursor over the text. Click 
and hold the le  mouse button. Drag the text to the 
desired location and release.

Add additional text objects to the Ad Screen by re-
peating Steps 4-6. Can add up to 28 text objects to the 
bitmap, or place in a text-only Ad Screen.

 -  

To create text-only Ad Screens, simply place 
the text you want in the display area and save 
the image (see Step 9).

 e process creates a .TCG ĕ le containing the 
text of the Ad Screen.

7. To delete the graphic or a text object, place the 
mouse cursor on the item and click the right 
mouse button. A conĕ rmation box will open. 

 e object receives a number upon its creation.  e 
bitmap image receives object number 1 by default. Text 
objects receive numbers from 2 to 29. 

To delete the selected object, click the OK button; 
otherwise, click the Cancel button and return to the 
display area window.

8. Select the Display Duration option from the menu 
bar

Choose a display duration for the Ad Screen. Termi-
nal will display the Ad on its screen for the number of 
seconds selected. Ad Screens will repeatedly display on 
the terminal screen using a “looping” system.



Triton Systems ©204

9. Upon completion of the Ad Screen graphic, save it 
by selecting the File option on the menu bar, and 
click Save As.

Name the ĕ le and click the OK button.  e so ware 
creates a Triton Connect Graphic (TCG) ĕ le format.

**Note**
A warning message opens for ĕ lenames greater than 
eight characters. Click the OK button.  e Save As 
screen opens with the ĕ rst eight characters highlighted. 
Accept the highlighted name or change the name with 
the limit of eight characters.

 
Use the Ad Graphics/File Manager tab in the Terminal 
Parameters area to download the Ads created in the Ad 
Designer.

Caution

Do not move, rename, or otherwise alter the original 
bitmap ĕ le created in the Ad Screen or Triton Connect 
cannot download the ĕ le to the terminal!

  

 e .TCG ĕ le holds information about the layout, con-
tents, and characteristics of an Ad Screen.

1.  e .TCG ĕ le contains text added to the Ad Screen 
image, including all text-formatting information.

2.  e .TCG ĕ le contains a pointer to the original bit-
map image used in the creation of the Ad Screen. 

3. The .TCG fi le contains the display duration param-
eter.

 

Graphics are displayed in designated ĕ elds in the 
display. Optimize display graphics by creating them in 
sizes that ĕ t their intended use. Graphic dimensions 
are in pixels.

-  (//) 
Full Screen - 636 X 476
Logo - 310 X 85
Transaction Ad - 636 X 260
Banner - 205 X 56
Welcome Ad - 310 X 385

• Coupon Graphic (Top or Bottom only) - 450 X 225 
(.BMP only)

• Coupon Graphic (Top and Bottom) - 320 X 160 
(.BMP only)

• Receipt Graphic - 480 X 120 (.BMP only)

  (  - /
/ (/.” ) 

5.7” Display (RL2000) 
Full Screen - 636 X 476
Welcome Ad - 322 X 475
Transaction Ad - 636 X 475
Receipt Graphic - 480 X 120 (.BMP only)

8.0” Display (RL2000) /10.4” Display
Header - 636 X 90
Welcome Ad - 310 X 385
Full Screen Ad - 636 X 476
Transaction Ad - 636 X 260
Receipt Graphic - 480 X 120 (.BMP only)

• Coupon Graphic (Top or Bottom only) - 450 X 225 
(.BMP only)

• Coupon Graphic (Top and Bottom) - 320 X 160 
(.BMP only)

• Applies for any X2 display size.
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LOGO
310 x 85

BANNER
205 x 56

WELCOME AD
310 x 385

TRANSACTION AD
636 x 260

HEADER (X2)
636 X 90

FULL SCREEN
636 x 476

E  C

G E
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  -  



 e Coupon Utility manages the graphic images and displays parameters associated with the Coupon Selection 
feature of Triton Systems ATMs.  e Coupon Selection feature available a er an ATM transaction enables the 
customer to select a coupon from a graphical menu screen.  e ATM’s receipt printer prints the selected coupon 
with a graphic image associated with it. Triton Connect downloads these bitmap images and displays the param-
eters to selected terminals. 

 e Coupon Utility imports and assigns bitmap graphics to the Coupon Selection Screen.   e Utility assigns 
individual receipt coupon graphic images up to six menus selections, and establishes the display duration of the 
Coupon Selection Screen.

**Note**
Only ATMs with supporting so ware will have the Coupon Selection feature.

  
In the ĕ nal step of the Triton Connect Coupon ĕ le creation, the process creates the .TCC ĕ le, a specially-format-
ted data ĕ le, which holds information describing the contents, displays duration of the Coupon Selection Screen, 
and contains pointers to the bitmap images of the Coupon Section Screen and Receipt Graphics.

Caution

Do not move, rename, or otherwise alter the original bitmap ĕ les associated with the .TCC ĕ le. To do so can 
prevent Triton Connect from downloading the ĕ les to the terminal.
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   

Navigate to the Terminal Manager > Utilities > Coupon 
Utility option.  e following screen opens.

  

 e Coupon Utility cannot create bitmap images: it 
can only import them. You must use a third-party 
graphics application (such as the Paint utility included 
in Microso  Windows) to initially create the images 
desired as the Coupon Selection Screen graphic and 
Receipt Graphic images. 

  

 e Coupon Selection Screen image must conform to 
these speciĕ cations.

 e image must be either 16-color or 256-color, or  
rejected.
 e image must be 320 pixels wide by 240 pixels high, 
or rejected.

 

Each Receipt Graphic image must conform to the fol-
lowing requirements

 e image must be monochrome (black and white) 
format. If the image is not monochrome, it will not be 
available for selection as a receipt graphic. 
 e image must be no larger than 380 pixels wide by 
700 pixels high. If the dimensions of the image are 
greater than these limits the image will not be available 
for selection as a receipt graphic. 

  

 is section provides a brief outline of the features of 
the coupon utility.

 e menu bar options allow the user to do the follow-
ing:.
1. File. Open and save Triton Connect Coupon 

(.TCC) ĕ les.
2. Place BMP. Place Coupon Selection Screen graph-

ics into the display area. 
3. Clear Screen. Clear the screen of the current Cou-

pon Selection Screen and Receipt Graphic selec-
tions. 

4. Remove BMP. Remove the Receipt Graphic associ-
ated with a Coupon Button. 

5. Window. See the color depth (16-color or 256-col-
or) of the Coupon Selection Screen image cur-
rently being viewed in the display window.  is 
also allows you to switch between the 16-color or 
256-color versions of the image. 
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 

1. Display Window. Where the selected Coupon Se-
lection Screen will appear. 

2. Menu buttons. Buttons 1 through 3 and buttons 
5 through 7 used to select a monochrome bitmap 
image for printing on the selected receipt coupon.

3. More/Cancel button. Represent the functions 
available to the customer at the ATM.  e More 
button allows the user to switch to the next Cou-
pon Selection Screen and set of Receipt Graphics 
menu selections.  e Cancel button returns the 
customer to the previous Coupon Selection Screen, 
or to the ATM welcome screen (if currently on the 
ĕ rst Coupon Selection Screen).

4. Display Duration. Used to select the length of Cre-
ating a Triton Connect Coupon ĕ le. 

   

Each Triton Connect Coupon (.TCC) ĕ le cre-
ated in the Coupon Utility can reference ONE 
Coupon Section Screen and up to SIX Receipt 
Graphic images. Download multiple .TCC ĕ les 
to a terminal will provide multiple Coupon 
Selection Screens to the customer.  e number 
of .TCC ĕ les/graphics stored on the terminal 
depends upon the amount of available memory 
on the selected expansion memory card.

To conserve memory for use by the Ad Graph-
ics, do not download more than two .TCC ĕ les 
per installed memory card.

For more information on downloading ĕ les to 
the terminal, see the Ad Graphics/Fill Manager 
topic in Chapter 8, Terminal Parameters.

     

Follow this procedure to create a Triton Connect Cou-
pon ĕ le:

1. Click the Place BMP selection on the Menu Bar. 
 is displays a BMP ĕ le selection window. Use it to 
locate the bitmap ĕ le desired. 

  

 e ĕ les selection window allows the user to 
locate and select Coupon Selection Screen ĕ les. 
 e selected ĕ le is automatically copied into the 
.BMP sub-folder of the Triton Connect installa-
tion folder.

2. Select the BMP graphic by either double clicking 
on the desired BMP ĕ le name, or by clicking on the 
ĕ le name to highlight it, then clicking the Open 
button. 

3.  e Coupon Utility will evaluate the color depth 
(number of colors in the image), and will present 
either of two messages, depending on whether 
image is 16-color or 256-color.

 is screen gives the user the option to proceed with 
the selection of the 16-color bitmap image, or to return 
to the ĕ le selection dialog to select a 256-color bitmap 
image. 

Take this opportunity to consider the type of terminal 
to display the image. If the terminal has a 16-color 
display, the 16-color Coupon Selection Screen is the 
only correct choice. If this is the case, click the DON’T 
SELECT 256-COLOR BMP button.  e selected im-
age will appear in the display area. 
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However, if the terminal uses a 256-color display, you 
may also wish to select another, 256-color version 
of the ĕ rst 16-color image, or a completely diff erent 
image. If this is the case, choose the select 256-color 
bmp option. You will be presented with the ĕ le selec-
tion dialog, which will allow you to choose a 256-color 
image. Both images load into the display area.  e 
display will show the ĕ rst image (16-color), and hide 
the second image (256-color). You can switch between 
images using the Window option on the Menu Bar 
(see Switching Between 16-color and 256-color Images 
section below). 

   /

 e warning messages that appear when graph-
ics or text are selected can be turned off , so 
subsequent operations are not interrupted by 
the appearance of these screens. 

A check box appears at the bottom of each 
screen.  is option allows the user to turn off  
the display of the warning screen. Click the 
check box to enable.

**Note**
To turn all currently disabled warning messag-
es back on, close the Coupon Utility. On the 
Terminal manager screen, navigate Utility > 
Ad Designer > Help option. Click on the Enable 
Messages option.

  -  
- 

To determine the color depth of the image 
visible in the display area, select the Window 
option from the menu bar:

A check mark will appear next to the type of 
image currently being displayed. If a second 
image has been loaded into the display area, 
you can switch to it by clicking on the appro-
priate image type.

A 256-color display can also display a 16-color image 
(although there will be no improvement in the im-
age), so if the terminal uses a 256-color display either 
16-color or a 256-color image may be used. 

 - :

 is screen will give you the option of proceeding 
with the selection of the 256-color bitmap image, or of 
opting to return to the ĕ le selection dialog to select a 
16-color bitmap image to work on as well.
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If the terminal has a 16-color display, you will have to 
select a 16-color image instead since terminals with 
16-color displays cannot display 256-color images cor-
rectly. In this case, click the SELECT 16-COLOR BMP 
button.  e ĕ le selection dialog opens and allows you 
to locate and select a 16-color image. Both images load 
into the display area. Use the Window option to select 
the 16-color image to work on it. 

If the terminal has a 256-color display and you do 
not wish to load another, 16-color bitmap, click the 
DON’T SELECT 16-COLOR BMP button to pro-
ceed with the operation. if you wish to load a 16-color 
image as well, click the SELECT 16-COLOR BMP but-
ton. Both images load into the display area.  e display 
shows the ĕ rst image (256-color), and hides the second 
image (16-color). You can switch between images us-
ing the Window option on the Menu Bar. 

4. Choose a display Duration for the currently dis-
played Coupon Selection Screen.  is is the num-
ber of seconds the terminal screen displays the 
image before returning to the terminal’s customer 
welcome screen.  e duration can be set from 10 
through 255 seconds.

5. Now you will assign Receipt Graphic images to one 
or more Coupon Buttons. Buttons 1 through 3 and 
5 through 7 can each have an associated graphic 
assigned. When the customer presses a Coupon 
Button on the terminal, the associated graphic 
prints on a receipt.  e customer will only be able 
to select one coupon item per ATM transaction. 

To begin, click a Coupon Button (1-3 or 5-7). A ĕ le 
selection window will appear. Use this window to 
locate and select a previously created graphic ĕ le that 
conforms to the speciĕ cations listed in the section on 
Image Characteristics. When viewing ĕ les, only im-
ages that are monochrome and 380x700 pixels will be 
visible. Once selected, the image ĕ lename will appear 
in the button caption, as in the following example.

6. Repeat Step 5 for any remaining Coupon Buttons 
you wish to assign. 

7. Once the Coupon Selection Screen graphic, Re-
ceipt Graphic(s), and Display Duration have been 
set, save the settings by selecting the File option on 
the menu bar, then clicking Save As.

A dialog box will appear. Enter a maximum 
eight-character name for the ĕ le and click the 
Save button. A ĕ le in the Triton Connect Graph-
ic (.TCC) format will be created in the >BMP 
sub-folder of the Triton Connect installation folder.

8. Use the Ad Graphics/File Manager function to 
download the coupon ĕ le to selected terminals (see 
Chapter 8, Terminal Parameters, for details on this 
procedure). 

E  C
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  -  



Triton Connect adds support for SSL for secure communications. To use this feature, a Certiĕ cate Authority 
(CA) such as VeriSign must sign a SSL certiĕ cate to support the ATM. If a suitable certiĕ cate exists on the Triton 
Connect server, the user may use it. A sample list of Certiĕ cate Authorities supported by the ATM provided 
below. 

• VeriSign/RSA Secure Server 
• VeriSign Class 1 Public Primary CA 
• VeriSign Class 2 Public Primary CA 
• VeriSign Class 3 Public Primary CA 
• GTE Cybertrust ROOT 
•  awte Premium Server CA 
•  awte Server CA 
• Entrust.net Secure Server CA 
• Entrust.net Premium Secure Server CA, also known as Entrust.net CA (2048) 

 e actual list depends on what the user loads onto the ATM. Check with the ATM’s technical support for a list 
of supported CAs. 

**Note**
To use SSL, conĕ gure both the ATM and Triton Connect to support SSL. If uncertain, please check with Triton’s 
Technical Support to verify if your ATM so ware version supports SSL. 
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     
()

Use a Certiĕ cate Signing Request (CSR) to acquire a 
certiĕ cate. A er an application generates a CSR, trans-
mit the CSR to a Certiĕ cate Authority during the pro-
cess of applying for a certiĕ cate. For Triton Connect, 
generate a CSR to obtain a new certiĕ cate for purposes 
such as initial setup or if the current certiĕ cate will 
soon expire. For the certiĕ cate to perform properly, 
the CSR’s Common Name ĕ eld must match the value 
entered in the ATM as the Triton Connect host in the 
Triton Connect conĕ guration screen. To create a CSR, 
perform the following steps. 

1. Navigate to the Call Monitor > Settings > SSL Set-
tings. 

2. Click the Create CSR button. 

3. Enter the value for the Common Name of the 
certiĕ cate.  is value matches the Host address 

entered in the ATM’s Triton Connect Host address. 
4. Click the Generate button. 

5. Click the Copy Text button to copy the CSR.  e 
Certiĕ cate Authority receives the CSR during the 
process of acquiring a SSL certiĕ cate. A er the 
Certiĕ cate Authority completes any veriĕ cation, 
the requestor will receive a signed CSR. 

6. Click the Close button to close this window.
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4. A er the signed CSR inserts into the window, click 
the Import button to proceed. If a problem occurs 
an error message appears. 

5. If no problems, a success message appears and the 
window closes.

    

A er the selected Certiĕ cate Authority processes 
the CSR and any other information they require, the 
requestor will receive a signed CSR by either an email 
with an attached ĕ le or download the form from the 
website.  e user can copy and paste into the Triton 
Connect. Import the signed CSR into Triton Connect 
to complete the certiĕ cate acquisition process. 

To import a CSR, perform the following steps. 

1. Navigate to the Call Monitor > Settings > SSL Set-
tings. 

2. Click the Import CSR button. 

3. From the Import Signed CSR window, either click 
the Paste Text button to paste the signed CSR into 
the window, or click on the Import Certiĕ cate 
from File button to browse for the certiĕ cate ĕ le. 
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    

Once the PC receives the certiĕ cate, the user must load 
the correct certiĕ cate into Triton Connect. To select 
the SSL certiĕ cate, perform the following steps.

1. Navigate to the Call Monitor > Settings > SSL Set-
tings.

2. Click the Select Certiĕ cate button. 

3. In the Certiĕ cate Browser window, highlight the 
desired certiĕ cate and click the Select button.  is 
will select the certiĕ cate and close the Certiĕ cate 
Browser window.

    

Before Triton Connect can establish an SSL session 
with the ATM, conĕ gure the Inbound SSL Port. To 
access this screen, perform the following steps.

1. Navigate to the Call Monitor > Settings > TCP/IP 
Settings.
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2. Set the Inbound SSL Port: to the desired port num-
ber. Triton Connect or other applications will use 
the port number. Click the OK button to accept 
the changes.

   

To change the SSL status, perform the following steps.

1. Navigate to the Call Monitor/Settings > SSL Settings 
menu.

2. To enable SSL, check the Use SSL box. To disable 
SSL, uncheck the Use SSL box. Click the OK button 
to save the change and close the window.

   

A er performing all the above steps, conĕ gure Triton 
Connect to accept an SSL connection from the ATM, 
if the ATM uses SSL. Triton Connect automatically 
enables the callback feature. To allow Triton Connect 
to accept SSL connection, conĕ gure a Call Processor 
for TCP/IP as normal.

Triton Connect revision 6.1 and 6.2 provides the IP 
address of the client attempting to connect. If an in-
coming call uses SSL, the parameters will negotiate and 
appear in the Call Processor window as shown below.

 

E  C
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 
No. Parameter Name Changeable?

 / 
1 Store Message Yes

2 Coupon Random Message Yes

3 Coupon Level Message Yes

4 Welcome Message Yes

5 Marketing Message Yes

6 Exit Message Yes


1 Master Key Check Digits No

2 Comms Key Check Digits No

3 Sequence No. No

4 Last Authorization No. No

5 Des Chip Loaded No

6 Security Module Present No

7 Demo Mode No

8 Last Dispensed Status No

9 Error Code No

 
1 Iso Numbers Yes

2 Terminal Owner Yes

3 Surcharge Owner Yes

4 Emv Settings Yes


1 Predial Yes

2 Modem Init. String Yes

3 Host Phone No. No

4 Alt Host Phone No. No

5 Use 8 Data Bits, No Parity, In 
Place Of 7 Data Bits, Even Pari-
ty For Host Communications

Yes

6 Remote Key Transfer (Rkt) Yes

 
No. Parameter Name Changeable?

 
1 Total Debit Transactions No

2 Total Credit Transactions No

3  Total Balance Inquiries No

4 Total Transfers Done No

5 Total Denied Transactions No

6 Total Debit Amount No

7 Total Credit Amount No

   ( )
1 Text Message Yes

2 Display Duration Yes

3 Selected Screen Yes


1 Fast Cash 1 Yes

2 Fast Cash 2 Yes

3 Fast Cash 3 Yes

4 Fast Cash 4 Yes

5 Fast Cash 5 Yes

6 Fast Cash 6 Yes

7 Fast Cash 7 Yes

8 Max. Withdrawal Amount Yes

9 Max Non Cash Withdrawal Yes

10 Denomination No

 
1 Document Value No

2 Total Transactions No

3 Cash Loaded No

4 Reject Events No

5 Dispensed Amounts No

6 Cash Remaining No

  
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 
No. Parameter Name Changeable?

 
1 Document Value No

2 Total Transactions No

3 Cash Loaded No

4 Reject Events No

5 Dispensed Amounts No

6 Cash Remaining No

 
1 Model No. No

2 Triton Controller (EPROM) 
Version No.

No

3 Program Version No. No

4 Screen (Table) Version No. No

5 Additional Data Info. No

6 View Conĕ g. Overview No

(/ )  / 
1 Files To Remain A er ’Send 

Parameters
Yes

2 Enable Advertisement Screens Yes

3 Overwrite Existing Files On 
Terminal

Yes

4 Re-Format Memory Card 1 Yes

5 Re-Format Memory Card 2 Yes

6 Scheduling Yes

7 View/Edit Ad (Ad Designer 
Function)

Yes

(/ ) 
1 Receipt Type Yes

2 Justiĕ cation Yes

3 Location Yes

4 Overwrite Existing Files On 
 e Terminal

Yes

5 Enable Graphic Printing On 
Receipts

Yes

 
No. Parameter Name Changeable?

  ( )
1 Balance Inquiries Enabled Yes

2 Savings Account Transactions 
Enabled

Yes

3 Credit Card Transactions En-
abled

Yes

4 Transfers Enabled Yes

5 Include Comms Header Yes

6 Include Terminal Status Yes

7 Return Terminal Total To Pro-
cessor

Yes

8 Ignore Eot Character Yes

9 Allow Extended Transaction 
Amounts

No

10 Dispense Opposite Cassette 
Side

No

11 Lock Cassettes Yes

12 Allow Any Bill Denominations Yes

13 Cassette ’A’ Is In Service Yes

14 Cassette ’B’ Is In Service Yes

15 Cassette ’C’ Is In Service Yes

16 Cassette ’D’ Is In Service Yes

17 Bill Mix Method Yes

18 Size (Digits) For Transaction 
Amounts.(Normal=8, Extend-
ed=12, Full Extended=15)

No


1 Change Terminal Master Pass-

word
Yes

2 Change Terminal Admin Pass-
word

Yes
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 
No. Parameter Name Changeable?

 ( )
*(SURCHARGE Screen Read-only) 

**(MODIFY SETTINGS) Button

1 Transaction Type *No / **Yes

2 Surcharge Enabled *No / **Yes

3 Surcharge Amount *No / **Yes

4 Will/May **Yes

5 Surcharge Percent *No / **Yes

6 Display Surcharge Screen A er 
Amount Selection Instead Of 
Before Selection

**Yes

7 Use “Greater” In Place Of 
“Lesser” In Surcharge Screens 
#7, #8, #10, And #11

*No / **Yes

8 Screen # **Yes

  
1 Triton Connect Call Back Yes

2 TC Max Retries Yes

3 TC Redial Reply Yes

4 Triton Connect Primary Phone 
Number

Yes

5 Triton Connect Backup Phone 
Number

Yes

6 Alarm Monitor Primary Phone 
Number

Yes

7 Alarm Monitor Backup Phone 
Number

Yes

 
No. Parameter Name Changeable?


1 Enable Schedule Close Yes

2 Close Report Time Yes

3 Enable Schedules Journal Call Yes

4 Set Journal Call Time Yes

5 Enable Call at Number of Jour-
nal Records  reshold

Yes

6 Set # Records  reshold Yes

7 Enable Call at Low Cash 
 reshold

Yes

8 Set Low Cash  reshold Yes

9 Stay in Service When Receipt 
Paper Low

Yes

10 Allow Heartbeat to be Enabled Yes

11 Enable Heartbeat Yes

12 Heartbeat Delay Period Yes

13 Out of Service Settings Yes


1 Currency Symbol Yes

2 Use “CHEQUING” in Place of 
“CHECKING”

Yes

3 Format Transaction Receipt 
Latin American Style

Yes

4 Use Date Format DDMMYY in 
Place of MMDDYY

Yes
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( )   
No. Parameter Name Changeable?

-

 
1 Metal Present Time (sec) Yes
2 Metal Absent Time (sec) Yes
3 Detection Voltage (mV) Yes
4 Warning Voltage (mV) Yes

 
5 Metal Present Time (sec) Yes
6 Metal Absent Time (sec) Yes
7 Detection Voltage (mV) Yes
8 Warning Voltage (mV) Yes

( )   
No. Parameter Name Changeable?


1 Currency Symbol Yes

2 Use “CHEQUING” in Place of 
“CHECKING”

Yes

3 Format Transaction Receipt 
Latin American Style

Yes

4 Use Date Format DDMMYY in 
Place of MMDDYY

Yes

.
1 Default Language Yes

2 Default Transaction Yes

3 Default Account Yes

4 Protocol Type Yes

5 Message Type Yes

6 User List Yes

7 Schedule Reboot Yes

  ( )
1 Add Ad Yes

2 Remove Ad Yes

3 Activate Ad Yes

4 Activate Screen File Yes

5 Edit Schedule/Field Yes

6 Move Up/Down Yes

 ( )
1 Coupon Type Yes

2 Min. Max. Levels Yes

3 Random Percentage Yes

4 Coupon Prompt Yes

5 Conĕ gure Printed Coupon 
Message, Graphic, Layout

Yes

6 Conĕ gure Dispensed coupon 
Cassette and Number of Dis-
penses

Yes

7 Enable Award based on ISO 
properties

Yes

 
1 Select Screen Type Yes

2 Optional Buttons Yes

3 Screen Screen Yes


